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Περίληψη 

Η παρούσα διπλωματική εργασία έχει αντικείμενο τη μελέτη των επιπτώσεων, στην πρόβλεψη 

της απορροής, της έλλειψης δεδομένων απορροής, ή, αλλιώς, της κατάστασης στην οποία μια 

λεκάνη είναι μη μετρούμενη. Η μελέτη γίνεται υπό το πρίσμα της υδρολογικής ομοιότητας 

μεταξύ λεκανών απορροής, δηλαδή των γεωμορφολογικών, κλιματολογικών, γεωλογικών και 

εδαφολογικών χαρακτηριστικών, ή χαρακτηριστικών κάλυψης γης τα οποία παρουσιάζουν 

μεγάλο βαθμό ομοιότητας μεταξύ των λεκανών. Συγκεκριμένα, πραγματοποιείται μια 

διερεύνηση μεταξύ δύο όμοιων υπολεκανών του Αχελώου, της λεκάνης του Αγραφιώτη και 

της λεκάνης του Κρικελιώτη με στόχο την βέλτιστη δυνατή πρόβλεψη της απορροής στη 

δεύτερη λεκάνη η οποία είναι μη μετρούμενη. Για την προσομοίωση των δύο λεκανών 

χρησιμοποιείται το υδρολογικό σύστημα προσομοίωσης HEC-HMS για συνεχή προσομοίωση. 

Για την κατάρτισή του γίνεται συλλογή γεωγραφικών και υδρομετεωρολογικών δεδομένων. 

Τα γεωγραφικά δεδομένα υφίστανται επεξεργασία και, στη συνέχεια, προετοιμάζονται 

κατάλληλα σε περιβάλλον Γεωγραφικών Συστημάτων Πληροφοριών. Τα υδρομετεωρολογικά 

δεδομένα υφίστανται κατάλληλη επεξεργασία για το μοντέλο με διάφορες μεθόδους. 

Ακολουθεί η κατάρτιση του μοντέλου της κάθε λεκάνης απορροής με τις διάφορες ενότητες 

που παρέχει το HEC-HMS. Έπειτα, το μοντέλο της λεκάνης του Αγραφιώτη για την οποία 

υπάρχουν διαθέσιμα δεδομένα απορροής βαθμονομείται ούτως ώστε να εκτιμηθούν οι 

βέλτιστες τιμές των παραμέτρων. Στη συνέχεια, και λόγω της υδρολογικής ομοιότητας των δύο 

λεκανών απορροής, πραγματοποιείται μεταφορά των βέλτιστων παραμέτρων στη λεκάνη του 

Κρικελιώτη, εκτελείται προσομοίωση των διεργασιών του υδρολογικού κύκλου σε αυτή και 

αναλύονται τα αποτελέσματα που προκύπτουν ως προς την απορροή. Τα αποτελέσματα αυτά 

είναι αποδεκτά και προσεγγίζουν την πραγματικότητα, όμως δεν είναι πλήρως ικανοποιητικά 

όπως θα ήταν στην περίπτωση ύπαρξης μετρήσεων απορροής. Τέλος, εξήχθησαν 

συμπεράσματα που προέκυψαν από την παρούσα μεταπτυχιακή εργασία. Η υδρολογική 

ομοιότητα μεταξύ λεκανών απορροής είναι μια πολύ σημαντική έννοια η οποία μπορεί να 

αποτελέσει αξιόπιστη λύση στο πρόβλημα της προσομοίωσης μη μετρούμενων λεκανών 

απορροής και για αυτό απαιτείται περισσότερη και εντονότερη έρευνα των μηχανισμών που 

καθορίζουν την ομοιότητα μεταξύ λεκανών, τη μελέτη μεγαλύτερου πλήθους λεκανών ως προς 

την ομοιότητά τους και την κατάρτιση τεχνικών και μεθοδολογιών για την εκμετάλλευση αυτής 

της πληροφορίας.  
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Extended Abstract 

The current thesis aims at studying the impact, on flow prediction, of the lack of streamflow 

data, or, else, of the situation in which a river basin is ungauged. The study is carried out in the 

light of hydrological similarity between river basins, i.e., geomorphological, climatic, 

geological and soil characteristics, or land cover characteristics which are similar between the 

studied basins. Specifically, research work is being carried out for two similar sub-basins of 

Acheloos river, the Agrafiotis basin and the Krikeliotis basin, with the aim of optimally 

predicting runoff in the second basin which is ungauged. The HEC-HMS hydrological 

simulation system is used for continuous simulation of hydrological processes of the two basins 

Geographical and hydrometeorological data are collected for the model setup. A Geographical 

Information System (GIS) environment is used for handling and processing geographical data. 

Hydrometeorological data are appropriately processed for the model by various hydrological 

methods. This allows the design of each basin model with the aid of various modules provided 

by HEC-HMS. Next, the model is calibrated for Agrafiotis basin for which runoff data is 

available, which allows for estimating the optimal values of model parameters. Subsequently, 

due to the known hydrological similarity of the two basins (Papageorgaki and Nalbantis, 2016), 

the optimal parameters are transferred to the Krikeliotis basin, hydrological processes of the 

latter are simulated and the results are analyzed. It is revealed that results are acceptable and 

are fairly close to reality, although they are not fully satisfactory as they would be in the case 

of availability of outflow measurements. Finally, conclusions were drawn from the 

postgraduate thesis. Hydrological similarity between river basins is a very useful concept which 

can provide a reliable solution to the problem of simulating processes in ungauged drainage 

basins. Therefore, more intensive research is required with regard to the mechanisms that 

determine basin similarity. Also, the study of a large number of basins for potential similarity 

is needed in conjunction with the development of techniques and methodologies for exploiting 

this information. 

To begin with, in this study the ungauged basins are analyzed. The term “ungauged basins” 

denotes the basins for which no runoff data is available. The systematic study of the subject has 

been organized under the “Predictions in Ungauged Basins” initiative of the International 

Association of Hydrological Sciences, known as PUB. The primary objective of the initiative 

is to "formulate and execute appropriate scientific programs that will engage and enable the 

scientific community in a coordinated and effective way to achieve significant progress in 

hydrological forecasts in ungauged drainage basins". The primary research objectives of the 

PUB initiative are: 

• To improve the ability of existing hydrological models to predict, with reduced 

uncertainty, hydrological variables in ungauged basins. 

• To develop new and innovative models that represent the spatio-temporal variability of 

hydrological processes and, thus, to improve confidence in predictions in ungauged 

basins. 

Various achievements have been made during the ten-year PUB initiative, and various studies 

have been published that go a step further in the science of hydrology and have contributed to 

more reliable predictions in ungauged basins. All of the above can be summarized in three 

categories of achievement in the following areas: 

• Heterogeneity of data and processes 
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• Models, uncertainty analysis and diagnoses 

• Basin classification and new theory 

The major stalemate in simulation and calibration in ungauged basins is the complete lack of 

measured runoff data which leads to the inability to calculate the fit factors of the model. Thus, 

a proper estimation of its various parameters cannot be performed, and with this approach a 

model becomes practically useless in simulating ungauged basins. 

Subsequently, a summary of the geomorphological characteristics of drainage basins is 

presented and the concepts of hydrological similarity, regionalization and parameter transfer 

are analyzed. The main morphological characteristics of the catchments are: the size that can 

range from a few m2 to a few thousand km2, the shape that may be relatively elongated or 

relatively circular, and the altitude which has a significant influence on meteorological 

conditions prevailing in a catchment area. The term “hydrological similarity” refers to the 

similarity of different characteristics of the hydrological cycle in different areas or separate 

basins. These characteristics may be geomorphological, climatic, geological and soil 

characteristics, or land cover. The decision whether two or more basins are similar is made by 

comparing them and classifying them according to their characteristics or some proper 

indicators. Within the frame of an earlier study on watershed classification in Greece 

(Papageorgaki and Nalbantis, 2016), the two study basins were chosen and investigated in the 

present work. The concept of regionalization refers to methods and techniques of transferring 

information from neighbouring basin to the study basin. Some widely used methods are simple 

arithmetic methods such as the mean of an attribute or a parameter obtained from a large basin 

sample, methods of regression on basin properties, methods of spatial proximity of the 

ungauged basin under study to other basins that have measurements and lastly, direct transfer 

of parameters. 

A rainfall-runoff model is known to be a set of mathematical relationships, whether algebraic 

or differential equations or even logical relationships, that associate rainfall with runoff. The 

calibration of the rainfall-runoff models and the determination of the optimum values of their 

parameters are achieved by applying a model performance measure that compares predicted 

and measured values of runoff. The most widely used measure in hydrological applications is 

the coefficient of Nash and Sutcliffe (1970), known as NSE. 

The model used in this study is the HEC-HMS (Hydrologic Engineering Center - Hydrologic 

Modeling System) developed by the US Army Corps of Engineers. It is designed to simulate 

rainfall-runoff processes in dendritic basins. HEC-HMS is a generalized modelling system that 

is capable of representing many different catchments. A model of the watershed is being formed 

through separating the hydrological cycle into manageable parts and constructing boundary 

conditions. 
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The methodology used in the implementation of the current work is presented in the following 

flowchart (Figure 1). 

 

Figure 1: Flow chart of study methodology 

The two basins selected for this study are the Agrafiotis basin with an area of 219.6 km2 and 

the Krikeliotis basin with an area of 88.7 km2. For both basins, geographical and 

hydrometeorological data were collected and processed, to be later used as inputs to HEC-HMS 

with the purpose to simulate hydrological processes in the two basins. 

As for the geographical data, digital terrain models were collected (one for each study basin) 

with a resolution of 5 m. These were provided by the “Hellenic Cadastre”. Using the various 

ArcGIS tools, the digital terrain models were appropriately processed so as to obtain the 

hydrographic networks, watershed divides and contours of the two basins. Finally, the HEC-

GeoHMS add-on was used to obtain the appropriate input files for HEC-HMS containing the 

geographical data in the correct, compatible formats. 

With regard to the hydrometeorological data, rainfall, air temperature and runoff data were 

collected from Public Power Corporation S.A. (PPC) and from an earlier research project. 

Specifically, for the Agrafiotis basin, daily rainfall data were collected for three raingauge 

stations within the basin, while for the Krikeliotis basin, daily rainfall data were collected for 

two stations within the basin. Air temperature data in the form of daily maximum and minimum 

values were collected for a station within the Krikeliotis basin and for a station adjacent to the 

Agrafiotis basin. Daily runoff data were collected at the outlet of the Agrafiotis Basin at 

Barbariadas Bridge, while sporadic flow observations were collected at the outlet of Krikeliotis 

at Domnista Bridge. 

Statistical homogeneity of annual rainfall depths was checked for all the rainfall data collected 

using the double mass curve method and then, filling-in of rainfall missing data was performed. 

Also, to calculate the areal rainfall for each basin the Thiessen polygon method was applied, 
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while. maximum and minimum daily temperature data were corrected so as they refer to the 

mean basin elevation. 

The model setup for both basins was based on the same assumptions and approaches. Initially, 

the simulation was chosen to be continuous. Due to the lack of runoff data for spatial units 

smaller than the selected basins, each test basin is chosen to be a single spatial entity, which 

resulted to adopting a lumped model for it. The setup of the two models in HEC-HMS was 

carried out by creating four core modules and the appropriate selection of individual models, 

methodologies and options within each module. The first module is the Basin Model which 

contains individual models for the hydrological processes. Specifically, the Simple Canopy 

method was selected for the water retention by the canopy, the Simple Surface method was 

adopted for the water accumulation on the soil surface, the Soil Moisture Accounting method 

was chosen for the calculation of soil losses, the Snyder Unit Hydrograph method was 

employed for converting rainfall into runoff and the Constant Monthly method was selected for 

simulating the basic runoff. The next core module of HEC-HMS is the Meteorological Model 

that includes all the meteorological processes. The Gage Weights method was used to spatially 

distribute the rainfall using the Thiessen polygon method, while the Hargreaves method was 

employed to calculate the evapotranspiration based on maximum and minimum temperature 

data. In the Control Specifications module the simulation time range is specified by selecting 

start and end dates and also the simulation time step which is daily in this study. Finally, in the 

Time-Series Data module all the hydrometeorological data collected were recorded 

appropriately so that they can be processed by HEC-HMS. 

The calibration of Agrafiotis' model was performed by first selecting fourteen model parameters 

which had a direct impact on the hydrological processes and then, by applying the Simplex 

method for minimizing the squares of the model residuals. The calibration period was selected 

to be from 01/10/1979 to 30/09/1986, i.e., seven hydrological years. The resulting NSE 

coefficient was 0.689 which indicates a satisfactory fit of the simulated runoff to the measured 

runoff. The verification period was selected from 01/10/1987 to 30/09/1989, i.e. three 

hydrological years. The NSE coefficient was found 0.612 which indicates a satisfactory fit, 

which is, however, lower than that of the calibration. Figure 2 shows the time series of observed 

and simulated runoff at the daily time step for Agrafiotis basin. 
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Figure 2: Observed and simulated daily runoff for Agrafiotis basin 

After the calibration of the Agrafiotis model, the optimal values of its parameters were 

transferred to the Krikeliotis basin model. Subsequently, this model was run for the period 

01/10/1980 to 30/09/1987, i.e. seven hydrological years and a simulated daily runoff time series 

was obtained. For its evaluation it was chosen to compare it with the only available runoff 

information which included sporadic flow observations at the basin outlet. Thus, for a set of 81 

flow observations, the simulated runoff values were selected on exactly the same dates. To 

compare the two flow sets five numerical criteria were computed: NSE, linear correlation 

coefficient, root mean square error (RMSE), bias and bias as a percentage. 

In conclusion, a summary of the work is carried out, the conclusions of the study are analyzed 

and some possible implications are presented. The findings refer to the satisfactory simulation 

of processes in the two basins with the aid of HEC-HMS model, although there was a lack of 

runoff data for the Krikeliotis basin. They also highlight the important role that hydrological 

similarity between river basins can play for the best possible simulation of hydrological 

processes in ungauged basins. 
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Κατάλογος συμβόλων 

A   Επιφάνεια λεκάνης απορροής 

P   Περίμετρος λεκάνης απορροής 

L   Μήκος κύριου υδατορεύματος 

Rc   Δείκτης κυκλικότητας 

RL   Δείκτης επιμήκυνσης 

KC   Δείκτης συγκέντρωσης η Cravelius 

NSE   Συντελεστής των Nash και Sutcliffe 

Qμετ   Μετρημένη απορροή 

Qεκτ   Εκτιμημένη απορροή 

μετQ    Μέση τιμή της μετρημένης απορροής 

N   Πλήθος παρατηρήσεων 

Zm   Μέσο υψόμετρο της λεκάνης απορροής 

Zi   Μέσο υψόμετρο κάθε υποπεριοχής 

Ai   Εμβαδόν κάθε υποπεριοχής 

Xi   Ετήσιο ύψος βροχής του σταθμού για το υδρολογικό έτος i 

α   Συντελεστής αναγωγής 

λ1   Κλίση του νεότερου τμήματος της διπλής αθροιστικής καμπύλης 

λ2   Κλίση του παλιότερου τμήματος της διπλής αθροιστικής καμπύλης 

r   Συντελεστής γραμμικής συσχέτισης 

x και y  Ετήσια ύψη βροχή των εξεταζόμενων για γραμμική συσχέτιση σταθμών 

Px   Τιμές βροχόπτωσης του υπό συμπλήρωση σταθμού 

P1, P2, P3  Τιμές βροχόπτωσης στους σταθμούς που χρησιμοποιούνται για συμπλήρωση 

Ν1, Ν2, Ν3  Κανονική μέση βροχόπτωση στους τρεις παραπάνω σταθμούς 

Nx   Κανονική βροχόπτωση του υπό συμπλήρωση σταθμού 

P0   Μέσο βροχομετρικό ύψος της λεκάνης απορροής 

Pi   Βροχομετρικό ύψος των επιμέρους σταθμών της λεκάνης απορροής 

λ  Διορθωτικός συντελεστής για τις υψομετρικές αναγωγές των βροχομετρικών 

παρατηρήσεων 

β  Βροχοβαθμίδα 

z   Σταθμικός μέσος των υψομέτρων των βροχομετρικών σταθμών που 

επηρεάζουν τη λεκάνη απορροής 

Tmax  Απόλυτη μέγιστη τιμή της θερμοκρασίας 
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Tmin  Απόλυτη ελάχιστη τιμή της θερμοκρασίας 

dT   Μέση ημερήσια τιμή της θερμοκρασίας 

moT   Μέση μηνιαία τιμή της θερμοκρασίας 

ET   Μέση ετήσια τιμή της θερμοκρασίας 

γ  Θερμοκρασιακή βαθμίδα ή κατακόρυφη θερμοβαθμίδα 

ET0  Δυνητική εξατμισοδιαπνοή 

Ra  Εξωγήινη ακτινοβολία βραχέων κυμάτων 

TR  Εύρος της ημερήσιας θερμοκρασίας (TR=Tmax - Tmin) 

RMSE  Μέσο τετραγωνικό σφάλμα 

Qobsi  Εκάστοτε μετρημένη τιμή απορροής 

Qsimi  Εκάστοτε προσομοιωμένη τιμή απορροής 
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1 Εισαγωγή 

1.1 Γενική τοποθέτηση του προβλήματος 

Σε πολλές λεκάνες απορροής, τόσο στον ελληνικό χώρο, όσο και σε παγκόσμιο επίπεδο, 

παρατηρείται έλλειψη σε δεδομένα μετρήσεων απορροής. Οι λόγοι αυτού του φαινομένου 

μπορεί να είναι η ανυπαρξία του κατάλληλου εξοπλισμού στην περιοχή, η μικρή σπουδαιότητα 

της λεκάνης, ειδικά αν αυτή έχει μικρό μέγεθος, οι αποφάσεις που λαμβάνονται από τα τοπικά 

ή εθνικά κέντρα λήψης αποφάσεων και από τις αρμόδιες υπηρεσίες, το κόστος του 

απαιτούμενου εξοπλισμού κ.ά. Οι λεκάνες αυτές ονομάζονται μη μετρούμενες λεκάνες 

απορροής. 

Η συστηματική μελέτη του αντικειμένου των μη μετρούμενων λεκανών απορροής αποτελεί 

ένα σχετικά σύγχρονο κομμάτι της επιστήμης της υδρολογίας καθώς η επιστημονική κοινότητα 

οργανώθηκε κατά τα προηγούμενα είκοσι χρόνια κάτω από την πρωτοβουλία “Predictions in 

Ungauged Basins” της International Association of Hydrological Sciences. Επίσης, αποτελεί 

ένα πολύ σημαντικό αντικείμενο για τη γενικότερη διαχείριση των υδατικών πόρων και το 

μέλλον αυτής, καθώς χρόνο με το χρόνο οι ανάγκες σε νερό αυξάνονται συνεχώς. Η μελέτη 

των μη μετρούμενων λεκανών απορροής μπορεί να βοηθηθεί από τις σπουδαίες τεχνολογικές 

εξελίξεις που συντελούνται, από την ανάπτυξη κατάλληλων υδρολογικών μοντέλων 

προσομοίωσης για αυτές τις λεκάνες και, προφανώς, από την ανάπτυξη νέων θεωριών της 

υδρολογίας με έμφαση σε εναλλακτικές μη συμβατικές μεθοδολογίες και τρόπους σκέψης. 

Μια προσέγγιση για την ανάπτυξη μεθοδολογιών για την προσομοίωση των υδρολογικών 

διεργασιών σε μη μετρούμενες λεκάνες απορροής είναι η διερεύνηση για την ομοιότητα μεταξύ 

λεκανών σχετικά με γεωμορφολογικά, κλιματολογικά, γεωλογικά και εδαφολογικά 

χαρακτηριστικά, ή χαρακτηριστικά κάλυψης γης. Υπό αυτό το πρίσμα οι λεκάνες απορροής 

μπορούν να ταξινομηθούν ως προς το βαθμό ομοιότητάς τους. Έτσι, στις περιπτώσεις 

μοντελοποίησης σε μη μετρούμενες λεκάνες απορροής, μπορεί να γίνει συσχέτιση και επιλογή 

συγκεκριμενών χαρακτηριστικών ή παραμέτρων από τις λεκάνες οι οποίες έχουν μετρήσεις 

απορροής και μπορούν να μοντελοποιηθούν, και, στη συνέχεια, να εφαρμοστούν στις πρώτες 

είτε με άμεσο τρόπο, δηλαδή με απλή μεταφορά, είτε με έμμεσο τρόπο,  χρησιμοποιώντας 

στατιστικές και γεωστατιστικές μεθόδους. 

Στην παρούσα διπλωματική εργασία μελετούνται οι μη μετρούμενες λεκάνες απορροής μέσω 

μιας εφαρμογής σε δύο όμοιες λεκάνες απορροής του ελληνικού χώρου και συγκεκριμένα τη 

λεκάνη απορροής του Αγραφιώτη και τη λεκάνη απορροής του Κρικελιώτη. Η πρώτη λεκάνη 

μοντελοποιείται πλήρως καθώς είναι διαθέσιμα όλα τα απαιτούμενα υδρομετεωρολογικά 

δεδομένα. Η δεύτερη λεκάνη έχει έλλειψη δεδομένων απορροής στην έξοδό της και για αυτό 

γίνεται μεταφορά των παραμέτρων του μοντέλου από την πρώτη. 

Το μοντέλο που χρησιμοποιείται είναι το HEC-HMS και η προσομοίωση που πραγματοποιείται 

είναι συνεχούς χρόνου για κάποια υδρολογικά έτη. Η ανάλυση και η επεξεργασία όλης της 

γεωγραφικής πληροφορίας γίνεται σε περιβάλλον Γεωγραφικών Συστημάτων Πληροφοριών 

(GIS). 

Μετά την επεξεργασία των δεδομένων και την εφαρμογή του μοντέλου τόσο στη λεκάνη για 

την οποία υπάρχουν διαθέσιμες μετρήσεις, όσο και στη μη μετρούμενη λεκάνη, αναλύονται 

και συγκρίνονται τα αποτελέσματα που προκύπτουν. 



 

22 

1.2 Διάρθρωση της διπλωματικής εργασίας 

Η παρούσα διπλωματική εργασία περιλαμβάνει επτά κεφάλαια στα οποία περιγράφεται το 

θεωρητικό υπόβαθρο, παρουσιάζεται το υδρολογικό μοντέλο που χρησιμοποιήθηκε, αναλύεται 

η μεθοδολογία και οι διαδικασίες που ακολουθήθηκαν για την κατάλληλη προσομοίωση των 

διεργασιών των λεκανών και τη βαθμονόμηση του μοντέλου, παρουσιάζονται τα 

αποτελέσματα που προέκυψαν και εξάγονται συμπεράσματα για τα αποτελέσματα και τις 

γενικότερες εργασίες της μεταπτυχιακής εργασίας. Στη συνέχεια, περιγράφεται συνοπτικά το 

περιεχόμενο κάθε κεφαλαίου. 

Κεφάλαιο 1ο 

Αποτελεί την εισαγωγή της μεταπτυχιακής εργασίας καθώς περιλαμβάνει μια γενική 

τοποθέτηση του προβλήματος και το πως έχει διαρθρωθεί η εργασία. 

Κεφάλαιο 2ο 

Παρουσιάζονται πληροφορίες για τις μη μετρούμενες λεκάνες απορροής και αναλύεται η 

πρωτοβουλία Predictions in Ungauged Basins καθώς και οι ενέργειες που έχουν γίνει από την 

επιστημονική κοινότητα σύμφωνα με αυτή την πρωτοβουλία. Επίσης, αναλύονται οι λόγοι για 

τους οποίους η μοντελοποίηση μη μετρούμενων λεκανών απορροής είναι μια περίπλοκη 

διαδικασία.  

Κεφάλαιο 3ο 

Παρουσιάζονται κάποια στοιχεία για τα γεωμορφολογικά χαρακτηριστικά των λεκανών 

απορροής τα οποία αποτελούν βάση για οποιαδήποτε προσπάθεια ταξινόμησης λεκανών 

απορροής. Επίσης αναλύεται η έννοια της υδρολογικής ομοιότητας και της περιοχοποίησης και 

μεταφοράς παραμέτρων. 

Κεφάλαιο 4ο 

Παρουσιάζεται ο ορισμός των μοντέλων βροχόπτωσης – απορροής, τα κριτήρια ταξινόμησής 

και η διαδικασία βαθμονόμησης αυτών. Επίσης, παρουσιάζεται το μοντέλο HEC-HMS που 

χρησιμοποιήθηκε στην εργασία. 

Κεφάλαιο 5ο 

Παρουσιάζονται οι δύο λεκάνες απορροής που μελετώνται, η λεκάνη του Αγραφιώτη και η 

λεκάνη του Κρικελιώτη και περιγράφεται η μεθοδολογία και οι διαδικασίες που 

ακολουθήθηκαν για την προετοιμασία των δεδομένων για το μοντέλο HEC-HMS. 

Κεφάλαιο 6ο 

Παρουσιάζεται ο τρόπος κατάρτισης όλων των συνιστωσών του μοντέλου για τις δύο υπό 

μελέτη λεκάνες απορροής, η βαθμονόμηση και η επαλήθευση της λεκάνης απορροής του 

Αγραφιώτη, η αξιοποίηση του μοντέλου της λεκάνης του Αγραφιώτη για την αντιμετώπιση 

έλλειψης δεδομένων απορροής στη λεκάνη του Κρικελιώτη με τη μεταφορά παραμέτρων και 

τέλος, η διαδικασία σύγκρισης και ελέγχου των αποτελεσμάτων της μη μετρούμενης λεκάνης 

του Κρικελιώτη. 

Κεφάλαιο 7ο 

Παρουσιάζεται μία σύνοψη της διπλωματικής εργασίας με αναφορά σε όλα τα προβλήματα 

που ανέκυψαν, καθώς και τα συμπεράσματα που προέκυψαν από αυτή. 
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2 Οι μη μετρούμενες λεκάνες απορροής 

2.1 Γενικά 

Παρόλη τη ραγδαία ανάπτυξη της τεχνολογίας και της επιστήμης της υδρολογίας τις τελευταίες 

δεκαετίες, είναι πολύ συχνό το φαινόμενο έλλειψης υδρολογικών δεδομένων σε πολλές 

περιοχές σε παγκόσμιο επίπεδο. Τα δεδομένα αυτά αφορούν κυρίως μετρήσεις των 

ατμοσφαιρικών κατακρημνισμάτων, των μετεωρολογικών μεγεθών και της απορροής. Έτσι, οι 

λεκάνες απορροής που σχηματίζονται σε αυτές τις περιοχές ονομάζονται μη μετρούμενες 

λεκάνες απορροής (ungauged basins). Βέβαια, στην επιστημονική κοινότητα που ασχολείται 

με αυτό το αντικείμενο, ο όρος συνήθως αφορά λεκάνες απορροής χωρίς μετρήσεις της 

απορροής. Οι ελλείψεις δεδομένων σε αυτές τις λεκάνες δημιουργούν πολλά προβλήματα και 

αδιέξοδα κατά τη μελέτη τους με συμβατικό τρόπο. Η μοντελοποίηση των διεργασιών σε αυτές 

καθίσταται ιδιαίτερα δύσκολη, η ακρίβειά της πολύ μικρή και διάφορες άλλες υδρολογικές 

διαδικασίες, σχεδόν ακατόρθωτες. 

Η επιστημονική κοινότητα έχει αντιληφθεί πόσο σημαντικό θέμα αποτελούν οι μη μετρούμενες 

λεκάνες απορροής και έχει καταβάλει μεγάλη προσπάθεια για την κατανόηση του θέματος, 

αλλά και στην ανάπτυξη επιστημονικής γνώσης, μεθόδων, εργαλείων και μοντέλων για την 

περαιτέρω μελέτη αυτού. 

2.2 Προβλέψεις σε μη μετρούμενες λεκάνες 

2.2.1 Η πρωτοβουλία RUB της IAHS 

Το ζήτημα των προβλέψεων σε μη μετρούμενες λεκάνες απορροής ξεκίνησε να απασχολεί την 

επιστημονική κοινότητα στην αρχή της νέας χιλιετίας, καθώς οι μέχρι τότε υδρολογικές 

θεωρίες, τα μοντέλα και οι εμπειρικές μέθοδοι ήταν ιδιαίτερα ανεπαρκείς για προβλέψεις σε 

τέτοιου είδους λεκάνες (Hrachowitz et al., 2013). Επιπλέον, υπήρχε μεγάλη ανάγκη για 

καλύτερη κατανόηση της υδρολογικής λειτουργίας της υπό εξέταση λεκάνης και της γένεσης 

της απορροής για να αντιμετωπιστεί η πρόκληση των μη μετρούμενων λεκανών απορροής. Με 

άλλα λόγια έγινε αντιληπτό ότι η έλλειψη δεδομένων θα οδηγούσε στο να εξαχθεί συμπέρασμα 

περί της υδρολογικής λειτουργίας μιας λεκάνης από μετρήσεις της μορφής της ίδιας της 

λεκάνης όπως και των συνδυασμένων επιδράσεων του κλίματος, της τοπογραφίας, της 

γεωλογίας, του είδους του εδάφους και της κάλυψης γης. Έγινε επίσης αντιληπτό ότι αυτός ο 

στόχος θα μπορούσε να επιτευχθεί μόνο με βελτιωμένη κατανόηση των βασικών υδρολογικών 

διεργασιών, απαιτώντας μετατόπιση της εστίασης της έρευνας μακριά από την απλή 

προσαρμογή παραμέτρων, προς την κατεύθυνση της κατανόησης των διεργασιών καθώς και 

της δομικής διάγνωσης των μοντέλων. 

Παρόλη τη μοναδική σημασία του νερού στο σύστημα της γης και τον κεντρικό ρόλο της 

υδρολογίας στη διεπαφή της με πολυάριθμους τομείς, ο ίδιος ο τομέας της υδρολογίας 

παρέμεινε διχασμένος και, κατά κάποιο τρόπο, σε κατάσταση έλλειψης επαρκούς στιβαρής 

επιστημονικής και θεωρητικής βάσης για να παρέχει αξιόπιστες προβλέψεις βασισμένες στην 

επιστήμη. Οι κύριοι παράγοντες που κατέληγαν σε αβεβαιότητα της πρόβλεψης 

περιελάμβαναν: 
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• Μία ελλιπή κατανόηση του συνόλου των διεργασιών απόκρισης του υδρολογικού 

συστήματος και των συσχετίσεων μεταξύ τους σε κλίμακα λεκάνης, που συχνά 

καταλήγει σε μη ρεαλιστικά μοντέλα με υψηλή αβεβαιότητα πρόβλεψης 

• Μία ελλιπή κατανόηση της πολυδιάστατης χωροχρονικής ετερογένειας των διεργασιών 

σε διαφορετικά τοπία και κλίματα, καθώς η μεγάλη πλειονότητα των μικρών λεκανών 

απορροής παγκοσμίως ήταν και είναι μη μετρούμενες με ελάχιστη ή μηδαμινή 

πληροφορία 

• Ακατάλληλες τεχνικές περιοχοποίησης για να μεταφερθεί η κατανόηση των προτύπων 

υδρολογικής απόκρισης από μετρούμενα σε μη μετρούμενα περιβάλλοντα, εξαιτίας, 

μεταξύ άλλων, της έλλειψης μελετών σύγκρισης μεταξύ λεκανών απορροής και της 

έλλειψης φυσικών αρχών που διέπουν την ισχυρή περιοχοποίηση. 

Έτσι, η ανεπαρκής κατανόηση των διεργασιών και η έλλειψη ταυτόχρονων δεδομένων σε 

πολλαπλές κλίμακες χώρου και χρόνου, καθώς και η έμφαση σε τοπικές και απομονωμένες 

ερευνητικές μελέτες, δημιούργησαν μία κατάσταση στην οποία η αξιόπιστη υδρολογική 

πρόβλεψη γινόταν συχνά δύσκολη στις σχετικά λίγες μετρημένες περιοχές παγκοσμίως και 

ουσιαστικά αδύνατη για τον υπόλοιπο κόσμο. 

Για να αντιμετωπιστούν αυτά τα προβλήματα, ξεκίνησε το 2003 η πρωτοβουλία για τις 

προβλέψεις σε μη μετρούμενες λεκάνες απορροής (Predictions in Ungauged Basins - PUB) από 

την Διεθνή Ένωση των Υδρολογικών Επιστημών (International Association of Hydrological 

Sciences - IAHS) με την έκδοση ενός δεκαετούς επιστημονικού σχεδίου. Ο πρωταρχικός 

στόχος της πρωτοβουλίας ήταν «να διατυπώσει και να εκτελέσει κατάλληλα επιστημονικά 

προγράμματα τα οποία θα απασχολήσουν και θα ενεργοποιήσουν την επιστημονική κοινότητα, 

με ένα συντονισμένο και αποτελεσματικό τρόπο, προς την επίτευξη σημαντικής προόδου σε 

ό,τι αφορά τις υδρολογικές προβλέψεις σε μη μετρούμενες λεκάνες απορροής». Αυτή η 

στρατηγική συνεπάγεται μία σημαντική μεταβολή στην ιδεολογική δομή της επιστημονικής 

υδρολογίας, η οποία παραδοσιακά σχετίζεται με εμπειρικές τεχνικές, καθώς δίνει έμφαση στην 

ανάγκη απομάκρυνσης από μεθόδους που εστιάζουν στα δεδομένα και στη βαθμονόμηση και 

στην προσέγγιση μεθόδων που είναι πιο ισχυρά βασισμένες σε θεωρητικές γνώσεις σχετικά με 

τις φυσικές διεργασίες και την κατανόηση του συστήματος. Η πρωτοβουλία PUB σχεδιάστηκε 

για να ωφελήσει την επιστήμη της υδρολογίας παρέχοντας μεγαλύτερη συνοχή και αρμονία 

στις επιστημονικές δραστηριότητες και αυξημένες προοπτικές για επιστημονικές ανακαλύψεις 

και, άρα, ενθουσιασμό για την επιστήμη. 

Σύμφωνα με τον παραπάνω γενικό στόχο, διατυπώθηκαν οι πρωταρχικοί ερευνητικοί στόχοι 

της πρωτοβουλίας PUB οι οποίοι είναι: 

• Να βελτιώσει την ικανότητα των υφιστάμενων υδρολογικών μοντέλων να προβλέπουν, 

με μειωμένη αβεβαιότητα, υδρολογικά μεγέθη σε μη μετρούμενες λεκάνες απορροής  

• Να αναπτύξει νέα και καινοτόμα μοντέλα που να αντιπροσωπεύουν τη χωροχρονική 

μεταβλητότητα των υδρολογικών διεργασιών και, ως εκ τούτου, να βελτιώσει την 

εμπιστοσύνη στις προβλέψεις σε μη μετρούμενες λεκάνες απορροής. 

Η πρωτοβουλία PUB υιοθέτησε πολλούς, ως επί το πλείστον παράλληλους αλλά έντονα 

συνυφασμένους άξονες έρευνας για να επιτύχει τους καθορισμένους στόχους. Η βασική 

στρατηγική της πρωτοβουλίας PUB ήταν να εξάγει περισσότερη πληροφορία από τα δεδομένα, 

είτε με πιο αποτελεσματική εκμετάλλευση των διαθέσιμων δεδομένων, είτε με χρήση 

νεοαποκτηθέντων δεδομένων για να βελτιώσει την τοπική διαδικασία κατανόησης στις μη 

μετρούμενες λεκάνες απορροής. Αυτή η κατανόηση θα χρησιμοποιούνταν έπειτα για το 

σχεδιασμό μοντέλων με αυξημένο βαθμό ρεαλισμού στις τοποθεσίες με μετρήσεις. Την ίδια 
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στιγμή, περιφερειακά ή παγκόσμια συγκεντρωμένα δεδομένα, επρόκειτο να χρησιμοποιηθούν 

σε συγκριτικές μελέτες για να αποκτηθεί μία καλύτερη κατανόηση των πολυδιάστατων, 

χωροχρονικών ετερογενειών των προτύπων της υδρολογικής απόκρισης. Αυτή η βελτιωμένη 

αντίληψη των προτύπων αναμενόταν να διευκολύνει την ανάπτυξη περισσότερων 

εκλεπτυσμένων τεχνικών περιοχοποίησης οι οποίες ήταν απαραίτητες για επέκταση της 

γνώσης σε τοποθεσίες χωρίς μετρήσεις, οι οποίες τελικά θα επιτρέψουν περισσότερο 

αξιόπιστες προβλέψεις σε μη μετρούμενες λεκάνες απορροής. Επιπρόσθετα, οι διαγνώσεις 

μοντέλων προόδευσαν προς μια καλύτερη κατανόηση των αβεβαιοτήτων και εκπονήθηκαν 

μέθοδοι ταξινόμησης των λεκανών απορροής καθώς και πλαίσια ομοιότητας λεκανών. Αυτή η 

καλύτερη αντίληψη των προτύπων της υδρολογικής λειτουργίας αποτέλεσε τη βάση για την 

ανάπτυξη μίας νέας προοπτικής (και των περιορισμών της) στην οποία η υδρολογία δεν 

φαίνεται ως μία απομονωμένη επιστήμη, αλλά, στην πραγματικότητα, αποτελεί τον κεντρικό 

παράγοντα στη διεπαφή της εξέλιξης του κλίματος, της γεωλογίας, της τοπογραφίας και της 

οικολογίας και των παροδικών και μακροχρόνιων αποκρίσεών τους στη μεταβολή. Πρέπει να 

επισημανθεί ότι η έμφαση της πρωτοβουλίας PUB δόθηκε στις προβλέψεις σε μη μετρούμενες 

λεκάνες απορροής καθώς και στη κατανόηση δεδομένων και διαδικασιών για να 

υποστηριχθούν αυτές οι προβλέψεις. 

2.2.2 Επιτεύγματα της πρωτοβουλίας 

Κατά τη διάρκεια της δεκαετούς πρωτοβουλίας PUB σημειώθηκαν διάφορα επιτεύγματα και 

εκπονήθηκαν διάφορες μελέτες που προχώρησαν ένα βήμα παραπέρα την επιστήμη της 

υδρολογίας και συνέβαλαν σε πιο αξιόπιστες προβλέψεις σε μη μετρούμενες λεκάνες 

απορροής. Όλα τα παραπάνω μπορούν να συνοψιστούν σε τρεις κατηγορίες επιτευγμάτων 

στους ακόλουθους τομείς: 

• Ετερογένεια δεδομένων και διεργασιών 

• Μοντέλα, ανάλυση αβεβαιότητας και διαγνώσεις 

• Ταξινόμηση λεκανών απορροής και νέα θεωρία 

Στη συνέχεια, αναλύεται κάθε μία από αυτές τις κατηγορίες. 

Ετερογένεια δεδομένων και διεργασιών 

Τα δεδομένα αποτελούν τη σπονδυλική στήλη για οποιουδήποτε είδους πρόοδο στην 

κατανόηση των υδρολογικών διεργασιών και στη μοντελοποίηση. Τόσο η έλλειψη δεδομένων 

όσο και η ποιότητά τους ήταν, παραδοσιακά, τα κύρια προβλήματα για την υδρολογία και 

ακόμα αποτελούν πηγή σημαντικής αβεβαιότητας σε οποιουδήποτε τύπου υδρολογική 

εφαρμογή. Καθώς η παραδοσιακή απόκτηση δεδομένων υπόκειται τυπικά σε οικονομικούς 

λογιστικούς και χρονικούς περιορισμούς, οι καινοτομίες και οι πρόοδοι στις τεχνολογίες 

αισθητήρων έχουν την προοπτική να είναι ιδιαίτερα πολύτιμες για την υδρολογία. Επίσης, κατά 

τη διάρκεια των προηγούμενων ετών έχουν γίνει σημαντικά βήματα προς τα εμπρός για τη 

διαθεσιμότητα και την ποιότητα μιας ευρείας ποικιλίας περιβαλλοντικών δεδομένων που 

αποκτήθηκαν με διαφορετικές τεχνολογίες και στρατηγικές παρατήρησης. Επιπλέον, έχουν 

γίνει σημαντικές προσπάθειες στην ανάπτυξη τρόπων για την εξαγωγή περισσότερης 

πληροφορίας από ιστορικά και σύγχρονα διαθέσιμα δεδομένα. Ακόμη, ένα κρίσιμο ζήτημα 

είναι οι απαιτήσεις των δεδομένων για εξάρτηση από μία κλίμακα, το οποίο απαιτεί μία 

ιεραρχική στρατηγική απόκτησης δεδομένων. Βέβαια, τα παγκόσμια και τα χαμηλής ανάλυσης 

σύνολα δεδομένων, τα οποία συνήθως βασίζονται στην τηλεπισκόπηση, παρέχουν γενικευμένη 

πληροφορία σε χαμηλό κόστος. Αντίθετα, περιφερειακές πηγές δεδομένων με ποικιλία 

διαθεσιμότητας και ακρίβειας παρέχουν πιο λεπτομερή πληροφορία με μεγαλύτερο κόστος, 
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μέσω δεδομένων μικρότερης κλίμακας. Τέλος, με τους αυξανόμενους χρονικούς και 

οικονομικούς πόρους, οι τοπικές εκστρατείες παρατήρησης, ακόμα και αν περιορίζονται σε 

μικρές περιόδους, μπορούν να παρέχουν λεπτομερή κατανόηση της απόκρισης της λεκάνης 

απορροής σε τοπική κλίμακα. 

Υπό το φως των εξελίξεων στην απόκτηση δεδομένων, υπάρχουν ομόφωνες απόψεις πως 

πλησιάζει σύντομα η εποχή κατά την οποία, παρόλη τη μείωση των πολλών επίγειων 

παρατηρήσεων εξαιτίας των οικονομικών περικοπών, η υδρολογία, λόγω της αυξημένης 

διαθεσιμότητας και ποιότητας δεδομένων τηλεπισκόπησης, δε θα περιορίζεται από την έλλειψη 

κλιματικών δεδομένων. Ακόμη, θα εμφανίζονται νέες ευκαιρίες για αφομοίωση δεδομένων η 

οποία θα είναι πολύτιμη για τη βελτίωση των προβλέψεων σε μη μετρούμενες λεκάνες 

απορροής. 

Όλα τα παραπάνω έχουν ομαδοποιηθεί και αναλυθεί σε πέντε κατηγορίες βημάτων προόδου: 

• Πρόοδος στην τεχνολογία radar και δορυφόρων 

• Πρόοδος στην τεχνολογία επίγειων παρατηρήσεων 

• Νέα δεδομένα και πρόοδος στην κατανόηση των διεργασιών μέσω πειραματικών 

μελετών 

• Δεδομένα ιχνηθετήσεων και πρόοδος στην κατανόηση των διεργασιών μεταφοράς 

• Πρόοδος στην κατανόηση της εξάρτησης από την κλίμακα μέσω δεδομένων αυξημένης 

κάλυψης και ανάλυσης 

Μοντέλα, ανάλυση αβεβαιότητας και διαγνώσεις 

Μέχρι την έναρξη της πρωτοβουλίας PUB, ο πολλαπλασιασμός των εμπορικών λογισμικών 

μοντελοποίησης οδήγησε σε πόλωση μεταξύ διαφορετικών ομάδων που υποστήριζαν το κάθε 

λογισμικό και δινόταν ιδιαίτερη έμφαση στον καθορισμό των τύπων των μοντέλων (π.χ., 

φυσικής βάσης - εννοιολογικά) που θα προτιμούνταν παγκόσμια. Δηλαδή, αντί να ελέγχεται το 

πιο κατάλληλο μοντέλο για κάθε συγκεκριμένη, μοναδική λεκάνη απορροής, ελεγχόταν ο 

κώδικας του μοντέλου για την ικανότητά του να εφαρμόζεται σε παγκόσμιο επίπεδο. 

Όμως, κατά τη διάρκεια της πρωτοβουλίας PUB αναπτύχθηκε μία αυξανόμενη κατανόηση της 

σημασίας της εξωστρέφειας ως προς διαφορετικές προσεγγίσεις και της προθυμίας για 

επικοινωνία και έρευνα για νέες ευκαιρίες. Αυτά οδήγησαν σε μία πολύ περισσότερο ανοικτή 

στάση ως προς τη μοντελοποίηση και τη διασταύρωση μεταξύ εννοιών. Παράδειγμα είναι η 

μίξη μηχανικών περιγραφών με την αφομοίωση δεδομένων, πειραματισμοί και δοκιμές με 

αλγορίθμους, συγχώνευση μεθόδων και χρήση προσεγγίσεων για πολλές λεκάνες απορροής για 

τον έλεγχο των παραδοχών και υποθέσεων. Ως εκ τούτου, έγινε ευρέως αποδεκτό ότι κανένα 

μοντέλο δεν είναι τέλειο και δόθηκε μεγαλύτερη σημασία στις διαδικασίες μοντελοποίησης και 

τις παραδοχές που εμπλέκονται από ό,τι στην ονομασία και τη φήμη ενός μοντέλου. 

Επιπλέον, αξιοποιήθηκαν νέα δεδομένα στα μοντέλα βροχόπτωσης - απορροής καθώς η 

ικανότητα πρόβλεψης περιορίζεται αν αυτά στηρίζονται μόνον σε παρατηρημένα 

υδρογραφήματα. 

Παράλληλα, έγινε πρόοδος στη διαδικασία βαθμονόμησης μοντέλων και τον έλεγχό τους και, 

ακόμη, διατυπώθηκαν νέοι τροποποιημένοι συντελεστές προσδιορισμού σαν αυτόν των Nash 

και Sutcliffe, ΝSE, καθώς ο NSE παρουσιάζει υπερευαισθησία στις παροχές αιχμής της 

απορροής. 

Επίσης, η επιστημονική κοινότητα ευαισθητοποιήθηκε σχετικά με την ανάλυση αβεβαιότητας 

και την ανάγκη αυτή να λάβει μία πιο εξέχουσα θέση στην υδρολογία. 
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Τέλος, με όλες αυτές τις εξελίξεις, διατυπώθηκε η άποψη πως τα μοντέλα μπορούν να 

χρησιμοποιηθούν ως εργαλεία εκμάθησης καθώς έχουν τη δυνατότητα να διδάξουν στην 

επιστημονική κοινότητα περισσότερα σχετικά με το υδρολογικό σύστημα. 

Ταξινόμηση λεκανών απορροής και νέα θεωρία 

Οι υδρολογικές επιστήμες χαρακτηρίζονται από ουσιώδη ετερογένεια των διεργασιών μεταξύ 

διάφορων τοποθεσιών καθώς και από χωρικές και χρονικές κλίμακες. Για πολύ καιρό, αυτή η 

ετερογένεια παρεμπόδιζε τις προσπάθειες για εμβάθυνση και κατανόηση σχετικά με το τι 

ελέγχει τις υδρολογικές διεργασίες και πως αυτές συνδέονται μεταξύ τους. Ωστόσο, από τις 

γνώσεις σχετικά με τις επιδράσεις αυτών των ετερογενειών στα πρότυπα απόκρισης μπορεί να 

παραχθεί μία ολιστική θεωρία για την υδρολογία. Η αναγνώριση των σχέσεων κλιμάκωσης, 

καθώς και η ανάπτυξη συστημάτων ταξινόμησης λεκανών απορροής και πλαισίων ομοιότητας, 

που βασίζονται σε συγκριτικές μελέτες, μπορούν να φανούν ως ένας πολλά υποσχόμενος 

δρόμος προς τη σύνθεση. 

Έτσι, κατά τη πρωτοβουλία PUB επετεύχθη πρόοδος στις διεργασίες και την περιοχοποίηση 

των παραμέτρων, στην ταξινόμηση των λεκανών απορροής και τα πλαίσια ομοιότητας, και 

στην ανάπτυξη νέας υδρολογικής θεωρίας. 

Η περαιτέρω ανάλυση των παραπάνω ξεφεύγει από τα όρια της παρούσας εργασίας. 

2.3 Προσομοίωση και βαθμονόμηση σε μη μετρούμενες λεκάνες 

απορροής 

2.3.1 Γενικά 

Στη ανάλυση συστημάτων υδατικών πόρων η διαδικασία της προσομοίωσης ενός συστήματος 

εφαρμόζεται σε μεγάλο βαθμό για την μελέτη και την κατασκευή ενός τεχνικού έργου, τη 

διαχείριση των υδατικών αποθεμάτων μιας περιοχής, την έρευνα κ.α. Ένας ορισμός που έχει 

δοθεί για την προσομοίωση είναι «η τεχνική μίμησης της συμπεριφοράς ενός πραγματικού 

συστήματος σε ό,τι αφορά στη χρονική του εξέλιξη» (Winston, 1994). Η προσομοίωση ενός 

συστήματος υδατικών πόρων μπορεί να υλοποιηθεί με την κατάρτιση ενός μοντέλου το οποίο 

λαμβάνει τις εισόδους του συστήματος, τις επεξεργάζεται κατάλληλα και εξάγει τα ζητούμενα 

αποτελέσματα. Με την εξέλιξη της τεχνολογίας και τις επιστήμης έχει αναπτυχθεί ένα μεγάλο 

εύρος μοντέλων που σχετίζονται με τα υδατικά συστήματα, το οποίο περιλαμβάνει μοντέλα 

που μπορούν να επιλύουν απλές μαθηματικές εξισώσεις μέχρι και ιδιαίτερα σύνθετα μοντέλα 

που περιλαμβάνουν διάφορες υδρολογικές μεθόδους για την προσομοίωση, επεξεργάζονται 

μεγάλο όγκο δεδομένων και πληροφοριών και αλληλοεπιδρούν με άλλα συστήματα και 

προγράμματα σε ηλεκτρονικούς υπολογιστές. Φυσικά, η προσομοίωση της υδρολογικής 

λειτουργίας και απόκρισης μιας ή περισσότερων λεκανών απορροής έχει απασχολήσει σε 

μεγάλο βαθμό την επιστημονική κοινότητα και έχει σταθεί αφορμή για την ανάπτυξη τέτοιων 

μοντέλων. Από τα παραπάνω φαίνεται πως οι έννοιες τις προσομοίωσης και της 

μοντελοποίησης προσεγγίζουν η μία την άλλη αλλά δεν είναι απολύτως ταυτόσημες. 

Η άλλη βασική έννοια στην ανάλυση συστημάτων είναι η βελτιστοποίηση η οποία γενικά 

ορίζεται ως «η διαδικασία του σχεδιασμού ή της λειτουργίας ενός συστήματος η οποία κάνει 

το σύστημα όσο το δυνατόν καλύτερο κατά μία προκαθορισμένη έννοια. Μαθηματικά αυτό 

ισοδυναμεί με την εύρεση μιας ή περισσότερων λύσεων που είναι οι καλύτερες δυνατές» 

(Ναλμπάντης, 2007). Στην πράξη, στα διάφορα μοντέλα προσομοίωσης της υδρολογικής 

λειτουργίας λεκανών απορροής η βαθμονόμηση είναι η διαδικασία καθορισμού των βέλτιστων 
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τιμών των παραμέτρων των διαφόρων εξισώσεων που υπεισέρχονται στο μοντέλο, υπό την 

έννοια της επιτυχούς αναπαράστασης του φυσικού συστήματος, δηλαδή της λεκάνης 

απορροής. Η βαθμονόμηση είναι μια διαδικασία βελτιστοποίησης. Όσο πιο πιστά στην 

πραγματικότητα είναι τα αποτελέσματα που εξάγει ένα μοντέλο τόσο πιο αξιόπιστο μπορεί να 

θεωρηθεί για περαιτέρω αναλύσεις, κατασκευή σεναρίων και προβλέψεις. Η βαθμονόμηση 

ενός μοντέλου επιτυγχάνεται με την κατάρτιση κάποιων συντελεστών οι οποίοι 

ποσοτικοποιούν το πόσο καλά προσαρμόζονται τα δεδομένα του μοντέλου με τα αντίστοιχα 

μετρημένα δεδομένα. Τέτοιοι συντελεστές είναι ο συντελεστής προσδιορισμού των Nash και 

Sutcliffe (NSE), το μέσο τετραγωνικό σφάλμα (RMSE) και το μέσο σφάλμα ή μεροληψία 

(BIAS) τα οποία σε αυτό το υποκεφάλαιο απλά αναφέρονται και δεν αναλύονται περαιτέρω. 

Στην προσομοίωση λεκανών απορροής τα δεδομένα που χρησιμοποιούνται στην εκτίμηση των 

παραπάνω συντελεστών είναι οι χρονοσειρές των μετρημένων και των προσομοιωμένων 

παροχών στην έξοδο κάθε λεκάνης ή τα στατιστικά αυτών των χρονοσειρών. 

2.3.2 Το αδιέξοδο που προκύπτει σε μη μετρούμενες λεκάνες απορροής 

Σε μία τυπική διαδικασία προσομοίωσης μίας λεκάνης απορροής, με στόχο την πιστότερη 

αναπαράσταση του συστήματός της, τα βήματα που απαιτούνται, χωρίς βέβαια να είναι 

αποκλειστικά αυτά, μπορούν να κατηγοριοποιηθούν ως εξής: 

• Συλλογή δεδομένων 

- Γεωγραφικά δεδομένα 

- Δεδομένα κάλυψης γης 

- Εδαφολογικά δεδομένα 

- Κλιματολογικά - Μετεωρολογικά δεδομένα (θερμοκρασία, βροχόπτωση, 

χιονόπτωση, άνεμος, πίεση) 

- Υδρολογικά δεδομένα (παροχή, στάθμη) 

• Κατάρτιση του μοντέλου με βάση τις αρχές λειτουργίας του και τις επιλογές που δίνει 

στον χρήστη 

• Βαθμονόμηση του μοντέλου 

- Χειροκίνητα 

- Με χρήση διαφόρων τεχνικών και αλγορίθμων βελτιστοποίησης 

• Χρήση του μοντέλου για την εκάστοτε μελέτη ή εφαρμογή 

Όπως όμως έχει αναφερθεί στα προηγούμενα υποκεφάλαια, στις μη μετρούμενες λεκάνες 

απορροής υπάρχει πλήρης έλλειψη δεδομένων απορροής, πράγμα που σημαίνει ότι δεν μπορεί 

να πραγματοποιηθεί η βαθμονόμηση μέσω των συντελεστών καλής προσαρμογής του 

μοντέλου. Έτσι, δεν υπάρχει σωστή εκτίμηση των διαφόρων παραμέτρων του και με αυτή την 

προσέγγιση ένα μοντέλο καθίσταται πρακτικά άχρηστο στην προσομοίωση μη μετρούμενων 

λεκανών. 

Επομένως, η επιστημονική κοινότητα καλείται να βρει και να εφαρμόσει μεθόδους για να 

καταφέρει να παρακάμψει αυτό το αδιέξοδο. Μερικές λύσεις, μέθοδοι και στόχοι που έχουν 

ήδη αναφερθεί από την PUB και συνοψίζονται είναι η ανάπτυξη νέας θεωρίας και νέων 

μοντέλων που να μπορούν να εφαρμοστούν σε μη μετρούμενες λεκάνες, η χρήση δορυφορικών 

δεδομένων εκτίμησης των υδρολογικών μεγεθών μιας λεκάνης απορροής άμεσα ή έμμεσα και, 

τέλος, η εξέταση σχέσεων ομοιότητας μεταξύ λεκανών απορροής, η ταξινόμησή τους και η 

κατάλληλη μεταφορά παραμέτρων από τη μία λεκάνη στην άλλη, αντικείμενα τα οποία 

αναλύονται εκτενέστερα σε επόμενο κεφάλαιο.  
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3 Γεωμορφολογικά χαρακτηριστικά και ομοιότητα 

λεκανών απορροής 

3.1 Γενικά 

Στην επιστήμη της Υδρολογίας και τη μελέτη των λεκανών απορροής ιδιαίτερο ρόλο κατέχει 

η Γεωμορφολογία της κάθε λεκάνης, καθώς αυτή επηρεάζει σε σημαντικό βαθμό τις διεργασίες 

του υδρολογικού κύκλου και ιδιαίτερα αυτές που σχετίζονται άμεσα με τη φυσική επιφάνεια 

του εδάφους, όπως η δημιουργία της απορροής από τα κατακρημνίσματα, η διάβρωση του 

εδάφους κ.α.. Με τον όρο Γεωμορφολογία εννοείται η επιστήμη που εξετάζει τα φυσικά 

χαρακτηριστικά των διαφόρων μορφών του ανάγλυφου της γης και τις διεργασίες που επιδρούν 

στη διαμόρφωσή του (Τσακίρης, 2013). Τα γεωμορφολογικά χαρακτηριστικά μιας λεκάνης 

απορροής, συναντιούνται και ως φυσιογραφικά χαρακτηριστικά. Διακρίνονται σε τρεις 

βασικές κατηγορίες: 

• Τα μορφολογικά ή μορφομετρικά χαρακτηριστικά που περιλαμβάνουν το μέγεθος, το 

σχήμα, το υψόμετρο, το ανάγλυφο και τις κλίσεις της λεκάνης απορροής καθώς και την 

κατάταξη του υδρογραφικού δικτύου, την πυκνότητά του και τη γεωμετρία του κύριου 

ρεύματος αυτού  

• Τα εδαφολογικά χαρακτηριστικά που περιλαμβάνουν τις μηχανικές ιδιότητες και τη 

χημική σύσταση του εδάφους της λεκάνης απορροής 

• Οι κατηγορίες κάλυψης της λεκάνης απορροής, όπως για παράδειγμα η διακριτοποίηση 

που παρουσιάζει το πρόγραμμα CORINE Land Cover 

Η πρώτη από τις παραπάνω κατηγορίες παρουσιάζει ιδιαίτερο ενδιαφέρον γιατί τα 

μορφολογικά χαρακτηριστικά των λεκανών απορροής αποτελούν ένα είδος ταυτότητας για 

αυτές και μπορούν να χρησιμοποιηθούν για τη σύγκριση μεταξύ τους ή την κατηγοριοποίησή 

τους σε κλάσεις σύμφωνα με ένα ή περισσότερα χαρακτηριστικά, σε ποσοτικό πάντα επίπεδο 

καθώς κάθε χαρακτηριστικό από αυτά είναι μετρήσιμο ή υπολογίσιμο άμεσα. Έτσι, εδώ 

εισέρχεται η έννοια της ομοιότητας λεκανών απορροής κατά την οποία μπορεί να εξαχθεί ένα 

συμπέρασμα για το πόσο όμοιες θεωρούνται δύο ή περισσότερες λεκάνες απορροής σύμφωνα 

με διάφορες προσεγγίσεις ή μεθοδολογίες που χρησιμοποιούν τις τιμές αυτών των 

χαρακτηριστικών. 

Στη συνέχεια, παρουσιάζονται τα μορφομετρικά χαρακτηριστικά των λεκανών απορροής και 

αναλύεται η έννοια της ομοιότητας των λεκανών απορροής υπό το πρίσμα των μη μετρούμενων 

λεκανών απορροής. 

3.2 Τα μορφομετρικά χαρακτηριστικά των λεκανών απορροής 

3.2.1 Μέγεθος λεκάνης απορροής 

Το μέγεθος της λεκάνης απορροής αναφέρεται στην επιφάνεια που αυτή καταλαμβάνει. 

Κυμαίνεται από λίγα m2 ως και μερικές χιλιάδες km2, ιδίως για τα μεγάλα ποτάμια. Ορίζεται 

από την επιφάνεια που περικλείει η νοητή γραμμή του υδροκρίτη, δηλαδή η γραμμή που 

θεωρείται πως χωρίζει μια λεκάνη από τις όμορές της, ή, αλλιώς, η γραμμή εκείνη που 
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καθορίζει αν μια σταγόνα βροχής θα απορρεύσει εντός της λεκάνης. Ο υδροκρίτης, και κατ΄ 

επέκταση, το μέγεθος της επιφάνειας που οριοθετεί, είναι διαφορετικός για κάθε σημείο του 

υδατορεύματος που επιλέγεται ως έξοδος της λεκάνης. Έτσι, για ένα υδατόρευμα μπορούν να 

οριστούν άπειρα σημεία εξόδου που συνεπάγεται άπειρους υδροκρίτες και άπειρα διαφορετικά 

μεγέθη λεκάνης. 

Το μέγεθος της λεκάνης απορροής επηρεάζει σημαντικά και άμεσα την υδρολογική 

συμπεριφορά της λεκάνης σε διάφορους παράγοντες, καθώς, όσο πιο μεγάλη είναι μια λεκάνη, 

τόσο αυξάνεται η συνολική απορροή της και ο χρόνος συγκέντρωσης, χωρίς αυτά να 

συσχετίζονται γραμμικά μεταξύ τους. Η παραπάνω διαπίστωση μπορεί να εξηγήσει, εν μέρει, 

γιατί σε λεκάνες με μικρό μέγεθος όπως οι ελληνικές παρατηρούνται μικροί χρόνοι 

συγκέντρωσης και, έτσι, αυξημένες πιθανότητες εμφάνισης πλημμυρικών γεγονότων. 

Παράλληλα, όσο μειώνεται το μέγεθος της λεκάνης, τόσο αυξάνει η κλίση της, ενώ όσο 

αυξάνεται το μέγεθος της λεκάνης, τόσο μειώνεται η ειδική παροχή (m3/s/km2). 

3.2.2 Σχήμα λεκάνης απορροής 

Το σχήμα της λεκάνης απορροής είναι άλλο ένα σημαντικό φυσικό χαρακτηριστικό γιατί 

επηρεάζει σε μεγάλο βαθμό το χρόνο συγκέντρωσης της απορροής και, επομένως, το μέγεθος 

της παροχής στην έξοδο της λεκάνης. Οι λεκάνες απορροής με σχετικά επίμηκες σχήμα 

παρουσιάζουν μεγαλύτερο χρόνο συγκέντρωσης από ό,τι οι λεκάνες με σχετικά κυκλικό ή 

ριπιδοειδές σχήμα και, κάτω από τις ίδιες συνθήκες, οι πρώτες εμφανίζουν μικρότερες παροχές 

στην έξοδό τους (Τσακίρης, 2013). 

Το σχήμα της λεκάνης στην πράξη είναι πολύπλοκο και δεν μοιάζει με κάποιο από τα απλά 

γεωμετρικά σχήματα. Έτσι, δεν μπορεί εύκολα να προσδιορισθεί και να εκφρασθεί αριθμητικά 

με ακρίβεια και σαφήνεια. Παρόλα αυτά, έχουν προταθεί και χρησιμοποιηθεί διάφοροι 

αδιάστατοι δείκτες, οι οποίοι προσφέρουν πληροφορία για το σχήμα της λεκάνης απορροής: 

• Δείκτης κυκλικότητας (Rc). Ο λόγος της επιφάνειας της λεκάνης A προς την επιφάνεια 

κύκλου με περίμετρο ίδια με αυτή της λεκάνης (P). Ισούται με: 

 𝑅𝑐 =
4𝜋𝐴

𝑃2
 (3.1) 

• Δείκτης επιμήκυνσης (RL). Ο λόγος της διαμέτρου κύκλου με εμβαδό A ίσο με εκείνο 

της λεκάνης προς το μήκος της λεκάνης, L, παράλληλα με το κύριο υδατόρευμα. Ισούται 

με: 

 𝑅𝐿 =
2√𝐴/𝜋

𝐿
 (3.2) 

• Δείκτης συγκέντρωσης, ή Cravelius (KC). Ο λόγος της περιμέτρου (P) μιας λεκάνης με 

επιφάνεια A, προς την περίμετρο ενός κύκλου με την ίδια επιφάνεια (A). 

 𝐾𝐶 =
P

2√𝜋𝐴
=

0.28𝑃

√𝐴
 (3.3) 

3.2.3 Υψόμετρο λεκάνης απορροής 

Το υψόμετρο της λεκάνης απορροής έχει άμεση σχέση τόσο με τα κατακρημνίσματα που 

δέχεται, όσο και με τις θερμοκρασίες που επικρατούν σε αυτή. Συγκεκριμένα, τα 

κατακρημνίσματα αυξάνουν όσο αυξάνει το υψόμετρο της λεκάνης, μέχρι τα 2500 m περίπου, 

ενώ από εκεί και πάνω παρατηρείται ελάττωση εξαιτίας της μείωσης της αέριας μάζας σε 

υδρατμούς (Τσακίρης, 2013). Αντίθετα, η θερμοκρασία μειώνεται όσο αυξάνει το υψόμετρο. 

Αυτή η άμεση σχέση του υψομέτρου της λεκάνης απορροής με τα κατακρημνίσματα και τη 
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θερμοκρασία συντελεί και στον επηρεασμό της απορροής από το υψόμετρο. Πιο αναλυτικά, 

μεγαλύτερο ύψος κατακρημνισμάτων συντελεί στην αύξηση της απορροής και χαμηλότερες ή 

υψηλότερες θερμοκρασίες συνεπάγονται ελάττωση ή αύξηση της εξάτμισης αντίστοιχα. 

Επιπλέον, η θερμοκρασία καθορίζει και το ποσοστό των κατακρημνισμάτων που πέφτουν υπό 

μορφή χιονιού, καθώς και τη διάρκεια παραμονής του στο έδαφος. Οι συνθήκες αυτές 

επηρεάζουν με τη σειρά τους την απορροή στην έξοδο της λεκάνης σημαντικά (Τσακίρης, 

2013). 

3.3 Ομοιότητα λεκανών απορροής 

3.3.1 Γενικά 

Ο όρος υδρολογική ομοιότητα (hydrologic similarity) αναφέρεται στην ομοιότητα που 

παρουσιάζουν διάφορα χαρακτηριστικά του υδρολογικού κύκλου σε διαφορετικές περιοχές, ή 

πιο ειδικά, σε ξεχωριστές λεκάνες απορροής. Τα χαρακτηριστικά αυτά μπορεί να είναι: 

γεωμορφολογικά, κλιματολογικά, γεωλογικά και εδαφολογικά, ή χαρακτηριστικά κάλυψης 

γης. Βέβαια, η φύση του όρου είναι υποκειμενική και ασαφής και δεν μπορεί να 

ποσοτικοποιηθεί με ακρίβεια, γιατί υπάγεται, κάθε φορά, στην εκάστοτε προσέγγιση και 

σκοπιά μελέτης και γιατί τα όρια ομοιότητας μεταξύ δύο ή περισσότερων λεκανών απορροής 

μπορεί να είναι δυσδιάκριτα. Για αυτό το λόγο, η επιστημονική κοινότητα αποφεύγει να δώσει 

έναν απόλυτο ορισμό που να μπορεί να ανταποκριθεί σε κάθε μελέτη, πείραμα ή εργασία. 

Παρόλα αυτά μία αρκετά ασφαλής μέθοδος για την εξαγωγή συμπερασμάτων σχετικά με τον 

βαθμό ομοιότητας μεταξύ λεκανών απορροής είναι η σύγκριση και η ταξινόμησή τους με βάση 

δείκτες που αφορούν τα χαρακτηριστικά τους, όπως αναλύεται εκτενέστερα στο επόμενο 

υποκεφάλαιο.  

3.3.2 Ταξινόμηση λεκανών απορροής 

Σύμφωνα με τον Sivapalan (2005) «μια λεκάνη απορροής είναι ένα αυτό-οργανωμένο σύστημα 

του οποίου το σχήμα, το υδρογραφικό δίκτυο, το υπέδαφος, οι κλίσεις και οι υδραυλικές 

γεωμετρίες των υδατορευμάτων του, τα εδάφη του και η βλάστησή του είναι όλα ένα 

αποτέλεσμα προσαρμοσμένων οικολογικών και γεωμορφολογικών διεργασιών. Άρα, ενώ η 

πολυπλοκότητα και οι διαφορές μεταξύ λεκανών απορροής μπορούν συχνά να είναι 

υπερβολικές, κάποια μοτίβα και συνδέσεις μπορούν να είναι διακριτά και να οδηγούν σε 

πρόοδο στην υδρολογική επιστήμη μέσω τις διατύπωσης υποθέσεων ή σχέσεων που μπορεί να 

έχουν γενική δυνατότητα εφαρμογής (Wagener et al., 2007) 

Σε αυτό το πλαίσιο, οι Sawicz et al. (2011) ανέπτυξαν μια μεθοδολογία ταξινόμησης λεκανών 

απορροής με ανάλυση κατά συστάδες (cluster analysis) που βασίζεται στην υδρολογική 

ομοιότητα, όχι όμως με απλά γεωμορφολογικά και υδρομετεωρολογικά χαρακτηριστικά, αλλά 

υδρολογικές υπογραφές. Η μελέτη έγινε σε σημαντικό πλήθος λεκανών απορροής (280 λεκάνες 

στις ανατολικές ΗΠΑ). Η ανάλυση κατά συστάδες είναι η διαδικασία ομαδοποίησης όμοιων 

οντοτήτων σύμφωνα με ένα ή περισσότερα επιλεγμένα μέτρα ομοιότητας, που, στην 

προκειμένη περίπτωση, ήταν οι υπογραφές. Οι υδρολογικές υπογραφές ποσοτικοποιούν τα 

χαρακτηριστικά της υδρολογικής απόκρισης, γεγονός που παρέχει μια διορατικότητα στη 

λειτουργική συμπεριφορά μιας λεκάνης απορροής. 

Μια αντίστοιχη έρευνα πραγματοποιήθηκε από τους Papageorgaki and Nalbantis (2016) για 

λεκάνες απορροής του ελλαδικού χώρου. Συγκεκριμένα, αναπτύχθηκε μια μεθοδολογία 

ταξινόμησης 24 λεκανών απορροής, χρησιμοποιώντας τη βροχόπτωση ως τη μόνη διαθέσιμη 
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κλιματολογική παράμετρο και 4 υδρολογικές υπογραφές και 13 γεωμορφομετρικά 

χαρακτηριστικά, ούτως ώστε να συμπεριληφθεί όσο το δυνατόν περισσότερη πληροφορία από 

τα διαθέσιμα ψηφιακά μοντέλα εδάφους. Η μεθοδολογία ταξινόμησης περιλαμβάνει δύο 

βήματα. Στο πρώτο βήμα πραγματοποιείται μη επιβλεπόμενη ταξινόμηση μέσω μιας μεθόδου 

ασαφούς λογικής (fuzzy c-means) για την αναγνώριση των κλάσεων λεκανών απορροής που 

χρησιμεύουν ως κλάσεις αναφοράς στο δεύτερο βήμα της ανάλυσης. Έπειτα, στο δεύτερο βήμα 

πραγματοποιείται μια επιβλεπόμενη ταξινόμηση μέσω μιας μεθόδου εγγύτερου γείτονα (k-

Nearest Neighbor) που χαρτογραφεί τους δείκτες πρόγνωσης στις κλάσεις λεκανών. Τέλος, 

γίνεται μια αξιολόγηση του δείκτη επιτυχίας της ταξινόμησης μέσω μιας μεθόδου 

επαναδειγματοληψίας (jack-knife re-sampling). Η πιο λεπτομερής περιγραφή των 

μαθηματικών και στατιστικών μεθόδων που χρησιμοποιήθηκαν στην ταξινόμηση ξεφεύγει από 

τα πλαίσια της παρούσας εργασίας. Αποτέλεσμα αυτής της έρευνας ήταν η ταξινόμηση των 24 

λεκανών απορροής σε 4 κλάσεις. Στην τρίτη κλάση αυτής της ταξινόμησης ανήκουν και οι 

λεκάνες απορροής του Αγραφιώτη και του Κρικελιώτη που μελετώνται στην παρούσα εργασία 

και για αυτό το λόγο θεωρούνται και αναφέρονται ως όμοιες. Σημειώνεται ότι η κλάση 3 των 

λεκανών περιλαμβάνει λεκάνες με μετρίως υψηλό συντελεστή απορροής, μεγάλο εύρος 

μεταβολής της παροχής, μέτρια συμβολή της βασικής ροής στη συνολική απορροή, και υψηλή 

συμβολή της χιονόπτωσης στα ατμοσφαιρικά κατακρημνίσματα. 

3.3.3 Περιοχοποίηση και μεταφορά παραμέτρων 

Ο όρος περιοχοποίηση (regionalization) για την υδρολογία και τη διαχείριση υδατικών πόρων 

αναφέρεται στις μεθόδους και τεχνικές μεταφοράς πληροφορίας από γειτονικές και όχι μόνο 

λεκάνες απορροής στη λεκάνη ενδιαφέροντος. Μερικές ευρέως χρησιμοποιούμενες μέθοδοι 

είναι απλές αριθμητικές μέθοδοι όπως η μέση τιμή μιας ιδιότητας ή παραμέτρου ενός μεγάλου 

δείγματος λεκανών απορροής, οι μέθοδοι παλινδρόμησης στις ιδιότητες των λεκανών 

απορροής, οι μέθοδοι χωρικής εγγύτητας μεταξύ της υπό μελέτης μη μετρούμενης λεκάνης και 

άλλων οι οποίες έχουν μετρήσεις με χρήση βαρών και τέλος η απευθείας, αυτούσια μεταφορά 

παραμέτρων (Parajka et al., 2005). 

Η τελευταία μέθοδος προϋποθέτει τον υψηλό βαθμό υδρολογικής ομοιότητας μεταξύ της 

λεκάνης δότη και της λεκάνης δέκτη παραμέτρων γιατί, σε αντίθετη περίπτωση, στον ήδη 

μεγάλο βαθμό αβεβαιότητας αυτής της διαδικασίας θα έρθει να προστεθεί και η αβεβαιότητα 

που προκύπτει από τη μη ομοιότητα των λεκανών απορροής. Στην παρούσα εργασία, λόγω της 

απόδειξης από προηγούμενο ερευνητικό έργο των Papageorgaki and Nalbantis (2016) για τον 

υψηλό βαθμό ομοιότητας των δύο υπό μελέτη λεκανών απορροής, του Αγραφιώτη και του 

Κρικελιώτη, εφαρμόζεται αυτή η προσέγγιση και η μεταφορά των παραμέτρων της 

προσομοίωσης γίνεται απευθείας μεταξύ των λεκανών. 
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4 Μοντέλα βροχόπτωσης - απορροής – Το μοντέλο 

HEC-HMS   

4.1 Ορισμός 

Όπως αναφέρεται από το Ναλμπάντη (2007): «Ως μοντέλο βροχόπτωσης - απορροής ορίζεται 

ένα σύνολο μαθηματικών σχέσεων, είτε αλγεβρικών είτε διαφορικών εξισώσεων ή λογικών 

σχέσεων, που συσχετίζουν την βροχόπτωση με την απορροή. Η αναπαράσταση των 

υδρολογικών διεργασιών μιας λεκάνης απορροής για μια συγκεκριμένη χρονική περίοδο 

ονομάζεται υδρολογική προσομοίωση. Η προσομοίωση ορίζεται ως η τεχνική μίμησης της 

συμπεριφοράς ενός πραγματικού συστήματος σε ό,τι αφορά την χρονική του εξέλιξη. Η 

σχηματική αναπαράσταση ενός μοντέλου βροχόπτωσης – απορροής παρουσιάζεται στο Σχήμα 

2.1». Εδώ το σχήμα είναι το 4.1.    

 

    Είσοδος                     Έξοδος 

 

Σχήμα 4.1: Γενική αναπαράσταση μοντέλου (Πηγή: Ναλμπάντης, 2007, Τσακίρης, 2013) 

Ως δεδομένα εισόδου υπεισέρχονται διάφορες μετεωρολογικές μεταβλητές όπως 

κατακρημνίσματα, θερμοκρασία, ταχύτητα ανέμου κλπ. Οι εξισώσεις του συστήματος 

περιλαμβάνουν ένα σύνολο μαθηματικών εξισώσεων που απεικονίζουν τις φυσικές διαδικασίες 

μετατροπής της βροχής σε απορροή. Τέτοιες φυσικές διαδικασίες είναι η κατακράτηση, η 

εξατμισοδιαπνοή, η διήθηση, η επιφανειακή απορροή, η ενδιάμεση απορροή και η αποθήκευση 

στο έδαφος. Επίσης, το αυξημένο ενδιαφέρον για τη ρύπανση των επιφανειακών και υπόγειων 

νερών τα τελευταία χρόνια, έχει οδηγήσει στην εισαγωγή αλγορίθμων προσομοίωσης χημικών 

διαδικασιών στα υδρολογικά μοντέλα. Η έξοδος του μοντέλου, μετά την εφαρμογή των 

εξισώσεων με τα δεδομένα εισόδου, δίνει την απορροή (Τσακίρης, 2013). 

4.2 Ταξινόμηση μοντέλων βροχόπτωσης - απορροής 

Η ταξινόμηση των μοντέλων βροχόπτωσης – απορροής γίνεται με βάση τα παρακάτω κριτήρια, 

που αναφέρουν οι Ναλμπάντης και Τσακίρης (2006): 

« 

• Ο χειρισμός της χωρικής κατανομής των φυσικών διεργασιών μετασχηματισμού της 

βροχόπτωσης σε απορροή εντός της εξεταζόμενης λεκάνης. 

• Το είδος των μαθηματικών εξισώσεων και σχέσεων για την αναπαράσταση των 

φυσικών διεργασιών στη θεωρούμενη λεκάνη 

• Ο τρόπος χειρισμού της αβεβαιότητας των υδρολογικών μεγεθών. 

• Η λειτουργία του μοντέλου σε σχέση με τον χρόνο (συνεχής ή όχι). 

Σύμφωνα με το κριτήριο της χωρικής κατανομής των φυσικών διεργασιών, τα μοντέλα 

διακρίνονται σε αδιαμέριστα και κατανεμημένα. Στα αδιαμέριστα (lumped), ολόκληρη η 

λεκάνη απορροής αντιμετωπίζεται ως ενιαία χωρική ενότητα που δέχεται ως εισόδους την 

Εξισώσεις 

Συστήματος 
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χωρικά μέση βροχόπτωση και τις χωρικά μέσες τιμές άλλων μεγεθών τα οποία 

μετασχηματίζονται μέσω μαθηματικών σχέσεων που είναι χωρικά ομογενείς. Στα 

κατανεμημένα (distributed) η λεκάνη απορροής διασπάται σε στοιχειώδη τμήματα τέτοια ώστε 

να αναπαρίσταται η χωρική κατανομή των φυσιογραφικών ή άλλων χαρακτηριστικών της 

λεκάνης (υψόμετρα, κλίση, γεωλογικό υπόβαθρο, κλπ). Τα κατανεμημένα μοντέλα που έχουν 

μικρό πλήθος χωρικών ενοτήτων αναφέρονται και ως ημικατανεμημένα (semi-distributed). 

Σύμφωνα με το κριτήριο του είδους των μαθηματικών εξισώσεων τα μοντέλα διακρίνονται σε 

μοντέλα «μαύρου κουτιού», εννοιολογικά μοντέλα και μοντέλα φυσικής βάσης. Στα μοντέλα 

«μαύρου κουτιού» (black box) οι φυσικές διεργασίες αναπαρίστανται από σχέσεις της γενικής 

θεωρίας της ανάλυσης συστημάτων, χωρίς καμία θεώρηση των ιδιαίτερων χαρακτηριστικών 

(φυσικοί νόμοι, εμπειρικές σχέσεις) του υπό μελέτη συστήματος, δηλαδή της λεκάνης 

απορροής. Στα εννοιολογικά ή παραμετρικά μοντέλα (conceptual) οι φυσικές διεργασίες 

αναπαρίστανται με απλές μαθηματικές σχέσεις που έχουν καταρτιστεί με εμπειρικό τρόπο. Οι 

σχέσεις αυτές όπως και εκείνες των μοντέλων «μαύρου κουτιού» περιλαμβάνουν άγνωστες 

παραμέτρους που εκτιμούνται ειδικά για την εξεταζόμενη λεκάνη. Στα μοντέλα φυσικής βάσης 

(physics-based) οι μαθηματικές σχέσεις αναπαριστούν τους φυσικούς νόμους που διέπουν το 

μετασχηματισμό της βροχόπτωσης σε απορροή. 

Σύμφωνα με το κριτήριο του τρόπου χειρισμού της αβεβαιότητας τα μοντέλα διακρίνονται σε 

αιτιοκρατικά και στοχαστικά. Στα αιτιοκρατικά (deterministic) όλα τα υδρολογικά μεγέθη που 

υπεισέρχονται θεωρούνται ότι έχουν συγκεκριμένες τιμές (γνωστές ή όχι) χωρίς αβεβαιότητα. 

Στα στοχαστικά (stochastic) ορισμένα από τα υδρολογικά μεγέθη θεωρούνται ότι περιέχουν 

αβεβαιότητα και συνήθως αναπαρίστανται ως στοχαστικέ ανελίξεις (stochastic processes). 

Σύμφωνα με το κριτήριο της λειτουργίας σε σχέση με το χρόνο τα μοντέλα διακρίνονται σε 

μοντέλα υδρολογικού γεγονότος και σε μοντέλα συνεχούς χρόνου. Τα μοντέλα υδρολογικού 

γεγονότος (event-based) λειτουργούν για ένα μεμονωμένο πλημμυρικό γεγονός και συνήθως 

αναπαράγουν μόνο τις κύριες φυσικές διεργασίες που λαμβάνουν χώρα κατά τη διάρκεια 

πλημμυρών. Τα μοντέλα συνεχούς χρόνου (continuous-time) μπορούν να λειτουργούν 

αναπαριστώντας την πλήρη χρονική εξέλιξη των υδρολογικών διεργασιών, τόσο σε υγρές όσο 

και σε ξηρές χρονικές περιόδους. Για το λόγω αυτό, μόνον τα μοντέλα συνεχούς χρόνου 

χρησιμοποιούνται στις εκτιμήσεις του επιφανειακού υδατικού δυναμικού.» 

4.3  Βαθμονόμηση μοντέλων βροχόπτωσης – απορροής 

Η διαδικασία εκτίμησης των παραμέτρων ενός μοντέλου βροχόπτωσης - απορροής με βάση 

μετρήσεις των υδρολογικών μεγεθών εισόδου και εξόδου ονομάζεται βαθμονόμηση 

(calibration). Κατά τη διαδικασία της βαθμονόμησης εισάγονται στο μοντέλο οι χρονοσειρές 

των μεγεθών εισόδου και παράγεται η χρονοσειρά της συνθετικής απορροής. Η πιστότητα της 

αναπαραγωγής της χρονοσειράς της μετρημένης απορροής δείχνει και τον βαθμό επιτυχούς 

προσαρμογής του μοντέλου στα δεδομένα. Δηλαδή, γίνεται μία σύγκριση μεταξύ της 

μετρημένης χρονοσειράς απορροής και της χρονοσειράς συνθετικής απορροής που προέκυψε 

από την διαδικασία προσομοίωσης του μοντέλου και εξάγεται συμπέρασμα για το πόσο καλά 

προσαρμόζονται οι δύο χρονοσειρές και, κατ’ επέκταση, για το πόσο καλά προσαρμόζεται το 

μοντέλο στα δεδομένα. Ως μέτρο καλής προσαρμογής ενός μοντέλου χρησιμοποιείται 

ευρύτατα ο συντελεστής επίδοσης των Nash και Sutcliffe (1970), NSE 
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όπου: 

μετQ : η μετρημένη απορροή 

εκτQ : η εκτιμημένη απορροή 

μετQ : η μέση τιμή της μετρημένης απορροής 

N : το πλήθος παρατηρήσεων 

 

Για το συντελεστή NSE ισχύει: 

 1NSE −  (4.2) 

Αρνητική τιμή του συντελεστή NSE σημαίνει ότι το μοντέλο συμπεριφέρεται χειρότερα από 

την απλή θεώρηση της μέσης τιμής της μετρημένης απορροής και το μοντέλο δεν είναι 

αποδεκτό. Αντίθετα, καλή προσαρμογή του μοντέλου σημαίνει υψηλή τιμή του συντελεστή 

προσδιορισμού που τείνει στη μονάδα. Γενικά, το όριο για να θεωρηθεί ικανοποιητική η 

προσαρμογή του μοντέλου είναι το 0.7 ή 0.8. 

Αν θεωρηθεί ότι διατίθενται ταυτόχρονες χρονοσειρές απορροής από μετρήσεις και 

υδρολογικών μεγεθών εισόδου (π.χ. χωρικά μέσης βροχόπτωσης) και ότι το μοντέλο 

βροχόπτωσης απορροής έχει K παραμέτρους (α1, α2, …, αK) τότε η χρονοσειρά της συνθετικής 

απορροής για τυχούσες τιμές των παραμέτρων α1, α2, …, αK προκύπτει ως μια συνάρτηση των 

παραμέτρων και των υδρολογικών μεγεθών. Αν τα παραπάνω εφαρμοστούν στη Σχέση 4.1 

προκύπτει σχέση από την οποία είναι εφικτός ο υπολογισμός των βέλτιστων τιμών των 

παραμέτρων εφαρμόζοντας μια οποιαδήποτε κατάλληλη μέθοδο βελτιστοποίησης. Η 

συνάρτηση στόχου προς μεγιστοποίηση είναι το NSE και οι μεταβλητές απόφασης είναι οι 

παράμετροι. Σε κάθε επαναληπτικό βήμα της διαδικασίας βελτιστοποίησης πραγματοποιείται 

ένα τρέξιμο του μοντέλου για μια ορισμένη χρονική περίοδο που ονομάζεται περίοδος 

βαθμονόμησης, έτσι ώστε να υπολογιστεί η χρονοσειρά της εκτιμημένης ή συνθετικής 

απορροής. 

Μετά τον υπολογισμό των βέλτιστων τιμών των παραμέτρων, αυτές εισάγονται στο μοντέλο 

μαζί με χρονοσειρές των υδρολογικών μεγεθών εισόδου για την υπό μελέτη λεκάνη, αλλά για 

μια χρονική περίοδο διαφορετική από την περίοδο βαθμονόμησης, η οποία λέγεται περίοδος 

επαλήθευσης. Στη συνέχεια, γίνεται τρέξιμο του μοντέλου και λαμβάνεται η τιμή του NSE. Αν 

η τιμή αυτή είναι σχετικά συγκρίσιμη με τη συνήθως μεγαλύτερη βέλτιστη τιμή που έχει 

προκύψει κατά την περίοδο βαθμονόμησης, τότε το μοντέλο γίνεται δεκτό για περαιτέρω 

χρησιμοποίηση. Αν οι δύο τιμές διαφέρουν σημαντικά, τότε το μοντέλο δεν γίνεται δεκτό και 

απορρίπτεται (Ναλμπάντης, 2007). 
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4.4 Το μοντέλο HEC-HMS (Hydrologic Engineering Center – Hydrologic 

Modeling System) 

4.4.1 Γενικά 

Το μοντέλο HEC-HMS (Hydrologic Engineering Center – Hydrologic Modeling System) 

δημιουργήθηκε από το Σώμα Μηχανικών του Στρατού των ΗΠΑ. Σχεδιάστηκε για την 

προσομοίωση των διαδικασιών βροχόπτωσης – απορροής σε λεκάνες απορροής δενδριτικού 

τύπου. Μπορεί να γίνει εφαρμογή του  σε ένα μεγάλο εύρος γεωγραφικών περιοχών για να 

επιλύσει μια εκτενή λίστα προβλημάτων. Έτσι, μπορεί να χρησιμοποιηθεί για την 

προσομοίωση μεγάλων λεκανών απορροής ποταμών αλλά και για την προσομοίωση μικρών 

αστικών ή φυσικών λεκανών απορροής. Τα υδρογραφήματα που παράγει μπορούν είτε άμεσα 

ή σε συνδυασμό με άλλα λογισμικά να χρησιμοποιηθούν σε μελέτες διαθεσιμότητας νερού, 

αστικής απορροής, πρόβλεψης απορροής, επίδρασης μελλοντικής αστικοποίησης κ.α. (US 

Army Corps of Engineers, 2018). 

Το λογισμικό HEC-HMS αποτελεί ένα γενικευμένο σύστημα μοντελοποίησης το οποίο είναι 

ικανό να αναπαραστήσει πολλές διαφορετικές λεκάνες απορροής. Κατασκευάζεται ένα 

μοντέλο της λεκάνης απορροής που μελετάται, διαχωρίζοντας τον υδρολογικό κύκλο σε 

διαχειρίσιμα κομμάτια και κατασκευάζοντας οριακές συνθήκες σε αυτή. Οποιαδήποτε ροή 

μάζας ή ενέργειας στον κύκλο μπορεί να αναπαρασταθεί με ένα μαθηματικό μοντέλο. Στις 

περισσότερες περιπτώσεις, είναι διαθέσιμες διάφορες επιλογές μοντέλων για την 

αναπαράσταση κάθε ροής. Κάθε μαθηματικό μοντέλο που περιλαμβάνεται στο λογισμικό είναι 

κατάλληλο για διαφορετικά περιβάλλοντα και κάτω από διαφορετικές συνθήκες. Η σωστή 

επιλογή του κάθε μοντέλου απαιτεί γνώση της υπό μελέτη λεκάνης, των διαθέσιμων 

δεδομένων, των στόχων της υδρολογικής μελέτης και κρίση από τη σκοπιά του μηχανικού (US 

Army Corps of Engineers, 2018). 

Tο πρόγραμμα διαθέτει ένα ολοκληρωμένο περιβάλλον εργασίας που περιλαμβάνει μια βάση 

δεδομένων, βοηθητικές δυνατότητες δεδομένων, μηχανή υπολογισμού και εργαλεία αναφοράς 

αποτελεσμάτων. Ένα γραφικό περιβάλλον εργασίας χρήστη επιτρέπει την απρόσκοπτη 

μετακίνηση μεταξύ των διαφόρων τμημάτων του προγράμματος. Η λειτουργικότητα του 

προγράμματος είναι η ίδια σε όλες της πλατφόρμες που υποστηρίζεται (US Army Corps of 

Engineers, 2018). 

4.4.2 Μοντέλα του υδρολογικού κύκλου 

Όπως αναφέρθηκε, για την προσομοίωση των διάφορων διεργασιών του υδρολογικού κύκλου 

το λογισμικό HEC-HMS παρέχει τη δυνατότητα επιλογής διάφορων μοντέλων σύμφωνα με 

τους US Army Corps of Engineers (2018). Αυτά είναι: 

1. Κατακρήμνιση 

• Υποθετικές καταιγίδες γνωστής συχνότητας 

• Απόδοση βαρών στους βροχομετρικούς σταθμούς για κάθε λεκάνη 

• Κατακρήμνιση σε κάνναβο 

• Καταιγίδα τύπου HMR 52 (Hydrometeorological Report No 52) 

• Απόδοση βαρών με την αντίστροφη τετραγωνική απόσταση 

• Υποθετικές καταιγίδες SCS 

• Καθορισμένο υετόγραμμα 

• Τυπική καταιγίδα του έργου 

2. Εξατμισοδιαπνοή 
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• Ετήσια εξατμισοδιαπνοή 

• Μέθοδος Penman Monteith σε κάνναβο 

• Μέθοδος Priestley Taylor σε κάνναβο 

• Μέθοδος Hamon 

• Μέθοδος Hargreaves 

• Μέση μηνιαία 

• Μέθοδος Penman Monteith 

• Μέθοδος Priestley Taylor 

• Καθορισμένη εξατμισοδιαπνοή 

3. Τήξη χιονιού 

• Δείκτης θερμοκρασίας 

• Δείκτης θερμοκρασίας σε κάνναβο 

4. Εκτίμηση απωλειών 

• Μέθοδος ελλείμματος και σταθερής απώλειας (Deficit and Constant Loss) 

• Μέθοδος εκθετικής απώλειας 

• Μέθοδος Green και Ampt 

• Μέθοδος ελλείμματος και σταθερής απώλειας σε κάνναβο 

• Μέθοδος Green και Ampt σε κάνναβο 

• Μέθοδος απωλειών αριθμού καμπύλης κατά SCS (SCS Curve Number) 

• Μέθοδος απωλειών αριθμού καμπύλης κατά SCS σε κάνναβο 

• Μέθοδος αρχικής και σταθερής απώλειας (Initial and Constant Loss) 

• Μέθοδος Smith Parlange 

• Μέθοδος υπολογισμού εδαφικής υγρασίας 

• Μέθοδος υπολογισμού εδαφικής υγρασίας σε κάνναβο 

5. Μετατροπή της βροχής σε απορροή 

• Μοναδιαίο Υδρογράφημα του Clark 

• Μέθοδος κινηματικού κύματος 

• Μέθοδος ModClark 

• Μοναδιαίο Υδρογράφημα της SCS 

• Μοναδιαίο Υδρογράφημα του Snyder 

• Διάγραμμα S καθορισμένο από το χρήστη (User-specified S-graph) 

• Μοναδιαίο Υδρογράφημα καθορισμένο από το χρήστη (User-specified Unit 

Hydrograph) 

6. Εκτίμηση βασικής απορροής 

• Μέθοδος ύφεσης 

• Μέθοδος οριοθετημένης ύφεσης 

• Μηνιαία σταθερή βασική απορροή 

• Μέθοδος γραμμικής δεξαμενής 

• Μέθοδος μη γραμμικής βασικής απορροής κατά Boussinesq 

7. Εκτίμηση της διόδευσης 

• Μέθοδος κινηματικού κύματος 

• Μέθοδος υστέρησης (Lag) 

• Διόδευση αποθήκευσης (Modified Puls) 

• Μέθοδος υστέρησης και συντελεστή K 

• Μέθοδος Muskingum 

• Μέθοδος Muskingum-Cunge 

• Μέθοδος κανονικού βάθους 
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• Μέθοδος Straddle Stagger 

Εκτός από τις παραπάνω διεργασίες και μεθόδους το μοντέλο HEC-HMS περιέχει και άλλες 

μεθόδους για άλλα δομικά υδρολογικά στοιχεία του συστήματος όπως η δεξαμενή, ο κόμβος, η 

εκτροπή κ.α. τα οποία όμως δεν χρησιμοποιήθηκαν κατά την προσομοίωση και έτσι η 

περιγραφή τους στερείται νοήματος στην παρούσα εργασία. 

Οι μέθοδοι που χρησιμοποιήθηκαν στην εφαρμογή του μοντέλου στην παρούσα εργασία 

παρουσιάζονται και αναλύονται σε επόμενο κεφάλαιο. 

4.4.3 Επιλογή πακέτου HEC-HMS 

Η επιλογή της χρήσης και εφαρμογής του συστήματος HEC-HMS για την παρούσα 

μεταπτυχιακή εργασία έγινε λαμβάνοντας υπόψη ορισμένα σημαντικά πλεονεκτήματα που 

παρέχει, μετά βέβαια από μελέτη και σύγκριση και άλλων μοντέλων. Τα πλεονεκτήματα του 

συγκεκριμένου συστήματος είναι: 

• Το πακέτο HEC-HMS και το πρόσθετό του, HEC-GeoHMS, για την γεωγραφική 

προετοιμασία του εκάστοτε έργου, είναι διαθέσιμα δωρεάν από τον επίσημο ιστότοπο 

του Σώματος Μηχανικού του Στρατού των ΗΠΑ, όπου παρέχεται και αναλυτικό υλικό 

τεκμηρίωσης και παραδειγμάτων όλων των λειτουργειών τους. 

• Επίσης, το συγκεκριμένο πακέτο είναι εύκολο στη χρήση καθώς διαθέτει οργανωμένο 

γραφικό περιβάλλον διεπαφής με το χρήστη (Graphical User Interface, GUI), η 

εκμάθησή του είναι σχετικά σύντομη και δεν απαιτεί κάποια συγκεκριμένη 

κωδικοποίηση για την εκτέλεση των λειτουργειών του. 

• Μέσω του πρόσθετου HEC-GeoHMS του πακέτου, υπάρχει σύνδεση με Σύστημα 

Γεωγραφικών Πληροφοριών (GIS) το οποίο επιτρέπει τη σαφή, λεπτομερή και ακριβή 

μεταφορά της γεωγραφικής πληροφορίας του εκάστοτε έργου στο σύστημα 

προσομοίωσης. 

• Περιέχει ένα μεγάλο εύρος μεθόδων και λειτουργειών για την όσο το δυνατόν πιο 

ρεαλιστική προσομοίωση των διεργασιών του υδρολογικού κύκλου. 

• Είναι ευρέως διαδεδομένο καθώς έχει εφαρμοστεί σε πληθώρα μελετών, τόσο 

ερευνητικών όσο και πρακτικών. Συγκεκριμένα στην αναζήτηση βιβλιογραφίας που 

άπτεται του περιεχομένου της παρούσας εργασίας, βρέθηκαν πολλές δημοσιεύσεις που 

έχει χρησιμοποιηθεί, όπως οι: Gumindoga et al. (2016), όπου γίνεται προσομοίωση μη 

μετρούμενης λεκάνης απορροής με χρήση του μοντέλου σε λεκάνη απορροής του 

ποταμού Μανγιάμε στην Ζιμπάμπουε Sintayehu (2015) όπου εφαρμόζεται το σύστημα 

HEC-HMS με συνεχή προσομοίωση στη λεκάνη απορροής του Άνω Μπλε Νείλου, 

Ibrahim-Bathis και Ahmed (2016) όπου γίνεται εφαρμογή του συστήματος σε μία 

αγροτική μη μετρούμενη λεκάνη απορροής, Azmat et al. (2017) όπου εφαρμόζεται και 

για συνεχή προσομοίωση και για προσομοίωση γεγονότος βροχής σε λεκάνη υψηλού 

υψομέτρου με έλλειψη δεδομένων απορροής και κάτω από την επίδραση της 

κλιματικής αλλαγής κ.α. 

Εκτός όμως από πλεονεκτήματα το σύστημα HEC-HMS έχει και μειονεκτήματα με κυριότερο 

ότι δεν έχει αναπτυχθεί ως πλήρως κατανεμημένο (distributed) αλλά μόνο ως ημικατανεμημένο 

(semi-distributed) και αδιαμέριστο (lumped). Αυτό έχει ως αποτέλεσμα τη μη ύπαρξη 

δυνατότητας διακριτοποίησης της υπό μελέτη λεκάνης απορροής σε μονάδες υδρολογικής 

απόκρισης (HRUs) ή άλλες υδρολογικά ομογενείς ενότητες για την πιο λεπτομερή και 

αναλυτική προσομοίωσή της. 
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5 Περιοχές μελέτης και προετοιμασία δεδομένων 

5.1 Επιλογή περιοχών μελέτης 

Η επιλογή των δύο λεκανών απορροής που μελετήθηκαν στην παρούσα εργασία έγινε από τις 

λεκάνες που συγκρίθηκαν και ταξινομήθηκαν σε κλάσεις ομοιότητας στην εργασία των 

Papageorgaki and Nalbantis (2016). Συγκεκριμένα, επιλέχθηκαν η λεκάνη απορροής του 

ποταμού Κρικελιώτη με έξοδο στο σταθμό Γέφυρα Δομνίστας και η λεκάνη απορροής του 

ποταμού Αγραφιώτη με έξοδο στη θέση Γέφυρα Βαρβαριάδας. Σύμφωνα με την παραπάνω 

εργασία, οι δύο λεκάνες είναι υδρολογικά όμοιες και έχουν ταξινομηθεί στην κλάση 3 η οποία 

περιλαμβάνει λεκάνες με μέτρια υψηλό συντελεστή απορροής (Runoff Ratio), μεγάλες κλίσεις 

στην καμπύλη διάρκειας απορροής (Flow Duration Curve), μεσαίες τιμές του δείκτη βασικής 

ροής (Baseflow Index) και υψηλές τιμές στο δείκτη ημερών χιονόπτωσης (Snow Day Ratio).  

5.2 Το Υδατικό Διαμέρισμα Δυτικής Στερεάς Ελλάδας 

Οι δύο ποταμοί, Κρικελιώτης και Αγραφιώτης, των οποίων οι λεκάνες απορροής μελετήθηκαν 

στην παρούσα εργασία, είναι παραπόταμοι του Αχελώου και ανήκουν στο 4ο Υδατικό 

Διαμέρισμα, δηλαδή το Υδατικό Διαμέρισμα Δυτικής Στερεάς Ελλάδας. Το συγκεκριμένο 

Υδατικό Διαμέρισμα έχει έκταση 10496.88 km2 και οι κύριες λεκάνες απορροής που 

περιλαμβάνει είναι: 

• Η λεκάνη απορροής του Αχελώου με συνολική έκταση 7530.690 km2 

• Η λεκάνη απορροής του Εύηνου με συνολική έκταση 1163.629 km2 

• Η λεκάνη απορροής του Μόρνου με συνολική έκταση 1437.732 km2 

• Η λεκάνη απορροής της Λευκάδας με συνολική έκταση 364.826 km2 

5.3 Οι υπό μελέτη λεκάνες απορροής 

5.3.1 Η λεκάνη απορροής του Αγραφιώτη 

Ο ποταμός Αγραφιώτης είναι παραπόταμος του Αχελώου, βρίσκεται στο βόρειο τμήμα του 

Υδατικού Διαμερίσματος Δυτικής Στερεάς Ελλάδας και πηγάζει από την οροσειρά της Πίνδου. 

Διοικητικά ανήκει στο νομό Ευρυτανίας της Περιφέρειας Στερεάς Ελλάδας. Περνάει από τα 

χωριά Βραγγιανά και Τροβάτο, διασχίζει το χωριό Άγραφα και καταλήγει κοντά στο χωριό 

Τριπόταμο, όπου και ενώνεται με τη λίμνη Κρεμαστών στην οποία συμβάλλουν επίσης οι 

ποταμοί Ταυρωπός και Τρικεριώτης. Ο ποταμός πήρε το όνομά του από τα βουνά Άγραφα και 

από το ομώνυμο χωριό. Η λεκάνη απορροής του ποταμού Αγραφιώτη έχει έκταση 219.6 km2 

και ως έξοδός της θεωρείται η Γέφυρα Βαρβαριάδας στην οποία υπάρχει υδρομετρικός 

σταθμός. 

5.3.2 Η λεκάνη απορροής του Κρικελιώτη 

Ο ποταμός Κρικελιώτης ή αλλιώς Κρικελοπόταμος είναι παραπόταμος του Αχελώου, 

βρίσκεται στο ανατολικό τμήμα του Υδατικού Διαμερίσματος Δυτικής Στερεάς Ελλάδας και 

πηγάζει από την οροσειρά της Πίνδου βόρεια από το χωριό Κρίκελλο. Διοικητικά, ανήκει στο 

νομό Ευρυτανίας της Περιφέρειας Στερεάς Ελλάδας. Ο ποταμός αφού περάσει κοντά από τα 
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χωριά Κρίκελλο και Δομνίστα ενώνεται με τον Καρπενησιώτη ποταμό και σχηματίζουν τον 

Τρικεριώτη. Η λεκάνη απορροής του έχει έκταση 88.7 km2 και ως έξοδός της θεωρείται η 

Γέφυρα Δομνίστας στην οποία λειτουργούσε σταθμημετρικός σταθμός τις προηγούμενες 

δεκαετίες αλλά πλέον η λειτουργία του έχει σταματήσει. 

5.4 Προετοιμασία γεωγραφικών δεδομένων 

5.4.1 Γενικά 

Τα γεωγραφικά δεδομένα αποτελούν μια απαραίτητη συνιστώσα σε οποιαδήποτε υδρολογική 

έρευνα ή μελέτη, καθώς αυτά αποτελούν πληροφορία για το χωρικό υπόβαθρο πάνω στο οποίο 

συντελούνται οι διάφορες διεργασίες του υδρολογικού κύκλου και έτσι η χωρική πληροφορία 

σε καλή ανάλυση έχει σημαντικότατο ρόλο για την όσο το δυνατόν πιστότερη αναπαράσταση 

των διεργασιών. 

Στην παρούσα εργασία η προετοιμασία, η επεξεργασία, η ανάκτηση και η παρουσίαση όλων 

των γεωγραφικών και χωρικών δεδομένων έγινε με τη χρήση του Συστήματος Γεωγραφικών 

Πληροφοριών ArcGIS της εταιρείας ESRI και συγκεκριμένα με την έκδοση 10.3.1. Για τη 

χρήση του συγκεκριμένου λογισμικού δόθηκε κατάλληλη άδεια από τη εταιρεία-πάροχο. 

Επίσης έγινε χρήση του πρόσθετου στο ArgGIS λογισμικού που λέγεται HEC-GeoHMS που 

έχει σαν στόχο τη σωστή προετοιμασία των δεδομένων με αυστηρή διαδοχή των διάφορων 

εργαλείων που εκτελούνται για να μπορέσει να γίνει η εισαγωγή τους με ορθό τρόπο στο 

μοντέλο HEC-HMS και να γίνει, στη συνέχεια, η κατάλληλη προσομοίωση της εκάστοτε 

λεκάνης απορροής. Το πρόσθετο HEC-GeoHMS διατίθεται ελεύθερα από τους δημιουργούς 

του οι οποίοι είναι το Σώμα Μηχανικών του Στρατού των Ηνωμένων Πολιτειών (US Army 

Corps of Engineers). 

5.4.2 Ψηφιακά μοντέλα εδάφους 

Τα Ψηφιακά Μοντέλα Εδάφους (ΨΜΕ ή DTM από το Digital Terrain Model) για τις δύο 

λεκάνες του Αγραφιώτη και του Κρικελιώτη χορηγήθηκαν από την «Ελληνικό Κτηματολόγιο» 

για χρήση στην παρούσα εργασία. Η διάσταση κανονικοποιημένου καννάβου στο έδαφος είναι 

5 m, ενώ το γεωδαιτικό σύστημα αναφοράς τους είναι το ΕΓΣΑ ’87. 

Η αρχική μορφή των ψηφιακών μοντέλων εδάφους ήταν σε επιμέρους πινακίδες διαστάσεων 

920x720 φατνίων (pixels) και για να σχηματιστούν οι υπό μελέτη λεκάνες ακολουθήθηκε η 

παρακάτω διαδικασία για κάθε μία. Αρχικά, έγινε εισαγωγή όλων των πινακίδων στο 

περιβάλλον ArcMap του ArcGIS. Έπειτα, έγινε σύνθεσή τους σε ένα ενιαίου μωσαϊκό 

πινακίδων ως εξής: πρώτα δημιουργήθηκε ένα κενό σετ δεδομένων raster με το εργαλείο 

ArcToolbox→Data Management Tools→Raster→Raster Dataset→ Create Raster Dataset 

και, στη συνέχεια, έγινε σύνθεση των επιμέρους πινακίδων σε μία ενιαία με το εργαλείο 

ArcToolbox→Data Management Tools→Raster→Raster Dataset→Mosaic. Έτσι, ήταν πλέον 

διαθέσιμο το ψηφιακό μοντέλο εδάφους της ευρύτερης περιοχής για κάθε λεκάνη απορροής. 

Επόμενο βήμα ήταν η σχηματοποίηση των λεκανών απορροής με τις συγκεκριμένες εξόδους, 

δηλαδή τη Γέφυρα Βαρβαριάδας για τη λεκάνη του Αγραφιώτη και τη Γέφυρα Δομνίστας για 

τη λεκάνη του Κρικελιώτη. Για να γίνει αυτό, αρχικά εντοπίστηκαν οι συντεταγμένες των δύο 

σταθμών από την Εθνική Τράπεζα Υδρολογικής και Μετεωρολογικής Πληροφορίας που 

ονομάζεται Υδροσκόπιο, έγινε εισαγωγή τους στο ArcMap και δημιουργήθηκε με 

ψηφιοποίηση, ένα σημειακό θεματικό επίπεδο που θα αποτελούσε την έξοδο της κάθε λεκάνης 

απορροής. Στη συνέχεια, δημιουργήθηκε ο κάνναβος διεύθυνσης ροής με το εργαλείο 
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ArcToolbox→Spatial Analyst Tools→Hydrology→Flow Direction. Το εργαλείο αυτό 

επιτρέπει να βρεθεί η διεύθυνση στην οποία θα απορρεύσει κάθε φατνίο στο ακριβώς κατάντη 

γειτονικό του. Έπειτα, έγινε εφαρμογή του εργαλείου ArcToolbox→Spatial Analyst 

Tools→Hydrology→Watershed στο οποίο έγινε εισαγωγή του παράγωγου του Flow Direction 

και του σημείου εξόδου κάθε λεκάνης απορροής και προέκυψε, σε μορφή raster, η 

σχηματοποιημένη επιφάνεια της κάθε λεκάνης. Στη συνέχεια, έγινε μετατροπή του 

προηγούμενου raster επιπέδου σε οντότητα πολυγώνου με το εργαλείο 

ArcToolbox→Conversion Tools→From Raster→Raster to Polygon. Στο πολύγωνο που 

προέκυψε έγινε εφαρμογή του εργαλείου ArcToolbox→Cartography 

Tools→Generalization→Simplify Polygon έτσι ώστε να απλοποιηθεί το πολύγωνο καθώς από 

την μετατροπή του raster σε πολύγωνο δημιουργήθηκαν πάρα πολλές γωνίες σε όλη τη γραμμή 

της περιμέτρου του. Τέλος, έγινε περικοπή του ενιαίου ψηφιακού μοντέλου εδάφους κάθε 

λεκάνης χρησιμοποιώντας το αντίστοιχο πολύγωνο της επιφάνειάς της με το εργαλείο 

ArcToolbox→Spatial Analyst Tools→Extraction→Extract by Mask και προέκυψαν τα τελικά 

ψηφιακά μοντέλα εδάφους, ένα για κάθε λεκάνη, τα οποία θα χρησιμοποιηθούν για περαιτέρω 

ανάλυση και παρουσιάζονται στα επόμενα σχήματα (Σχήμα 5.1 και 5.2). 
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Σχήμα 5.1: Ψηφιακό Μοντέλο Εδάφους λεκάνης απορροής Αγραφιώτη 
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Σχήμα 5.2: Ψηφιακό Μοντέλο Εδάφους λεκάνης απορροής Κρικελιώτη 
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5.4.3 Δημιουργία υδρογραφικού δικτύου 

Το υδρογραφικό δίκτυο των ποταμών Αγραφιώτη και Κρικελιώτη είναι δυνατόν να 

προσδιοριστεί και να αναπαρασταθεί εφαρμόζοντας μια σειρά από εργαλεία που παρέχει το 

περιβάλλον του ArcMap. Εξαιτίας της υψηλής χωρικής ανάλυσης των ψηφιακών μοντέλων 

εδάφους (5x5m), η διαδικασία και το αποτέλεσμα της δημιουργίας του υδρογραφικού δικτύου 

των ποταμών κρίνεται αξιόπιστη και πως προσεγγίζει σε ικανοποιητικό βαθμό την 

πραγματικότητα. Στη συνέχεια, ακολουθούν τα εργαλεία που χρησιμοποιήθηκαν και η 

διαδικασία που ακολουθήθηκε για να δημιουργηθούν τα υδρογραφικά δίκτυα των λεκανών 

απορροής των υπό μελέτη ποταμών. 

Αρχικά,, για τον εντοπισμό και τη διόρθωση τυχόν χονδροειδών σφαλμάτων του ψηφιακού 

μοντέλου εδάφους κάθε λεκάνης, τα οποία μπορεί να οφείλονται σε πιθανά βυθίσματα, 

εκτελέστηκε το εργαλείο Fill με διαδρομή: ArcToolbox→Spatial Analyst 

Tools→Hydrology→Fill. Το αποτέλεσμα αυτού του εργαλείου είναι να απορρεύσει επιτυχώς 

όλο το πλήθος των κελιών του μοντέλου στην έξοδο της λεκάνης απορροής. 

Για να εξαχθεί το υδρογραφικό δίκτυο της κάθε λεκάνης απορροής, εκτελέστηκαν δύο 

εργαλεία: ένα για τη δημιουργία του καννάβου διεύθυνσης ροής και ένα για τη δημιουργία του 

καννάβου συγκεντρωτικής ροής. Το πρώτο εργαλείο είναι το Flow Direction με διαδρομή: 

ArcToolbox→Spatial Analyst Tools→Hydrology→Flow Direction. Όπως αναφέρθηκε και 

προηγουμένως, το εργαλείο αυτό ουσιαστικά δείχνει τη διεύθυνση στην οποία θα απορρεύσει 

κάθε φατνίο στο ακριβώς κατάντη γειτονικό του. Το δεύτερο εργαλείο είναι το Flow 

Accumulation με διαδρομή: ArcToolbox→Spatial Analyst Tools→Hydrology→Flow 

Accumulation. Η συγκεντρωτική ροή κάθε φατνίου είναι ουσιαστικά το άθροισμα όλων των 

φατνίων που απορρέουν σε αυτό.  

Στο σημείο αυτό έχει ήδη αρχίσει να διακρίνεται το υδρογραφικό δίκτυο σε μια πρόχειρη 

μορφή. Για την καλύτερη αναπαράστασή του, έγιναν διάφορες δοκιμές και προσδιορίσθηκε 

ένα κατώφλι φατνίων πάνω από το οποίο θεωρήθηκε ότι υφίσταται υδρογραφικό δίκτυο και 

κάτω από αυτό πως δεν υφίσταται. Δηλαδή, αν ο αριθμός των φατνίων που απορρέουν σε ένα 

άλλο είναι μεγαλύτερος από το κατώφλι, τότε αυτό αποτελεί υδρογραφικό δίκτυο. Αν απορρέει 

αριθμός μικρότερος από το κατώφλι δεν αποτελεί μέρος στο υδρογραφικό δίκτυο. Έπειτα, με 

τον κατάλληλο χρωματισμό όλων των φατνίων υδρογραφικού δικτύου για να υπάρχει αντίθεση 

με την υπόλοιπη λεκάνη, έγινε δυνατή η κατά το δυνατόν πιο ρεαλιστική αναπαράσταση του 

(Παπαγεωργάκη, 2012). 

Επιπλέον, έγινε ταξινόμηση των υδατορευμάτων των λεκανών απορροής κατά Strahler με την 

εξής διαδικασία. Αρχικά, με το εργαλείο ArcToolbox→Spatial Analyst 

Tools→Hydrology→Stream Order και με εισόδους τον κάνναβο διεύθυνσης ροής (Flow 

Direction) και τον κάνναβο των υδατορευμάτων που προέκυψε από την προηγούμενη 

διαδικασία, και με επιλογή της μεθόδου Stahler, προέκυψε σε μορφή καννάβου η ταξινόμηση 

του υδρογραφικού δικτύου. Έπειτα, με το εργαλείο ArcToolbox→Spatial Analyst 

Tools→Hydrology→Stream to Feature και με εισόδους τον κάνναβο διεύθυνσης ροής (Flow 

Direction) και τον κάνναβο της προηγούμενης ταξινόμησης, προέκυψε το τελικό υδρογραφικό 

δίκτυο, ταξινομημένο κατά Strahler και σε γραμμικές οντότητες. 

Η απεικόνιση των λεκανών απορροής έτσι όπως προέκυψαν από τα ψηφιακά μοντέλα εδάφους 

με τη δημιουργία του υδρογραφικού δικτύου, σύμφωνα με τη μεθοδολογία που 

παρουσιάστηκε, αλλά και τη δημιουργία των ισοϋψών καμπύλων ανά 100 m με το εργαλείο 
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Contour με διαδρομή: ArcToolbox→Spatial Analyst Tools→Surface→Contour 

παρουσιάζονται στα επόμενα σχήματα (Σχήμα 5.3 & 5.4). 

 
Σχήμα 5.3: Η λεκάνη απορροής και το υδρογραφικό δίκτυο του Αγραφιώτη 
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Σχήμα 5.4: Η λεκάνη απορροής και το υδρογραφικό δίκτυο του Κρικελιώτη 
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5.4.4 Υπολογισμός μορφομετρικών χαρακτηριστικών 

Μέγεθος λεκάνης απορροής 

Σε προηγούμενο κεφάλαιο αναφέρθηκε η σπουδαιότητα που έχει το μέγεθος μιας λεκάνης 

απορροής στις υδρολογικές συνθήκες που λαμβάνουν χώρα σε αυτή και στην υδρολογική της 

απόκριση. Ο προσδιορισμός του μεγέθους των δύο λεκανών απορροής που μελετώνται στην 

παρούσα εργασία έγινε από τα γεωγραφικά δεδομένα και συγκεκριμένα από τις ιδιότητες των 

πολυγώνων των λεκανών απορροής που προέκυψαν όπως παρουσιάστηκε προηγουμένως. 

Έτσι, το μέγεθος της λεκάνης απορροής του Αγραφιώτη είναι 219.6 km2 και το μέγεθος της 

λεκάνης απορροής του Κρικελιώτη είναι 88.7 km2. Το μέγεθος των δύο λεκανών θεωρείται 

μικρό σε σχέση πάντα με αντίστοιχες μελέτες που αναφέρονται σε υπολεκάνες ποταμών και 

όχι σε άλλης κλίμακας μελέτες όπως για παράδειγμα αστικές λεκάνες απορροής ή λεκάνες 

απορροής ολόκληρων ποταμών. Επίσης, με βάση τις λεκάνες απορροής που μελετήθηκαν από 

τους Παπαγεωργάκη και Ναλμπάντη (2016) οι οποίες ήταν 24, οι λεκάνες του Αγραφιώτη και 

του Κρικελιώτη καταλαμβάνουν την 17η και την 21η θέση ως προς το μέγεθός τους. 

Σχήμα λεκάνης απορροής 

Από τις ιδιότητες των πολυγώνων των λεκανών απορροής στο περιβάλλον ArcMap είναι 

εφικτός ο υπολογισμός των δεικτών σχήματος λεκάνης απορροής όπως αυτοί παρουσιάστηκαν 

σε προηγούμενο κεφάλαιο. Στον επόμενο πίνακα (Πίνακας 5.1) παρουσιάζονται οι δείκτες 

σχήματος κάθε λεκάνης. 

Πίνακας 5.1: Δείκτες σχήματος των λεκανών απορροής του Αγραφιώτη και του Κρικελιώτη 

Δείκτες σχήματος 
Λεκάνες Απορροής 

Αγραφιώτης Κρικελιώτης 

Δείκτης κυκλικότητας (Rc) 0.543 0.567 

Δείκτης επιμήκυνσης (RL) 0.552 0.646 

Δείκτης συγκέντρωσης ή Cravelius (KC) 1.358 1.328 

 

Υψόμετρο λεκάνης απορροής 

Όπως παρουσιάστηκε και σε προηγούμενο κεφάλαιο η σημασία του υψομέτρου και των 

διακυμάνσεών του μέσα σε μία λεκάνη απορροής αποτελεί σημαντικό παράγοντα για τις 

φυσικές και υδρολογικής διεργασίες που συντελούνται σε αυτή. 

Από τα διάφορα υψόμετρα μιας λεκάνης απορροής αυτά που είναι πιο σημαντικά και τη 

χαρακτηρίζουν είναι το μέσο, η μέση τιμή, το μέγιστο και το ελάχιστο. Το μέγιστο και το 

ελάχιστο υψόμετρο προσδιορίζονται εύκολα από μετρήσεις και στη συγκεκριμένη περίπτωση 

προσδιορίστηκαν από τα ψηφιακά μοντέλα εδάφους των λεκανών απορροής. Η μέση τιμή του 

υψομέτρου προσδιορίζεται με τη χάραξη της υψομετρικής καμπύλης της λεκάνης απορροής η 

οποία ορίζεται ως η καμπύλη που χαράσσεται σε σύστημα συντεταγμένων με τεταγμένη κάθε 

φορά το υψόμετρο και τετμημένη την επιφάνεια των εκτάσεων που βρίσκονται πάνω από αυτό 

το υψόμετρο. Έτσι, η μέση τιμή του υψομέτρου εκτιμάται από τη διάμεσο, δηλαδή λαμβάνεται 

η τιμή του υψομέτρου της υψομετρικής καμπύλης για την οποία το 50% της έκταση της 

λεκάνης απορροής βρίσκεται πάνω από αυτό το υψόμετρο. Το μέσο υψόμετρο, το οποίο είναι 

και το σημαντικότερο, υπολογίζεται αφού πρώτα διαιρεθεί η λεκάνη σε υποπεριοχές και 

υπολογισθεί το μέσο υψόμετρο κάθε μίας. Στην συγκεκριμένη περίπτωση, οι υποπεριοχές 
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αυτές είναι μεταξύ των διάφορων κλάσεων του υψομέτρου στο ψηφιακό μοντέλο εδάφους. 

Τελικά, το μέσο υψόμετρο της λεκάνης απορροής υπολογίζεται από την επόμενη σχέση. 
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 Zm  είναι το μέσο υψόμετρο της λεκάνης απορροής 

 Zi  είναι το μέσο υψόμετρο κάθε υποπεριοχής 

 Ai   είναι το εμβαδόν κάθε υποπεριοχής 

Για τη δημιουργία της υψομετρικής καμπύλης της λεκάνης απορροής εφαρμόστηκαν κάποια 

εργαλεία στο ArcMap και, στη συνέχεια, έγινε επεξεργασία σε λογιστικό φύλλο. Αρχικά, 

εφαρμόστηκε το εργαλείο ArcToolbox→Spatial Analyst Tools→Reclass→Reclassify και το 

ψηφιακό μοντέλο εδάφους χωρίστηκε σε κλάσεις υψομέτρου ανά 100 m και δόθηκε ο αύξων 

αριθμός κάθε κλάσης ως ακέραια τιμή ώστε να μπορεί να γίνει η μετατροπή σε πολύγωνα. 

Έπειτα, εφαρμόστηκε το εργαλείο ArcToolbox→Conversion Tools→From Raster→ Raster to 

Polygon και έτσι η επιφάνεια που κάλυπτε κάθε κλάση υψομέτρου έγινε πολύγωνο. Όμως, με 

τη διαδικασία αυτή δημιουργήθηκαν πολλά ξεχωριστά πολύγωνα για κάθε κλάση τα οποία 

έπρεπε να συγχωνευθούν για να προκύψει η συνολική επιφάνεια της κάθε κλάσης. Έτσι, 

εφαρμόστηκε η εντολή Merge στον Editor και επιλέχθηκαν διαδοχικά όλα τα πολύγωνα κάθε 

κλάσης και συγχωνεύτηκαν σε μία ενιαία οντότητα. Έτσι, ο πίνακας ιδιοτήτων περιείχε όλα τα 

πολύγωνα των κλάσεων και τα εμβαδά τους. Αυτά μεταφέρθηκαν σε ένα λογιστικό φύλλο στο 

οποίο δημιουργήθηκε οι υψομετρικές καμπύλες της λεκάνης απορροής οι οποίες 

παρουσιάζονται στα Σχήματα 5.5 και 5.6 που ακολουθούν. 

 
Σχήμα 5.5: Υψομετρική καμπύλη λεκάνης απορροής Αγραφιώτη 
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Σχήμα 5.6: Υψομετρική καμπύλη λεκάνης απορροής Κρικελιώτη 

Στον Πίνακα 5.2 που ακολουθεί παρουσιάζονται τα διάφορα υψόμετρα των λεκανών απορροής 

όπως προέκυψαν από τα ψηφιακά μοντέλα εδάφους τους από το περιβάλλον του ArcMap και 

από τις υψομετρικές τους καμπύλες. 

Πίνακας 5.2: Υψόμετρα λεκανών απορροής 

Υψόμετρο (m) 
Λεκάνη Απορροής 

Αγραφιώτη Κρικελιώτη 

Μέσο 1189.3 1294.4 

Ελάχιστο  382.4 776.7 

Μέγιστο 2163.6 1918.8 

Διάμεσο 1243.5 1277.4 

Όπως φαίνεται στον παραπάνω πίνακα και οι δύο λεκάνες έχουν μέσο υψόμετρο μεγαλύτερο 

από 1000 m κι έτσι θεωρούνται ορεινές λεκάνες για τα δεδομένα του ελλαδικού χώρου. 

5.4.5 Υδρολογική ανάλυση και προετοιμασία στο HEC-GeoHMS 

Για τη σωστή εισαγωγή των γεωγραφικών δεδομένων των λεκανών απορροής στο περιβάλλον 

του συστήματος HEC-HMS είναι απαραίτητη η υδρολογική τους ανάλυση και προετοιμασία 

στο πρόσθετο HEC-GeoHMS. Όπως έχει ήδη αναφερθεί το πρόσθετο αυτό αποτελεί το δίαυλο 

επικοινωνίας από το ArcGIS στο HEC-HMS. Μέσω αυτό του πρόσθετου σχηματοποιείται η 

εκάστοτε υπό μελέτη λεκάνη απορροής, αναλύεται υδρολογικά και κατασκευάζεται το έργο 

(Project) της καθώς επίσης και το μοντέλο λεκάνης απορροής (Basin Model) το οποίο αποτελεί 

δομική ενότητα για την προσομοίωση στο HEC-HMS και αναλύεται περισσότερο σε επόμενο 

κεφάλαιο. Η σειρά επεξεργασίας και εργασιών στο πρόσθετο HEC-GeoHMS είναι αυστηρή 

και διαδοχική και παρουσιάζεται στη συνέχεια. 

Αρχικά, το κάθε ψηφιακό μοντέλο εδάφους εισάγεται στο ArcMap, δημιουργείται και 

αποθηκεύεται ένα νέο αρχείο. Έπειτα, από την εργαλειοθήκη του πρόσθετου HEC-GeoHMS 

επιλέγεται το εργαλείο Preprocessing→Fill Sinks και γεμίζονται τυχόν βυθίσματα του 
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μοντέλου. Ακολουθεί το εργαλείο Preprocessing→Flow Direction και δημιουργείται ο 

κάνναβος διεύθυνσης ροής. Στη συνέχεια εφαρμόζεται το εργαλείο Preprocessing→Flow 

Accumulation και δημιουργείται ο κάνναβος συγκεντρωτικής ροής. Έπειτα, εφαρμόζεται το 

εργαλείο Preprocessing→Stream Definition και καθορίζονται τα υδατορεύματα που 

προκύπτουν από τη συγκεντρωτική ροή. Με το εργαλείο Preprocessing→Stream Segmentation 

γίνεται κατάτμηση των προηγούμενων υδατορευμάτων σε ξεχωριστές οντότητες από την αρχή 

τους μέχρι τη συνένωσή τους κατάντη. Με το εργαλείο Preprocessing→Catchment Grid 

Delineation δημιουργούνται υπολεκάνες για κάθε υδατόρευμα που προέκυψε σε μορφή 

καννάβου. Με το εργαλείο Preprocessing→Catchment Polygon Processing οι παραπάνω 

υπολεκάνες μετατρέπονται σε οντότητες πολυγώνων. Με το εργαλείο 

Preprocessing→Drainage Line Processing τα υδατορεύματα μετατρέπονται σε γραμμικές 

οντότητες. Με το εργαλείο Preprocessing→Adjoint Catchment Processing δημιουργείται σε 

οντότητα πολυγώνου η συνολική επιφάνεια που απορρέει κατάντη μέσω του υδρογραφικού 

δικτύου. 

Επόμενο, στάδιο είναι η δημιουργία του έργου (Project) που θα εισαχθεί στο μοντέλου HEC-

HMS. Έτσι, αρχικά επιλέγεται η εντολή Project Setup→Start New Project→Define a New 

Project. Έπειτα, με την επιλογή Add Project Point επιλέγεται το σημείο ανάντη του οποίου θα 

γίνει όλη η προσομοίωση, το οποίο στην πράξη είναι η έξοδος κάθε λεκάνης (Γεφ. 

Βαρβαριάδας για τη λεκάνη του Αγραφιώτη και Γεφ. Δομνίστα για τη λεκάνη του Κρικελιώτη). 

Στη συνέχεια, με την εντολή Project Setup→Generate Project δημιουργείται το έργο για κάθε 

λεκάνη που μελετάται χρησιμοποιώντας όλα τα γεωγραφικά επίπεδα που δημιουργήθηκαν 

προηγουμένως. 

Πλέον το κάθε Project έχει δημιουργηθεί, όμως απαιτείται επιπλέον επεξεργασία για να 

εισαχθεί με τη σωστή μορφή στο μοντέλο HEC-HMS με βάση τις παραδοχές που έχουν τεθεί 

στην παρούσα μελέτη και τη σωστή δημιουργία της δομικής ενότητας του μοντέλου basin 

model που θα αναλυθεί λεπτομερώς σε επόμενο κεφάλαιο. Αρχικά, όλες οι υπολεκάνες που 

δημιουργήθηκαν αυτόματα για κάθε λεκάνη ενώνονται σε μία ενιαία με την εντολή Basin 

Processing→Basin Merge. Στη συνέχεια, για το νέο επίπεδο River που δημιουργείται με τη 

δημιουργία του Project, υπολογίζονται το μήκος και η κλίση κάθε υδατορεύματος με τις 

εντολές Characteristics→River Length και Characteristics→River Slope αντίστοιχα και 

καταγράφονται στον πίνακα ιδιοτήτων του. Έπειτα, με το εργαλείο Characteristics→Longest 

Flowpath δημιουργείται ένα επίπεδο που περιέχει τη μεγαλύτερη διαδρομή ροής, από το πιο 

απομακρυσμένο σημείο της λεκάνης μέχρι την έξοδό της. Έπειτα, με την επιλογή 

Characteristics→Basin Centroid δημιουργείται το κεντροειδές της λεκάνης το οποίο είναι 

ουσιαστικά το κέντρο βάρους του σχήματός της. Με την επιλογή Characteristics→ Centroid 

Elevation υπολογίζεται και καταγράφεται στο επίπεδο του κεντροειδούς, το υψόμετρό του. Με 

την επιλογή Characteristics→ Centroid Longest Flowpath δημιουργείται ένα επίπεδο με τη 

μεγαλύτερη διαδρομή ροής από το κεντροειδές κάθε λεκάνης μέχρι την έξοδό της. 

Ακολουθεί η επιλογή των μεθόδων και διαδικασιών που θα χρησιμοποιηθούν από το μοντέλο 

HEC-HMS για την προσομοίωση των συνιστωσών του υδρολογικού κύκλου με την επιλογή 

Parameters→Select HMS Processes. Βέβαια, η επιλογή αυτή μπορεί να αλλάξει εύκολα και 

στο περιβάλλον του μοντέλου HEC-HMS όπως παρουσιάζεται σε επόμενο κεφάλαιο, όπου 

αναλύονται λεπτομερώς και οι διαδικασίες που επιλέγονται κατά την κατάρτιση του μοντέλου. 

Επίσης, με τις επιλογές Parameters→River Auto Name και Parameters→Basin Auto Name 

ονοματίζονται αυτόματα τα επίπεδα River και Basin που δημιουργήθηκαν κατά τη δημιουργία 

του Project. 
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Ακολουθούν κάποιες βασικές επιλογές για τους σωστούς υπολογισμούς και τη σωστή 

αναπαράσταση των λεκανών απορροής στο περιβάλλον του HEC-HMS. Αρχικά, με την 

επιλογή HMS→Map to HMS Units επιλέγεται ο τύπος μονάδων που θα χρησιμοποιηθούν κατά 

την προσομοίωση και συγκεκριμένα το Διεθνές Σύστημα Μονάδων (SI). Έπειτα, γίνεται ένας 

έλεγχος των δεδομένων με την επιλογή HMS→HMS Check Data και εξάγεται μια αναφορά για 

την περίπτωση που εντοπιστεί κάποιο σφάλμα. Στη συνέχεια, με την επιλογή HMS→HMS 

Schematic δημιουργείται η σχηματοποίηση της λεκάνης που θα εμφανίζεται στο περιβάλλον 

του HEC-HMS και με την επιλογή HMS→HMS Legend επιλέγεται το τυπικό υπόμνημα 

σχημάτων του HEC-HMS. Με την επιλογή HMS→Add Coordinates προστίθενται 

συντεταγμένες στα υδρολογικά στοιχεία του HEC-HMS. Με την επιλογή HMS→Prepare Data 

for Model Export  γίνεται η προετοιμασία των δεδομένων για την εξαγωγή τους στο μοντέλο 

στη μορφή ASCII. Με την επιλογή HMS→Background Shape Files λαμβάνονται οι 

γεωγραφικές πληροφορίες για τα όρια της κάθε λεκάνης και το υδρογραφικό δίκτυο ούτως 

ώστε να μπορούν να προβληθούν στο μοντέλο HEC-HMS. Τέλος, δημιουργείται το αρχείο του 

μοντέλου λεκάνης απορροής (Basin Model) με την επιλογή HMS→Basin Model File, το οποίο 

περιέχει όλα τα παραπάνω δεδομένα για τα υδρολογικά στοιχεία, τη σύνδεσή τους και τις 

σχετιζόμενες γεωγραφικές πληροφορίες, σε ένα αρχείο κειμένου μορφής ASCII το οποίο 

μπορεί να διαβαστεί από το HEC-HMS. Έτσι, η επεξεργασία στο περιβάλλον HEC-GeoHMS 

ολοκληρώνεται και, πλέον, είναι εφικτή η κατάρτιση του μοντέλου για την προσομοίωση των 

λεκανών απορροής του Αγραφιώτη και του Κρικελιώτη, η οποία παρουσιάζεται στο κεφάλαιο 

6. 

5.5 Προετοιμασία υδρομετεωρολογικών δεδομένων 

5.5.1 Βροχομετρικά δεδομένα 

Τα βροχομετρικά δεδομένα αποτελούν έναν ιδιαίτερα καίριο και σημαντικό παράγοντα για την 

υδρολογική μελέτη μιας περιοχής. Έτσι και στην παρούσα εργασία έγινε επιλογή δεδομένων 

από βροχομετρικούς σταθμούς εντός των λεκανών απορροής του Αγραφιώτη και του 

Κρικελιώτη. Συγκεκριμένα, οι σταθμοί αυτοί είχαν χρονοσειρές με ημερήσιο βήμα για το ύψος 

βροχής για ένα μεγάλο πλήθος υδρολογικών ετών. Τα δεδομένα αντλήθηκαν από την Εθνική 

Τράπεζα Υδρολογικής και Μετεωρολογικής Πληροφορίας με την ονομασία Υδροσκόπιο, από 

παλαιότερο ερευνητικό έργο (Ξανθόπουλος και Κουτσογιάννης, 1991) και από την Διεύθυνση 

Υδροηλεκτρικής Παραγωγής (ΔΥΗΠ) της ΔΕΗ. Οι σταθμοί κάθε λεκάνης, τα δεδομένα των 

οποίων χρησιμοποιήθηκαν στην παρούσα εργασία, παρουσιάζονται στους επόμενους πίνακες 

(Πίνακες 5.3 και 5.4 ) 

Πίνακας 5.3: Βροχομετρικοί σταθμοί λεκάνης απορροής Αγραφιώτη 

Όνομα σταθμού 
Συντεταγμένες θέσης ΕΓΣΑ 87 

Υψόμετρο (m) 
Κωδικός ID στο 

Υδροσκόπιο 
Φορέας  

X Y 

Μοναστηράκι 290751.300 4328576.900 712.0 400030143 ΔΕΗ 

Τροβάτο 292914.910 4343211.500 1052.9 400030140 ΔΕΗ 

Επινιανά 293770.690 4335788.000 805.8 400030141 ΔΕΗ 

Πίνακας 5.4: Βροχομετρικοί σταθμοί λεκάνης απορροής Κρικελιώτη 

Όνομα σταθμού 
Συντεταγμένες θέσης ΕΓΣΑ 87 

Υψόμετρο (m) 
Κωδικός ID στο 

Υδροσκόπιο 
Φορέας  

X Y 

Δομνίστα 312639.000 4291951.300 1015.1 400030169 ΔΕΗ 

Κρίκελλο 313470.190 4296100.000 1067.3 400030163 ΔΕΗ 
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Για τους σταθμούς Επινιανά, Τροβάτο και Μοναστηράκι της λεκάνης απορροής του 

Αγραφιώτη υπήρχαν διαθέσιμα ημερήσια δεδομένα από τον Οκτώβριο του 1966 μέχρι το 

Σεπτέμβριο του 1991. Για το σταθμό Κρίκελλο της λεκάνης απορροής του Κρικελιώτη 

υπήρχαν διαθέσιμα ημερήσια δεδομένα από τον Οκτώβριο του 1959 μέχρι το Σεπτέμβριο του 

1991, ενώ για το σταθμό Δομνίστα της ίδιας λεκάνης υπήρχαν διαθέσιμα ημερήσια δεδομένα 

από τον Οκτώβριο του 1980 μέχρι τον Σεπτέμβριο του 1994. Οι προηγούμενες διαπιστώσεις 

είναι ιδιαίτερα σημαντικές γιατί καθορίζουν σε μεγάλο βαθμό το χρονικό εύρος της 

προσομοίωσης που θα πραγματοποιηθεί στα πλαίσια της παρούσας εργασίας σε συνδυασμό 

πάντα με τα υπόλοιπα διαθέσιμα υδρομετεωρολογικά δεδομένα. 

Για την εφαρμογή των βροχομετρικών δεδομένων των παραπάνω σταθμών στο μοντέλο HEC-

HMS πρέπει πρώτα να γίνουν κάποιες διαδικασίες επεξεργασίας τους οι οποίες παρουσιάζονται 

στη συνέχεια. 

Έλεγχος ομογένειας βροχομετρικών δεδομένων 

Ο έλεγχος ομογένειας αναφέρεται στον έλεγχο της ποιότητας των παρατηρήσεων, δηλαδή 

ελέγχεται κατά πόσο το σύνολο των παρατηρήσεων προέκυψε με τις ίδιες συνθήκες μέτρησης, 

καθώς η αλλαγή της θέσης του οργάνου, η αντικατάσταση του οργάνου και η αλλαγή του 

παρατηρητή οδηγούν σε μη ομογενή δεδομένα (Τσακίρης, 2013). Ο έλεγχος ομογένειας γίνεται 

με τη μέθοδο της διπλής αθροιστικής καμπύλης η οποία ουσιαστικά συγκρίνει τα δεδομένα 

ενός σταθμού με ενός άλλου γειτονικού ή μιας ομάδας γειτονικών σταθμών που αποτελούν 

τους σταθμούς βάσης και έχει, πρώτα, ελεγχθεί η ομογένεια των δεδομένων τους. 

Σύμφωνα με τη μέθοδο της αθροιστικής καμπύλης, ελέγχονται τα ετήσια ύψη βροχής ενώ, στη 

συνέχεια, μπορούν να εξαχθούν συμπεράσματα και για τα μηνιαία και ημερήσια ύψη βροχής 

χρησιμοποιώντας τους συντελεστές που προκύπτουν. Αρχικά, για κάθε σταθμό υπολογίζονται 

τα αθροιστικά ετήσια ύψη βροχής σύμφωνα με την επόμενη σχέση. 

  ++ += 1ii1i XXX  (5.2) 

όπου 

 Xi  είναι το ετήσιο ύψος βροχής του σταθμού για το υδρολογικό έτος i 

 i  είναι η τάξη του νεότερου στοιχείου 

 i+1  είναι η τάξη του παλαιότερου κατά ένα έτος στοιχείου 

Έπειτα, επιλέγεται ο σταθμός βάσης που παρουσιάζεται στον άξονα των τετμημένων και ο 

εξεταζόμενος σταθμός που παρουσιάζεται στον άξονα των τεταγμένων. Έτσι, σχηματίζεται μία 

καμπύλη που αποτελείται από σημεία με τετμημένες τα αθροιστικά ύψη βροχής του σταθμού 

βάσης και τεταγμένες τα αθροιστικά ύψη βροχής του εξεταζόμενου σταθμού. Αν η καμπύλη 

προσεγγίζει την ευθεία χωρίς να δημιουργείται θλάση, σημαίνει πως οι παρατηρήσεις έχουν 

γίνει κάτω από τις ίδιες συνθήκες μέτρησης, ενώ αν δημιουργείται θλάση, σημαίνει πως οι 

παρατηρήσεις δεν έχουν γίνει κάτω από τις ίδιες συνθήκες μέτρησης και οι διαφορετικές 

συνθήκες μέτρησης ξεκινούν στο σημείο της θλάσης, στο αντίστοιχο υδρολογικό έτος και, άρα, 

οι παρατηρήσεις αποτελούν δύο επιμέρους σύνολα με διαφορετικές συνθήκες μέτρησης. 

Για τη διόρθωση των ετήσιων υψών βροχής θεωρούνται αξιόπιστες οι πιο πρόσφατες μετρήσεις 

και, άρα, η διόρθωση γίνεται στο παλιότερο υποσύνολο πολλαπλασιάζοντας τα ύψη με ένα 

συντελεστή αναγωγής που προκύπτει ως ο λόγος των κλίσεων των δύο ευθύγραμμων τμημάτων 

της διπλής αθροιστικής καμπύλης σύμφωνα με την επόμενη σχέση. 

 
2

1




 =  (5.3) 
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όπου 

 α  είναι ο συντελεστής αναγωγής 

 λ1  είναι η κλίση του νεότερου τμήματος της διπλής αθροιστικής καμπύλης 

 λ2  είναι η κλίση του παλιότερου τμήματος της διπλής αθροιστικής καμπύλης 

Βέβαια, αναγκαία προϋπόθεση για να εφαρμοστεί η μέθοδος της διπλής αθροιστικής καμπύλης 

είναι ο υψηλός βαθμός γραμμικής συσχέτισης μεταξύ του σταθμού που εξετάζεται και του ή 

των σταθμών βάσης. Η γραμμική συσχέτιση ελέγχεται με των συντελεστή R2 που προκύπτει 

σύμφωνα με την επόμενη σχέση. 
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Όπου x και y είναι τα ετήσια ύψη βροχής του σταθμού βάσης και του εξεταζόμενου σταθμού 

αντίστοιχα. 

Ο συντελεστής συσχέτισης λαμβάνει τιμές στο διάστημα [-1, 1] και όσο πιο κοντά στα άκρα 

βρίσκεται η τιμή του, τόσο πιο ισχυρή θεωρείται η συσχέτιση, ενώ αν προσεγγίζει το 0 

θεωρείται ότι υφίσταται ανυπαρξία συσχέτισης. 

Αν δεν υπάρχουν δεδομένα για το ποιος σταθμός έχει ελεγχθεί για την ομογένεια του και άρα 

μπορεί να αποτελέσει σταθμό βάσης, όπως συμβαίνει με τα δεδομένα της συγκεκριμένης 

εργασίας, τότε υπολογίζεται ο συντελεστής γραμμικής συσχέτισης ανά δύο σταθμούς σύμφωνα 

με την επόμενη σχέση. 
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Όπου x και y είναι τα ετήσια ύψη βροχής του σταθμού βάσης και του εξεταζόμενου σταθμού 

αντίστοιχα. 

Τέλος, αναφέρεται ότι για να είναι στατιστικά σημαντική η συσχέτιση των δύο σταθμών θα 

πρέπει ο συντελεστής συσχέτισης να είναι μεγαλύτερος κατ’ απόλυτη τιμή από μία κρίσιμη 

τιμή που δίνεται από την επόμενη σχέση. 

 
N

rc

2
=  (5.6) 

όπου N είναι ο αριθμός των υδρολογικών ετών. 

Συνήθως βέβαια, οι απαιτήσεις για την τιμή του συντελεστή συσχέτισης, είναι κατά πολύ 

μεγαλύτερες από την παραπάνω κρίσιμη τιμή. 

Συμπλήρωση βροχομετρικών παρατηρήσεων 

Ένα πολύ συχνό φαινόμενο είναι η έλλειψη παρατηρήσεων στον υπό έλεγχο σταθμό. Αυτό 

μπορεί να αντιμετωπιστεί με τη συμπλήρωση αυτών των παρατηρήσεων με τη βοήθεια 

γειτονικών σταθμών οι οποίοι διαθέτουν πλήρη δεδομένα και έχουν ελεγχθεί για την ομογένεια 

των δεδομένων και για το βαθμό συσχέτισης με τα δεδομένα του υπό συμπλήρωση σταθμού. 
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Έτσι, αν είναι διαθέσιμοι τρεις γειτονικοί σταθμοί βάσης τότε μπορεί να χρησιμοποιηθεί η 

παρακάτω εξίσωση για τη συμπλήρωση της τιμής Px του υπό συμπλήρωση σταθμού. 
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όπου  

 P1, P2, P3  είναι οι αντίστοιχες τιμές στους σταθμούς 1, 2, 3 

 Ν1, Ν2, Ν3  είναι η κανονική μέση βροχόπτωση στους τρεις παραπάνω σταθμούς 

 Νx   είναι η κανονική βροχόπτωση του υπό συμπλήρωση σταθμού 

Ως κανονική μέση βροχόπτωση εννοείται η μέση βροχόπτωση από δείγμα 30 ετών. 

Πολύγωνα Thiessen και αναγωγή στο υψόμετρο της λεκάνης απορροής 

Αφού τα βροχομετρικά δεδομένα των σταθμών έχουν ελεγχθεί, ομογενοποιηθεί και 

συμπληρωθεί, μπορεί να υπολογισθεί το μέσο βροχομετρικό ύψος της λεκάνης απορροής. Για 

τον υπολογισμό του υπάρχουν τρεις τρόποι (Τσακίρης, 2013): 

• Ο αριθμητικός μέσος όρος παρατηρήσεων των σημειακών βροχομετρικών υψών των 

σταθμών της λεκάνης απορροής 

• Τα πολύγωνα Thiessen 

• Οι ισοϋέτιες καμπύλες (ή ισόβροχες καμπύλες) 

Ο πιο συνηθισμένος τρόπος υπολογισμού του βροχομετρικού ύψους, και αυτός που 

χρησιμοποιείται στην συγκεκριμένη εργασία, είναι τα πολύγωνα Thiessen γιατί έχουν 

ικανοποιητική ακρίβεια, η εφαρμογή τους είναι σχετικά απλή και δεν χρειάζονται κάποιες 

άλλες προϋποθέσεις όπως οι άλλοι δύο τρόποι. 

Η μέθοδος των πολυγώνων Thiessen χρησιμοποιεί τον παράγοντα βάρους που αντιστοιχεί στα 

εμβαδά των πολυγώνων επηρεασμού κάθε σταθμού όπως προκύπτει με τη χάραξη των 

μεσοκαθέτων επί των ευθύγραμμων τμημάτων (αποστάσεων) των σταθμών μεταξύ τους. Το 

μέσο βροχομετρικό ύψος της λεκάνης P0 προκύπτει ως το άθροισμα των επιμέρους 

παρατηρήσεων Pi των σταθμών πολλαπλασιασμένες επί τις αντίστοιχες εκτάσεις επηρεασμού 

Ai δια της συνολικής έκτασης της λεκάνης A, όπως παρουσιάζεται στην επόμενη σχέση. 
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Γενικά, το σημειακό ύψος βροχής αυξάνει με την αύξηση του υψομέτρου (Τσακίρης, 2013). Η 

διαπίστωση αυτή είναι ιδιαίτερα χρήσιμη για οποιαδήποτε αναγωγή βροχομετρικών 

παρατηρήσεων σε διαφορετικό υψόμετρο από αυτό στο οποίο αρχικά ανήκουν. Οι αναγωγές 

γίνονται με τη βοήθεια της βροχοβαθμίδας η οποία ορίζεται ως η μέση αύξηση του ετήσιου 

σημειακού βροχομετρικού ύψους ανά 100 m αύξησης του υψομέτρου. Η βροχοβαθμίδα 

προκύπτει για κάθε περιοχή από τα μέσα ετήσια βροχομετρικά ύψη των βροχομετρικών 

σταθμών μιας περιοχής σε συνάρτηση με τα υψόμετρα των σταθμών. Για τις υψομετρικές 

αναγωγές των βροχομετρικών παρατηρήσεων υπολογίζεται ένας διορθωτικός συντελεστής λ 

σύμφωνα με την επόμενη σχέση. 
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  (5.9) 

όπου 

 β  είναι η βροχοβαθμίδα 
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 P0  είναι η τιμή του ύψους βροχής στην υψομετρική αναγωγή 

 zm  είναι το μέσο υψόμετρο της λεκάνης απορροής 

z  είναι ο σταθμικός μέσος των υψομέτρων των βροχομετρικών σταθμών που 

επηρεάζουν τη λεκάνη απορροής 

Εφαρμογή στα δεδομένα 

Αρχικά, προσδιορίστηκαν τα πολύγωνα Thiessen των παραπάνω βροχομετρικών σταθμών στο 

περιβάλλον ArcMap με το εργαλείο Create Thiessen Polygons με διαδρομή 

ArcToolbox→Analysis Tools→Proximity→ Create Thiessen Polygons. Έτσι, για κάθε λεκάνη 

απορροής προέκυψαν τα πολύγωνα Thiessen τα οποία παρουσιάζονται στους επόμενους χάρτες 

(Σχήματα 5.7 και 5.8) μαζί με τις θέσεις των βροχομετρικών σταθμών. 
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Σχήμα 5.7: Πολύγωνα Thiessen λεκάνης απορροής Αγραφιώτη 
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Σχήμα 5.8: Πολύγωνα Thiessen λεκάνης απορροής Κρικελιώτη 

Το ποσοστό επιρροής κάθε σταθμού στην αντίστοιχη λεκάνη απορροής παρουσιάζεται στους 

επόμενους πίνακες (Πίνακες 5.3 & 5.4 ). 
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Πίνακας 5.5: Ποσοστά επιρροής στη λεκάνη απορροής του Αγραφιώτη 

Σταθμός επιρροής Ποσοστό επιρροής % 

Τροβάτο 31.03% 

Επινιανά 43.57% 

Μοναστηράκι 25.40% 

Πίνακας 5.6: Ποσοστά επιρροής στη λεκάνη απορροής του Κρικελιώτη 

Σταθμός επιρροής Ποσοστό επιρροής % 

Κρίκελλο 74.52% 

Δομνίστα 25.48% 

Από τους δύο παραπάνω πίνακες φαίνεται ότι ο σταθμός Επινιανά και ο σταθμός Κρίκελλο 

έχουν τη μεγαλύτερη επιρροή σε κάθε λεκάνη. Έτσι, και επειδή δεν υπήρχε πληροφορία για 

την ομογένεια κάποιου συγκεκριμένου σταθμού, επιλέχθηκαν αυτοί ως σταθμοί βάσης και 

εφαρμόστηκε η μέθοδος της διπλής αθροιστικής καμπύλης σε κάθε έναν από τους υπόλοιπους 

σταθμούς κάθε αφού προηγήθηκε απλή επεξεργασία όλων των δεδομένων των σταθμών σε 

λογιστικό φύλλο. Τα αντίστοιχα διαγράμματα για κάθε ζεύγος σταθμών παρουσιάζονται στα 

επόμενα σχήματα. 

 
Σχήμα 5.9: Διπλή αθροιστική καμπύλη με σταθμό βάσης τα Επινιανά και ελεγχόμενο σταθμό το 

Τροβάτο 
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Σχήμα 5.10: Διπλή αθροιστική καμπύλη με σταθμό βάσης τα Επινιανά και ελεγχόμενο σταθμό το 

Μοναστηράκι 

 

 
Σχήμα 5.11: Διπλή αθροιστική καμπύλη με σταθμό βάσης το Κρίκελλο και ελεγχόμενο σταθμό τη 

Δομνίστα 
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Οι συντελεστές R2 για όλα τα ζεύγη είναι πολύ υψηλοί και άρα τα δεδομένα είναι ομογενή και 

δεν απαιτείται καμία διαδικασία διόρθωσης. 

Οι χρονοσειρές δεδομένων που συλλέχθηκαν είχαν ορισμένες ελλείψεις τιμών, οι οποίες ήταν 

πολύ λίγες σε σχέση με το χρονικό εύρος των χρονοσειρών, Έτσι, εφαρμόστηκε η διαδικασία 

που παρουσιάστηκε προηγουμένως (Εδάφιο 5.5.1) για τη συμπλήρωση των βροχομετρικών 

παρατηρήσεων, χρησιμοποιώντας τα δεδομένα και όλων των διαθέσιμων σταθμών. 

5.5.2 Θερμοκρασία αέρα 

Ως θερμοκρασία αέρα αναφέρεται κυρίως η θερμοκρασία του αέρα υπό σκιά (Τσακίρης, 2013). 

Η μέτρησή της γίνεται με θερμόμετρα και θερμογράφους που τοποθετούνται μέσα σε ένα 

μετεωρολογικό κλωβό, στον οποίο ο αέρας μπορεί να κυκλοφορεί ελεύθερα και τα όργανα 

προστατεύονται από την ηλιακή ακτινοβολία. Από τα όργανα αυτά μπορούν να ληφθούν ή να 

υπολογισθούν οι παρακάτω παράμετροι της θερμοκρασίας: 

• Η απόλυτη μέγιστη και ελάχιστη τιμή της θερμοκρασίας (Tmax και Tmin αντίστοιχα) που 

παρατηρούνται κατά τη διάρκεια ορισμένης χρονικής περιόδου. 

• Η μέση ημερήσια τιμή της θερμοκρασίας ( dT ) 

• Η μέση μηνιαία τιμή της θερμοκρασίας ( moT ) 

• Η μέση ετήσια τιμή της θερμοκρασίας (
ET ) 

• Το ημερήσιο θερμομετρικό εύρος (ΗΘΕ), δηλαδή η διαφορά ανάμεσα στη μέγιστη και 

ελάχιστη θερμοκρασία του 24ώρου. 

• Το ετήσιο θερμομετρικό εύρος (ΕΘΕ), δηλαδή η διαφορά της μέσης θερμοκρασίας του 

ψυχρότερου μήνα από τη μέση του θερμότερου μήνα του έτους. 

Η θερμοκρασία του αέρα μεταβάλλεται με την αύξηση του υψομέτρου της ατμόσφαιρας. 

Όμως, για την υδρολογία, ιδιαίτερα σημαντική είναι η μεταβολή της θερμοκρασίας εντός της 

τροπόσφαιρας και, στην περίπτωση αυτή, η αύξηση του υψομέτρου συνεπάγεται μείωση της 

θερμοκρασίας. Οι κυριότεροι λόγοι της μείωσης είναι η αραίωση του αέρα και των υδρατμών 

με το ύψος, η μείωση της ανακλώμενης από το έδαφος ακτινοβολίας εντός της ατμόσφαιρας 

κλπ. 

Η τιμή της μεταβολής της θερμοκρασίας της ατμόσφαιρας σε σχέση με τη μονάδα του ύψους, 

λέγεται θερμοκρασιακή βαθμίδα ή κατακόρυφη θερμοβαθμίδα και προκύπτει από την επόμενη 

σχέση. 

 
z

T




−=  (5.10) 

όπου 

 Τ είναι η θερμοκρασία 

 z είναι το υψόμετρο 

Το αρνητικό πρόσημο τοποθετείται για να δηλώσει ότι η αύξηση του ύψους αντιστοιχεί σε 

ελάττωση της θερμοκρασίας. Ως μονάδα του ύψους λαμβάνονται τα 100 m ή το 1 km. 

Επομένως, η θερμοβαθμίδα εκφράζεται σε oC/100 m ή σε oC/1 km και η μέση τιμή της είναι 

0.6 oC/100 m ή 6.0 oC/1 km. Η τιμή αυτή μεταβάλλεται και κυρίως κοντά στην επιφάνεια του 

εδάφους που μπορεί να γίνει πολύ θερμή την ημέρα και να ψυχθεί τη νύχτα, με αποτέλεσμα 

και η θερμοβαθμίδα να λαμβάνει μεγαλύτερη τιμή την ημέρα και μικρότερη τη νύχτα. 
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Στην παρούσα εργασία, στην οποία χρησιμοποιείται το μοντέλο HEC-HMS, απαιτείται η 

ύπαρξη χρονοσειρών μέγιστης και ελάχιστης θερμοκρασίας αέρα για την προσομοίωση 

υδρολογικών μεγεθών όπως η εξατμισοδιαπνοή. 

Στην αναζήτηση δεδομένων προέκυψε πως για τη λεκάνη του Κρικελιώτη υπήρχαν διαθέσιμα 

δεδομένα ημερήσιας μέγιστης και ελάχιστης θερμοκρασίας αέρα για το σταθμό Κρίκελλο και 

τα οποία χορηγήθηκαν από την Διεύθυνση Υδροηλεκτρικής Παραγωγής (ΔΥΗΠ) της ΔΕΗ. Ο 

σταθμός αυτός έχει μικρή υψομετρική διαφορά από το μέσο υψόμετρο της λεκάνης απορροής, 

μερικές δεκάδες μέτρα, και έτσι δεν έγινε αναγωγή στο μέσο υψόμετρο γιατί και τα διαθέσιμα 

δεδομένα ήταν για λίγα υδρολογικά έτη. Επομένως, τα δεδομένα από το σταθμό Κρίκελλο 

χρησιμοποιήθηκαν αυτούσια αφού όμως πρώτα έγινε συμπλήρωση μερικών ελλείψεων 

ημερήσιων τιμών στις χρονοσειρές με τον υπολογισμό της μέσης τιμής των ημερήσιων τιμών 

από όλα τα υπόλοιπα διαθέσιμα υδρολογικά έτη.  

Αντίθετα, για τη λεκάνη του Αγραφιώτη δεν υπήρχαν διαθέσιμα δεδομένα μέγιστης κι 

ελάχιστης θερμοκρασίας αέρα σε κάποιον από τους σταθμούς που είναι εγκατεστημένοι εντός 

της λεκάνης. Έτσι, χρησιμοποιήθηκαν δεδομένα από το σταθμό Φουσιανά που βρίσκεται σε 

γειτονική, όμορη λεκάνη απορροής, δυτικά από τη λεκάνη του Αγραφιώτη, τα οποία 

χορηγήθηκαν από την Διεύθυνση Υδροηλεκτρικής Παραγωγής (ΔΥΗΠ) της ΔΕΗ. Και σε 

αυτές τις χρονοσειρές υπήρχαν μερικές ελλείψεις τιμών οι οποίες συμπληρώθηκαν με όμοιο 

τρόπο όπως και στην περίπτωση της λεκάνης του Κρικελιώτη. Για την αναγωγή στο μέσο 

υψόμετρο της λεκάνης απορροής του Αγραφιώτη, δεν ήταν δυνατός ο υπολογισμός της 

θερμοβαθμίδας λόγω έλλειψης δεδομένων και, έτσι, χρησιμοποιήθηκε μια τιμή από 

παλαιότερη μελέτη της ίδιας λεκάνης με τον ίδιο σταθμό από τη βιβλιογραφία (Αθανασιά, 

2010) η οποία ήταν -0.18 oC/100 m. Μετά και από αυτήν την αναγωγή, τα δεδομένα ήταν 

έτοιμα να εισαχθούν στο μοντέλο HEC-HMS. 

5.5.3 Απορροή 

Όπως έχει ήδη αναφερθεί, τα δεδομένα απορροής αποτελούν ένα σημαντικότατο και καίριο 

παράγοντα για την ορθή μελέτη και προσομοίωση λεκανών απορροής γιατί είναι τα δεδομένα 

σύμφωνα με τα οποία θα βαθμονομηθεί το μοντέλο. Επίσης, λόγω της απαιτητικής και 

οικονομικά ακριβής διαδικασίας μέτρησης της απορροής, δεν είναι εύκολη η εύρεση συνεχών 

χρονοσειρών που να καλύπτουν μάλιστα αρκετά υδρολογικά έτη. Στη συγκεκριμένη εργασία 

υπήρξε διαφορετική προσέγγιση ως προς την απορροή για κάθε μια από τις λεκάνες που 

μελετώνται και παρουσιάζονται στη συνέχεια. 

Για τη λεκάνη του Αγραφιώτη υπήρξαν διαθέσιμα δεδομένα ημερήσιας παροχής στην έξοδό 

της, στη Γέφυρα Βαρβαριάδας, τα οποία χορηγήθηκαν από την Διεύθυνση Υδροηλεκτρικής 

Παραγωγής (ΔΥΗΠ) της ΔΕΗ. Το χρονικό εύρος της διαθέσιμης χρονοσειράς αυτών των 

παροχών ήταν από 01/10/1979 μέχρι 30/09/1989, δηλαδή δέκα υδρολογικά έτη. Επίσης, η 

χρονοσειρά αυτή δεν είχε κάποια έλλειψη τιμής κι έτσι κατέστη δυνατή η άμεση επεξεργασία 

της και εισαγωγή της στο μοντέλο HEC-HMS. 

Αντίθετα, για τη λεκάνη απορροής του Κρικελιώτη δεν υπήρχαν διαθέσιμα δεδομένα παροχής 

στην έξοδό του, Γέφυρα Δομνίστας, αλλά υπήρχαν δεδομένα ημερήσιας στάθμης και δεδομένα 

μεμονωμένων υδρομετρήσεων που κάλυπταν μια περίοδο 11 ετών (1976-1987). Όμως, οι 

μετρήσεις αυτές αναφέρονταν σε διάφορες φάσεις λειτουργίας του υδρομετρικού σταθμού στις 

οποίες έλαβαν χώρα κάποια γεγονότα όπως τοποθέτηση νέων σταθμημέτρων, αλλαγή θέσης 

ενός και μπάζωμα ανά διαστήματα είτε ενός ή ακόμα και όλων, με αποτέλεσμα η ποιότητα των 

υδρομετρήσεων να είναι αμφιλεγόμενη. Επίσης, για κάποια διαστήματα λειτουργούσαν 
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ταυτόχρονα σταθμήμετρα καταγράφοντας διαφορετική στάθμη το καθένα που σημαίνει ότι δεν 

είχαν κοινή αφετηρία και πως για αυτή την μικρή απόσταση που απείχαν στο ρου του ποταμού, 

η διατομή του ποταμού για κάθε ένα παρουσίαζε μεγάλες διακυμάνσεις. Συνολικά, για τη 

χρονική περίοδο από το 1976 μέχρι το 1987 λειτούργησαν με διακοπές τέσσερα σταθμήμετρα 

και οι υδρομετρήσεις που έλαβαν χώρα σε αυτό το διάστημα είναι άγνωστο τι μεθοδολογία 

ακολούθησαν και ποιο ή ποια σταθμήμετρα σε λειτουργία συμπεριέλαβαν στους 

υπολογισμούς. 

Για τους παραπάνω λόγους δεν κατέστη εφικτή η κατάρτιση καμπυλών στάθμης – παροχής, 

παρόλο που έγινε προσπάθεια κατακερματισμού των υδρομετρήσεων σε ομοιογενή χρονικά 

εύρη που θα παρέκαμπταν τους παραπάνω περιορισμούς. Στο επόμενο διάγραμμα (Σχήμα 5.12) 

παρουσιάζονται οι υδρομετρήσεις με τις αντίστοιχες στάθμες τους για το κάθε σταθμήμετρο 

λειτουργίας. Στις περιπτώσεις που λειτουργούσαν ταυτόχρονα δύο ή περισσότερα 

σταθμήμετρα, επιλέχθηκε να παρουσιαστούν οι τιμές της στάθμης που ανήκαν σε σταθμήμετρο 

με συνεχή (τοπικά) λειτουργία, δηλαδή να υπάρχουν υδρομετρήσεις πριν και μετά που να 

γίνεται χρήση του συγκεκριμένου σταθμήμετρου. 

 
Σχήμα 5.12: Υδρομετρήσεις Κρικελιώτη στη θέση Γεφ. Δομνίστας 

Από το παραπάνω διάγραμμα γίνονται αντιληπτά τα ζητήματα που παρουσιάζουν οι 

υδρομετρήσεις. Αρχικά, υπάρχουν εξωκείμενες τιμές οι οποίες βρίσκονται μακριά από τη 

φυσιολογική διασπορά των τιμών και μάλιστα το πλήθος τους δεν μπορεί να θεωρηθεί 

αμελητέο. Έπειτα, ο συντελεστής προσδιορισμού R2 προσεγγίζει το 0 και υποδεικνύει πως δεν 

υπάρχει συσχέτιση μεταξύ στάθμης και παροχής. Έτσι, δεν μπορεί να εξαχθεί από τα δεδομένα 

μία σχέση που θα συνδέει τη στάθμη με την παροχή. Η παραπάνω διαπίστωση μπορεί να 

εξαχθεί και οπτικά από το διάγραμμα καθώς θα έπρεπε να υπάρχει ένα είδος αναλογίας μεταξύ 

στάθμης και παροχής. Όσο δηλαδή αυξανόταν η στάθμη, θα έπρεπε και οι τιμές της παροχής 

να ήταν υψηλότερες και επομένως η γραμμή τάσης που παρεμβάλλεται στα δεδομένα θα 

έπρεπε να είναι ένας ανοδικός κλάδος. Αντίθετα, παρατηρείται μια κατάσταση στην οποία κάθε 
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μέτρηση είναι πολύ διαφορετική από την επόμενη με συνεχή παράβαση της αναλογίας και η 

γραμμή τάσης που προσαρμόζεται στα δεδομένα είναι σχεδόν παράλληλη στον οριζόντιο 

άξονα. 

Οι λόγοι αυτής της ασυνέπειας είναι, όπως αναφέρθηκε και προηγουμένως, οι μεταβολές που 

έλαβαν χώρα στη λειτουργία του υδρομετρικού σταθμού κατά την πάροδο των ετών και 

αφορούσαν την τοποθέτηση νέων σταθμημέτρων, την αλλαγή θέσης ενός σταθμημέτρου και 

το μπάζωμα των σταθμημέτρων ανά διαστήματα λειτουργίας. Επίσης, είναι πολύ πιθανή η 

εσφαλμένη τοποθέτηση της αφετηρίας των σταθμημέτρων καθώς παρατηρείται πως για 

διαστήματα που λειτουργούσαν ταυτόχρονα δύο ή περισσότερα σταθμήμετρα και για περίπου 

ίδια παροχή, οι στάθμες διαφέρουν αρκετά και άρα οι ενδείξεις μεταξύ τους δεν ήταν ίδιες. 

Παρόλη την παραπάνω ανάλυση για τα ζητήματα των υδρομετρήσεων, οι τιμές της παροχής 

χρησιμοποιούνται στην παρούσα εργασία, μετά από μια διαλογή, «πετώντας» τα εξωκείμενα 

δεδομένα, όπως εξηγείται και στο υποκεφάλαιο 6.4 καθώς θεωρείται πως τα προβλήματα έχουν 

να κάνουν με τις στάθμες και όχι με τις παροχές. 
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6 Εφαρμογή του μοντέλου 

6.1 Κατάρτιση του μοντέλου 

6.1.1 Γενικά 

Η κατάρτιση του μοντέλου HEC-HMS για κάθε μία λεκάνη απορροής προϋποθέτει τη λήψη 

αποφάσεων σχετικά με τον τύπο του μοντέλου ως προς το χώρο και το χρόνο. Επίσης, μιας και 

ο στόχος της παρούσας εργασίας είναι η μελέτη όμοιων λεκανών για την εξαγωγή 

συμπερασμάτων όταν αυτές θεωρούνται μη μετρούμενες λεκάνες απορροής, οι αποφάσεις και 

οι προσεγγίσεις ως προς την κατάρτιση και την προσομοίωση επιβάλλεται να είναι κοινές και 

για τις δύο υπό μελέτη λεκάνες. Οι αποφάσεις αυτές υλοποιούνται στο περιβάλλον του HEC-

HMS με την επιλογή κατάλληλων μεθόδων υπολογισμού των διαφόρων συνιστωσών του 

υδρολογικού κύκλου και με την κατάλληλη σύνθεση της λεκάνης ως προς τα συστατικά της 

στοιχεία. 

Έτσι λοιπόν, όπως έχει ήδη γίνει κατανοητό από τη χρονική κλίμακα των υδρομετεωρολογικών 

δεδομένων, η προσομοίωση που θα υλοποιηθεί θα έχει ως εισόδους χρονοσειρές ημερήσιων 

δεδομένων και, άρα, θα είναι μία συνεχής προσομοίωση (continuous simulation) και όχι μια 

προσομοίωση γεγονότος βροχής (event-based simulation). Επομένως, οι μέθοδοι που παρέχει 

το HEC-HMS και αφορούν προσομοίωση γεγονότος βροχής δεν πρέπει σε καμία περίπτωση 

να ληφθούν υπόψη. 

Επίσης, και οι δύο λεκάνες θεωρούνται μικρές για τη φύση τέτοιων μελετών και δεν 

παρουσιάζουν έντονες διαφορές ως προς την κάλυψη γης τους παρά μόνο ως προς τα υψόμετρα 

και τις κλίσεις του εδάφους. Είναι ορεινές λεκάνες με μεγάλο εύρος υψομέτρων όπως φάνηκε 

και στο κεφάλαιο 5. Παράλληλα, δεν υπάρχουν δεδομένα απορροών σε σταθμούς ανάντη από 

τις εξόδους των δύο λεκανών ούτως ώστε να μπορούσαν να σχηματιστούν υπολεκάνες τους. 

Έτσι, κρίθηκε πως μια χωρική διακριτοποίηση της λεκάνης απορροής, είτε σε υπολεκάνες, είτε 

σε μικρότερες ομογενείς περιοχές, όπως για παράδειγμα οι μονάδες υδρολογικής απόκρισης 

(Hydrological Response Units, HRUs), περισσότερο θα περιέπλεκε την προσομοίωση και την 

κατάρτιση του μοντέλου, παρά θα οδηγούσε σε πιο αξιόπιστα αποτελέσματα. Επομένως, το 

μοντέλο που καταρτίστηκε για κάθε λεκάνη απορροής είναι αδιαμέριστο (lumped) ως προς την 

χωρική του διακριτοποίηση και όχι ημι-κατανεμημένο (semi-distributed) ή πλήρως 

κατανεμημένο (distributed). 

Στο μοντέλο HEC-HMS για να είναι εφικτή η προσομοίωση μιας λεκάνης απορροής είναι 

απαραίτητο να έχουν δημιουργηθεί οι παρακάτω τέσσερις ομάδες επιλογών για τις διάφορες 

διεργασίες, υπολογιστικές ή ρυθμιστικές, που λαμβάνουν χώρα κατά την προσομοίωση. 

• Το μοντέλο λεκάνης απορροής (basin model) στο οποίο καθορίζονται οι διάφορες 

μέθοδοι των υδρολογικών διεργασιών και περιέχει όλη τη σχηματοποίηση της λεκάνης 

απορροής και των συστατικών της, όπως το δίκτυο των υδατορευμάτων της, η έξοδός 

ή τυχόν υπολεκάνες.  

• Το μετεωρολογικό μοντέλο (meteorological model) το οποίο περιλαμβάνει όλες τις 

επιλογές που σχετίζονται με τα μετεωρολογικά δεδομένα όπως τα βάρη των σταθμών 

ή η μέθοδος υπολογισμού της εξατμισοδιαπνοής 

• Οι λεπτομέρειες ελέγχου (control specifications) στις οποίες καθορίζονται οι 

ημερομηνίες έναρξης και λήξης της προσομοίωσης, καθώς και το χρονικό βήμα της 
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• Τα δεδομένα χρονοσειρών (time-series data) τα οποία περιλαμβάνουν όλα τα 

υδρομετεωρολογικά δεδομένα που αποτελούν εισόδους για το μοντέλο. 

Στη συνέχεια, παρουσιάζονται οι επιλογές και οι προσεγγίσεις που έγιναν για κάθε ομάδα. Στα 

επόμενα σχήματα παρουσιάζεται το γενικό περιβάλλον του HEC-HMS για κάθε λεκάνη 

απορροής (Σχήματα 6.1 & 6.2) 

 

 
Σχήμα 6.1: Το περιβάλλον του HEC-HMS για τη λεκάνη απορροής του Αγραφιώτη 
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Σχήμα 6.2: Το περιβάλλον του HEC-HMS για τη λεκάνη απορροής του Κρικελιώτη 

 

6.1.2 Μοντέλο λεκάνης απορροής (Basin model) 

Το μοντέλο λεκάνης απορροής χρησιμοποιείται για να περιγράψει τις φυσικές ιδιότητες της 

λεκάνης και την τοπολογία του υδρογραφικού δικτύου. Περιλαμβάνει τις συνιστώσες 

μοντελοποίησης που περιγράφουν την συγκράτηση νερού από τη φυτοκόμη, την επιφανειακή 

αποθήκευση, τη διήθηση, την επιφανειακή απορροή, τη βασική απορροή, τη διόδευση και τις 

λίμνες. Γενικά, αποτελεί το επίκεντρο στην εκτέλεση προσομοιώσεων για μια λεκάνη και στην 

προβολή των αποτελεσμάτων που προκύπτουν (US Army Corps of Engineers, 2018). 

Το μοντέλο λεκάνης απορροής είναι μία από τις κύριες συνιστώσες σε ένα έργο στο περιβάλλον 

του HEC-HMS. Ο πρωταρχικός σκοπός του είναι να μετατρέπει το ατμοσφαιρικό νερό σε 
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απορροή σε συγκεκριμένη θέση ή θέσεις σε μια λεκάνη απορροής. Για να χωρισθεί η λεκάνη 

απορροής σε διαχειρίσιμα κομμάτια, χρησιμοποιούνται υδρολογικά στοιχεία του συστήματος 

όπως η υπολεκάνη, η δεξαμενή, ο κόμβος, η εκτροπή κ.α. Συνδέονται μεταξύ τους με ένα 

δενδριτικό δίκτυο για να σχηματίσουν μια αναπαράσταση του υδρογραφικού δικτύου. Στο 

μοντέλο λεκάνης απορροής μπορούν να χρησιμοποιηθούν χάρτες υποβάθρου της υπό μελέτης 

λεκάνης που βοηθούν στην τοποθέτηση των διαφόρων στοιχείων σε χωρική συνοχή (US Army 

Corps of Engineers, 2018). 

Για τις υπό μελέτη λεκάνες απορροής του Αγραφιώτη και του Κρικελιώτη, αφού 

δημιουργήθηκε το μοντέλο λεκάνης απορροής (basin model) στο περιβάλλον HEC-GeoHMS, 

κατέστη δυνατή η επιλογή των μεθόδων που θα χρησιμοποιηθούν για την προσομοίωση των 

υδρολογικών διεργασιών με τις αντίστοιχες παραμέτρους τους. Αυτές παρουσιάζονται στη 

συνέχεια. 

Η συγκράτηση από τη φυτοκόμη είναι η διεργασία κατά την οποία τα φυτά συγκρατούν μια 

ποσότητα από τα κατακρημνίσματα μειώνοντας έτσι το ποσό που φθάνει στο έδαφος. Για την 

προσομοίωση αυτής της διεργασίας το HEC-HMS παρέχει τρεις μεθόδους αλλά αυτή που είναι 

η πιο κατάλληλη για συνεχή προσομοίωση είναι η απλή φυτοκόμη (simple canopy) και για 

αυτό επιλέχθηκε αυτή. Σύμφωνα με αυτή τη μέθοδο όλη η ποσότητα από τα κατακρημνίσματα 

συγκρατείται μέχρι να εξαντληθεί η χωρητικότητα αποθέματος φυτοκόμης. Όταν συμβεί αυτό, 

όλη η επιπλέον ποσότητα από τα κατακρημνίσματα πέφτει στην επιφάνεια ή κατευθείαν στο 

έδαφος, αν δεν έχει συμπεριληφθεί κάποια συνιστώσα με μια μέθοδο αναπαράστασης του 

νερού στην επιφάνεια. Όλη η δυνητική εξατμισοδιπανοή χρησιμοποιείται για να αδειάσει το 

απόθεμα της φυτοκόμης. Η αρχική συνθήκη της φυτοκόμης καθορίζεται ως το ποσοστό 

αποθέματος φυτοκόμης που είναι γεμάτο με νερό στην αρχή της προσομοίωσης. Το απόθεμα 

της φυτοκόμης αναπαριστά τη μέγιστη ποσότητα νερού που μπορεί να συγκρατηθεί στα φύλλα 

πριν πέσει στο έδαφος. Η ποσότητα αυτή ορίζεται ως ένα ενεργό ύψος νερού (US Army Corps 

of Engineers, 2018). 

Για τις υπό μελέτη λεκάνες απορροής επιλέχθηκε το αρχικό απόθεμα φυτοκόμης να είναι 0% 

ενώ για το μέγιστο απόθεμα και για το συντελεστή καλλιέργειας επιλέχθηκαν ρεαλιστικές τιμές 

μιας και οι δύο αυτές παράμετροι συμμετείχαν είτε εξ ολοκλήρου, ή, μερικώς, στη 

βαθμονόμηση των δύο μοντέλων των λεκανών. Το περιβάλλον της μεθόδου της απλής 

φυτοκόμης παρουσιάζεται στο Σχήμα 6.3 που ακολουθεί. 
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Σχήμα 6.3: Η μέθοδος της απλής φυτοκόμης (Simple Canopy) 

Η επιφάνεια είναι άλλη μια συνιστώσα που περιλαμβάνεται στην προσομοίωση και σκοπεύει 

να αναπαραστήσει την επιφάνεια του εδάφους στην οποία το νερό μπορεί να συσσωρευθεί σε 

επιφανειακό απόθεμα κατάπτωσης. Τα κατακρημνίσματα που διαπερνούν την φυτοκόμη ή τα 

απευθείας κατακρημνίσματα, όταν δεν υπάρχει φυτοκόμη, ενεργούν στην επιφάνεια. Τα 

καθαρά κατακρημνίσματα συσσωρεύονται στο απόθεμα κατάπτωσης και διηθούνται όσο το 

έδαφος έχει διαθέσιμη χωρητικότητα να δέχεται νερό. Η επιφανειακή απορροή ξεκινά όταν ο 

ρυθμός των κατακρημνισμάτων υπερβεί το ρυθμό διήθησης και το απόθεμα επιφάνειας γεμίσει. 

Όσο νερό απομένει στο απόθεμα επιφάνειας μπορεί να διηθηθεί μόλις σταματήσουν τα 

κατακρημνίσματα και υπόκειται σε δυνητική εξατμισοδιαπνοή (US Army Corps of Engineers, 

2018). 

Για την προσομοίωση της παραπάνω διεργασίας το HEC-HMS παρέχει δύο μεθόδους αλλά 

αυτή που είναι η πιο κατάλληλη για συνεχή προσομοίωση είναι η απλή επιφάνεια (simple 

surface) και, για αυτό, επιλέχθηκε αυτή η συγκεκριμένη. Σύμφωνα με αυτή τη μέθοδο όλα τα 

κατακρημνίσματα που φθάνουν στην επιφάνεια του εδάφους δεσμεύονται σε απόθεμα μέχρι 

να καλυφθεί η χωρητικότητά του. Το νερό στο απόθεμα επιφάνειας διηθείται στο έδαφος με το 

που βρεθεί σε αυτό. Αυτό σημαίνει ότι διηθείται ακόμα κι όταν δεν έχει καλυφθεί η 

χωρητικότητα αποθέματος. Η επιφανειακή απορροή δημιουργείται όταν γεμίσει το απόθεμα 

επιφάνειας και ο ρυθμός των κατακρημνισμάτων υπερβεί το ρυθμό διήθησης. Η αρχική 

συνθήκη της επιφάνειας καθορίζεται ως το ποσοστό της χωρητικότητας επιφάνειας το οποίο 

είναι γεμάτο με νερό στην αρχή της προσομοίωσης. Η χωρητικότητα επιφάνειας αναπαριστά 

το μέγιστο ποσό νερού που μπορεί να συγκρατηθεί από την επιφάνεια του εδάφους πριν 

ξεκινήσει η επιφανειακή απορροή και ορίζεται ως ένα ενεργό ύψος νερού (US Army Corps of 

Engineers, 2018). 

Για τις υπό μελέτη λεκάνες απορροής επιλέχθηκε το αρχικό απόθεμα επιφάνειας να είναι 0% 

ενώ για το μέγιστο απόθεμα επιλέχθηκαν ρεαλιστικές τιμές μιας και η παράμετρος αυτή 

συμμετέχει στη βαθμονόμηση των δύο μοντέλων των λεκανών. Το περιβάλλον της μεθόδου 

της απλής επιφάνειας παρουσιάζεται στο Σχήμα 6.4 που ακολουθεί. 
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Σχήμα 6.4: Η μέθοδος της απλής επιφάνειας (Simple Surface) 

Μέχρι στιγμής με τις δύο προηγούμενες μεθόδους έχουν προσομοιωθεί οι απώλειες της βροχής 

από τη φυτοκόμη (canopy) και από την επιφάνεια του εδάφους (surface). Όμως δεν είναι οι 

τελευταίες απώλειες στην πορεία των κατακρημνισμάτων. Όταν η ποσότητα καθαρής βροχής 

περάσει τη συγκράτηση από τη φυτοκόμη και τη συγκράτηση από το έδαφος, ξεκινάει η 

διαδικασία διήθησης του νερού στους πόρους το εδάφους. Ο ρυθμός με τον οποίο 

πραγματοποιείται η διήθηση εξαρτάται από τη διηθητικότητα του εδάφους και από την ένταση 

της βροχής (Τσακίρης, 2013). Η διήθηση μπορεί να χωρισθεί σε τρία στάδια: 

• Κατακόρυφη είσοδος του νερού στο έδαφος 

• Ροή και αποθήκευση μέσα στο έδαφος 

• Ροή στο έδαφος χωρίς επιπλέον αποθήκευση  

Σύμφωνα με τον Τσακίρη (2013) κατά την είσοδο του νερού στο έδαφος η δίηθηση εξαρτάται 

κυρίως από την κατάσταση της επιφάνειας του εδάφους και την ύπαρξη ή όχι βλάστησης. Αν 

κατά το χρόνο της βροχόπτωσης το έδαφος είναι ξηρό, το νερό της βροχής κινείται με ευκολία 

στο εσωτερικό του εδάφους από τους πόρους και τα ανοίγματα που υπάρχουν στην επιφάνεια 

του ξηρού εδάφους. Με την πάροδο του χρόνου και ενώ η βροχόπτωση συνεχίζεται, κλείνουν 

σταδιακά τα ανοίγματα και οι πόροι, είτε με τη διόγκωση του εδάφους που προκαλείται από 

την αύξηση της υγρασίας, είτε με τη μεταφορά κόκκων στα ανοίγματα και τους πόρους που 

προέρχονται από την κρούση των σταγόνων στην επιφάνεια του εδάφους. 

Η κίνηση του νερού μέσα στο έδαφος εξαρτάται κυρίως από την τύπο του εδάφους και την 

περιεχόμενη υγρασία. Με τη συνέχιση της βροχόπτωσης η εδαφική υγρασία μιας εδαφικής 

ζώνης μεγαλώνει μέχρι ενός ανώτατου ορίου που λέγεται υδατοϊκανότητα. Η επιπλέον 

ποσότητα νερού στραγγίζει προς την αμέσως επόμενη εδαφική ζώνη με τελικό αποδέκτη την 

κορεσμένη ζώνη. 

Επομένως, είναι προφανές ότι η μέγιστη ταχύτητα διήθησης παρουσιάζεται συνήθως στην αρχή 

της βροχής και κυρίως σε εποχές ξηρασίας που η υγρασία του εδάφους βρίσκεται σε πολύ 

χαμηλά επίπεδα. 
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Για τον υπολογισμό των παραπάνω απωλειών, το HEC-HMS παρέχει, συνολικά, δώδεκα 

μεθόδους. Όμως, από αυτές που είναι κατάλληλες για συνεχή προσομοίωση, η πιο αναλυτική 

και η πλέον δοκιμασμένη είναι η μέθοδος απωλειών του υπολογισμού της εδαφικής υγρασίας 

(Soil Moisture Accounting). 

Κατά την εφαρμογή της μεθόδου, το έδαφος χωρίζεται σε επιμέρους στρώσεις. Η κάτω στρώση 

είναι το τμήμα του εδάφους, το οποίο χάνει νερό σε εξατμισοδιαπνοή και διήθηση, ενώ η πάνω 

στρώση αποτελεί το τμήμα που χάνει νερό μόνο σε εξατμισοδιαπνοή. Το νερό που 

συγκρατείται στην πάνω στρώση του εδάφους, αναπαριστά το νερό που βρίσκεται στα κενά 

του εδάφους, ενώ η κάτω στρώση αναπαριστά το νερό που βρίσκεται προσκολλημένο στους 

κόκκους του εδάφους. Το νερό διηθείται στο ανώτερο υπόγειο στρώμα από το έδαφος και από 

εκεί στο κατώτερο υπόγειο στρώμα, μέσω του οποίου εκρέει εκτός συστήματος. Το νερό που 

βρίσκεται αποθηκευμένο σε ένα υπόγειο στρώμα, μπορεί να εκρεύσει πλευρικά έξω από το 

σύστημα. Χρησιμοποιείται σε συνδυασμό με μεθόδους που αφορούν στη φυτοκάλυψη και την 

επιφάνεια του εδάφους. 

Η σχηματική αναπαράσταση της μεθόδου υπολογισμού της εδαφικής υγρασίας (Soil Moisture 

Accounting) παρουσιάζεται στο Σχήμα 6.5 που ακολουθεί. 

 
Σχήμα 6.5: Η μέθοδος υπολογισμού της εδαφικής υγρασίας (Soil Moisture Accounting). πηγή: 

Sintayehu, 2015 

Οι παράμετροι που υπεισέρχονται στη μέθοδο παρουσιάζονται στο Σχήμα 6.6 που ακολουθεί. 
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Σχήμα 6.6: Παράμετροι μεθόδου υπολογισμού της εδαφικής υγρασίας (Soil Moisture Accounting) 

Η αρχική κατάσταση του εδάφους καθορίζεται ως το ποσοστό του εδάφους που είναι γεμάτο 

με νερό στην αρχή της προσομοίωσης (Soil). Οι αρχικές καταστάσεις των άνω και κάτω 

στρώσεων υπόγειου νερού πρέπει επίσης να καθοριστούν (Groundwater 1 & Groundwater 2 

αντίστοιχα). Ο μέγιστος ρυθμός διήθησης καθορίζει το άνω όριο διήθησης από το επιφανειακό 

απόθεμα προς το εσωτερικό του εδάφους (Max Infiltration). Η ενεργός διήθηση σε μια 

συγκεκριμένη χρονική στιγμή είναι μια γραμμική συνάρτηση του αποθέματος της επιφάνειας 

και του εδάφους. Επίσης, καθορίζεται το ποσοστό της λεκάνης που συνδέεται άμεσα με 

αδιαπέρατη επιφάνεια (Impervious). Όλα τα κατακρημνίσματα αυτού του τμήματος της 

λεκάνης θεωρείται πως μετατρέπονται σε άμεση απορροή. Το απόθεμα του εδάφους (Soil 

Storage) αναπαριστά το συνολικό απόθεμα που είναι διαθέσιμο σε μία στρώση εδάφους. Το 

απόθεμα νερού υπό τάση (Tension Storage) καθορίζει το ποσό του αποθέματος νερού στο 

έδαφος το οποίο δεν απορρέει κάτω από τις επιδράσεις της βαρύτητας. Όποτε το τρέχων 

απόθεμα εδάφους υπερβαίνει το απόθεμα υπό τάση, συντελείται διήθηση από τη στρώση 

εδάφους προς την ανώτερη στρώση υπόγειου νερού. Το νερό του αποθέματος υπό τάση 

διαφεύγει μόνο με την επίδραση της εξατμισοδιαπνοής. Εξ ορισμού, το απόθεμα αυτό πρέπει 

να είναι λιγότερο από το απόθεμα εδάφους. Η εδαφική διήθηση (Soil Percolation) είναι το άνω 

όριο της διήθησης από τη στρώση εδάφους προς την άνω στρώση υπόγειου νερού. Η ενεργός 

διήθηση σε μια συγκεκριμένη χρονική στιγμή είναι μια γραμμική συνάρτηση του τρέχοντος 

αποθέματος εδάφους και του τρέχοντος αποθέματος στην άνω στρώση υπόγειου νερού. Το 

απόθεμα Grounwater 1 αναπαριστά το συνολικό απόθεμα στην άνω στρώση υπόγειου νερού. 

Η διήθηση GW 1 Percolation καθορίζει το άνω όριο της διήθησης από την ανώτερη στρώση 

υπόγειου νερού στην κατώτερη στρώση υπόγειου νερού. Ο συντελεστής GW 1 Coefficient 
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χρησιμοποιείται ως η χρονική καθυστέρηση στη γραμμική δεξαμενή για να μετατραπεί το νερό 

σε απόθεμα και να γίνει πλευρική υπεδάφια απορροή. Η πλευρική υπεδάφια απορροή είναι 

διαθέσιμη και μπορεί να συμβάλει στη βασική απορροή. Το απόθεμα Grounwater 2 

αναπαριστά το συνολικό απόθεμα στην κατώτερη στρώση υπόγειου νερού. Η διήθηση GW 2 

Percolation καθορίζει το άνω όριο της  βαθιάς διήθησης έξω από το σύστημα. Ο συντελεστής 

GW 2 Coefficient χρησιμοποιείται ως η χρονική καθυστέρηση στη γραμμική δεξαμενή για να 

μετατραπεί το νερό σε απόθεμα και να γίνει πλευρική υπεδάφια απορροή. Έχει συνήθως 

υψηλότερη τιμή από τον συντελεστή της ανώτερης στρώσης (GW 1 Coefficient). Η πλευρική 

υπεδάφια απορροή είναι διαθέσιμη και μπορεί να συμβάλει στη βασική απορροή. 

Μια άλλη, πολύ σημαντική διεργασία του υδρολογικού κύκλου η οποία προσομοιώθηκε και 

στο HEC-HMS είναι η μετατροπή της βροχής σε απορροή. Σε αυτήν γίνονται οι πραγματικοί 

υπολογισμοί της επιφανειακής απορροής. Για την προσομοίωση της μετατροπής της βροχής σε 

απορροή το μοντέλο διαθέτει οκτώ διαφορετικές μεθόδους. Από αυτές επιλέχθηκε η μέθοδος 

του Μοναδιαίου Υδρογραφήματος κατά Snyder. 

Το Μοναδιαίο Υδρογράφημα κατά Snyder είναι ίσως το πιο γνωστό Συνθετικό Μοναδιαίο 

Υδρογράφημα. Τα στοιχεία που προσδιορίζονται είναι η χρονική βάση, η παροχή αιχμής και 

τέσσερα σημεία του υδρογραφήματος συναρτήσει των γεωμετρικών χαρακτηριστικών της 

λεκάνης. 

Στο μοντέλο HEC-HMS χρησιμοποιείται η πρότυπη μέθοδος (Standard Method) γιατί 

υπάρχουν ακόμα δύο τροποποιήσεις που αφορούν περιοχές στις ΗΠΑ, όπως αναφέρουν οι US 

Army Corps of Engineers (2018). Σύμφωνα με αυτή πρέπει να εκτιμηθούν οι παράμετροι του 

Μοναδιαίου Υδρογραφήματος κατά Snyder χρησιμοποιώντας κατάλληλες προσεγγίσεις όπως 

το ταίριασμα των παραμέτρων για μια λεκάνη απορροής χρησιμοποιώντας μετρημένα 

δεδομένα βροχής και απορροής. Αυτές οι προσεγγίσεις μπορεί να είναι αποτελεσματικές στην 

εκτίμηση παραμέτρων σε μη μετρούμενες λεκάνες απορροής αν αυτές είναι όμοιες με τις 

λεκάνες απορροής για τις οποίες αναπτύχθηκαν οι προσεγγίσεις. 

Οι παράμετροι της μεθόδου παρουσιάζονται ενδεικτικά στο Σχήμα 6.7 που ακολουθεί. 

 
Σχήμα 6.7: Παράμετροι μεθόδου Μοναδιαίου Υδρογραφήματος κατά Snyder (Snyder Unit 

Hydrograph) 
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Η παράμετρος της τυπικής υστέρησης (Standard Lag) ορίζεται ως ο χρόνος που μεσολαβεί από 

το κεντροειδές της μάζας της βροχής ως την παροχή αιχμής του εξαγόμενου υδρογραφήματος. 

Έχουν αναπτυχθεί πολλές σχέσεις υπολογισμού της υστέρησης από τα χαρακτηριστικά της 

λεκάνης απορροής για διαφορετικές περιοχές. Ο συντελεστής αιχμής (Peaking Coefficient) 

καθορίζει το πόσο απότομο είναι το υδρογράφημα που προκύπτει από τη βροχή. Κυμαίνεται 

τυπικά από 0.4 ως 0.8 με τις χαμηλές τιμές να συνδέονται με υδρογραφήματα απότομης 

ανόδου. Υπολογίζεται είτε με σωστή κρίση και εμπειρία, ή από τοπικές σχέσεις που λαμβάνουν 

υπόψη τα φυσικά χαρακτηριστικά της λεκάνης απορροής. 

Για τον υπολογισμό της υπεδάφιας απορροής χρησιμοποιείται μια μέθοδος βασικής απορροής. 

Από τις έξι μεθόδους που παρέχονται επιλέχθηκε λόγω έλλειψης άλλης πληροφορίας και 

καταλληλότητας σε συνεχή προσομοίωση, η μέθοδος της σταθερής μηνιαίας βασικής 

απορροής. Αυτή η μέθοδος ορίζει μια σταθερή βασική απορροή για κάθε μήνα του 

υδρολογικού έτους ξεκινώντας από την τιμή του Ιανουαρίου έως το Δεκέμβριου. 

Στη λεκάνη του Αγραφιώτη λόγω της ύπαρξης δεδομένων ημερήσιας απορροής από 

01/10/1979 ως 30/09/1989 έγινε η παραδοχή πως η μέση μηνιαία απορροή μπορεί να θεωρηθεί 

ως η βασική απορροή και να χρησιμοποιηθεί στην προσομοίωση. Έτσι, έγιναν οι κατάλληλοι 

υπολογισμοί στη χρονοσειρά των ημερήσιων παροχών σε λογιστικό φύλλο και τα δεδομένα 

χρησιμοποιήθηκαν στην προσομοίωση, όπως φαίνεται και στο Σχήμα 6.8 που ακολουθεί. 

 
Σχήμα 6.8: Τιμές μεθόδου σταθερής μηνιαίας βασικής απορροής (Constant Monthly Baseflow) για τη 

λεκάνη του Αγραφιώτη 

Στη λεκάνη του Κρικελιώτη δεν υπήρχε συνεχής χρονοσειρά παροχών όπως παρουσιάστηκε 

σε προηγούμενο κεφάλαιο παρά μόνο μεμονωμένες υδρομετρήσεις παροχής και στάθμης. 

Επίσης, δεν κατέστη εφικτή η κατάρτιση καμπυλών στάθμης - παροχής. Όμως οι τιμές της 

παροχής χρησιμοποιήθηκαν σε αυτή την εργασία. Συγκεκριμένα, για τις 163 διαθέσιμες τιμές 

παροχής έγινε ταξινόμηση ανά μήνα και υπολογίστηκε η μέση μηνιαία τιμή κάθε μήνα. Έτσι, 

γίνεται η παραδοχή πως οι δώδεκα μέσες μηνιαίες τιμές που προέκυψαν αντιπροσωπεύουν τη 
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βασική παροχή της λεκάνης του Κρικελιώτη και παρουσιάζονται στο Σχήμα 6.9 που 

ακολουθεί. 

 
Σχήμα 6.9: Τιμές μεθόδου σταθερής μηνιαίας βασικής απορροής (Constant Monthly Baseflow) για τη 

λεκάνη του Κρικελιώτη 

6.1.3 Μετεωρολογικό μοντέλο (Meteorological model) 

Το μετεωρολογικό μοντέλο είναι όπως έχει ήδη αναφερθεί μια από τις βασικές ενότητες που 

πρέπει να δημιουργηθούν για την προσομοίωση μιας λεκάνης απορροής. Ο κύριος σκοπός του 

είναι να προετοιμάσει τις οριακές μετεωρολογικές συνθήκες για την εκάστοτε υπό μελέτη 

λεκάνη απορροής ή και για τις υπολεκάνες της. Οπωσδήποτε, πρέπει να προϋπάρχει ένα 

μοντέλο λεκάνης απορροής (Basin Model) πριν δημιουργηθεί το μετεωρολογικό μοντέλο. 

Το μετεωρολογικό μοντέλο για τις υπό μελέτη λεκάνες απορροής του Αγραφιώτη και του 

Κρικελιώτη επιλέχθηκε να περιλαμβάνει, ως μέθοδο επιφανειακής αναγωγής της 

βροχόπτωσης, τα βάρη των σταθμών (Gage Weights). Συγκεκριμένα, χρησιμοποιήθηκαν τα 

βάρη – ποσοστά επιρροής που υπολογίσθηκαν στο υποκεφάλαιο 5.5 με τη μέθοδο Thiessen. 

Επίσης, επιλέχθηκε η επιλογή δεικτών για την προσαρμογή της τοπικής μεροληψίας σε ετήσια 

ή μηνιαία βροχόπτωση πριν τον υπολογισμό του σταθμισμένου ύψους βροχόπτωσης (US Army 

Corps of Engineers, 2018). Οι δείκτες μπορούν να είναι η συνολική ετήσια βροχόπτωση για 

κάθε βροχομετρικό σταθμό και η μέση ετήσια βροχόπτωση πάνω από την επιφάνεια της 

λεκάνης για κάθε υπό μελέτη λεκάνη. Στα επόμενα σχήματα (Σχήμα 6.10, 6.11, 6.12, 6.13, 

6.14, 6.15) παρουσιάζονται τα βάρη των σταθμών, οι δείκτες των σταθμών και οι δείκτες κάθε 

λεκάνης απορροής όπως υπολογίστηκαν και επιλέχθηκαν σε καθένα από τα δύο μετεωρολογικά 

μοντέλα. 
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Σχήμα 6.10: Βάρη Thiessen για κάθε σταθμό της λεκάνης του Αγραφιώτη 

 

 
Σχήμα 6.11: Βάρη Thiessen για κάθε σταθμό της λεκάνης του Κρικελιώτη 

 

 
Σχήμα 6.12: Δείκτες σταθμών του Αγραφιώτη 

 

 
Σχήμα 6.13: Δείκτες σταθμών του Κρικελιώτη 

 

 
Σχήμα 6.14: Δείκτης για το σύνολο της λεκάνης του Αγραφιώτη 
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Σχήμα 6.15: Δείκτης για το σύνολο της λεκάνης του Κρικελιώτη 

 

Μια άλλη υδρομετεωρολογική διεργασία που συμπεριλήφθηκε στην προσομοίωση και των δυο 

λεκανών απορροής είναι η εξατμισοδιαπνοή. Αυτή είναι ο συνδυασμός από την εξάτμιση από 

την επιφάνεια του εδάφους και από τη διαπνοή από τη βλάστηση. Έτσι, είτε από την εξάτμιση 

ή από τη διαπνοή, το νερό επιστρέφει στην ατμόσφαιρα. Ο μέγιστος ρυθμός εξατμισοδιαπνοής 

από μια φυτοκαλυμμένη επιφάνεια, που έχει επάρκεια νερού, κάτω από ορισμένες 

μετεωρολογικές συνθήκες ονομάζεται δυνητική εξατμισοδιαπνοή (Thornthwaite, 1948). Το 

μετεωρολογικό μοντέλο υπολογίζει τη δυνητική εξατμισοδιαπνοή και σε κάθε υπολεκάνη 

υπολογίζεται η πραγματική εξατμισοδιαπνοή με βάση τους περιορισμούς από το νερό στο 

έδαφος. 

Όπως αναφέρθηκε στο κεφάλαιο 5, στο εδάφιο 5.5.2 τα μόνο μετεωρολογικά δεδομένα που 

σχετίζονται με την εξατμισοδιαπνοή και ήταν διαθέσιμα για τις δύο λεκάνες απορροής, ήταν 

οι χρονοσειρές της μέγιστης και της ελάχιστης ημερήσιας θερμοκρασίας αέρα. Για το λόγο 

αυτό, από τις εννέα διαθέσιμες μεθόδους υπολογισμού της δυνητικής εξατμισοδιαπνοής, 

επιλέχθηκε η μέθοδος Hargreaves (Hargreaves and Samani, 1985) η οποία είναι βασισμένη σε 

μια εμπειρική σχέση που χρησιμοποιούνται δεδομένα ηλιακής ακτινοβολίας και θερμοκρασίας: 

 𝐸𝑇0 = 0.0023 × 𝑅𝑎 × (𝑇𝐶 + 17.8) × 𝑇𝑅0.5 (6.1) 

όπου: 

ET0: η δυνητική εξατμισοδιαπνοή 

Ra: η εξωγήινη ακτινοβολία βραχέων κυμάτων 

TC: η μέση ημερήσια θερμοκρασία 

TR: το εύρος της ημερήσιας θερμοκρασίας (TR=Tmax - Tmin) 

Η ακτινοβολία βραχέων κυμάτων επιλέχθηκε να υπολογιστεί με τη μέθοδο Hargreaves για να 

είναι απολύτως συμβατή. Η μέθοδος αυτή υπολογίζει την ηλιακή απόκλιση και την ηλιακή 

γωνία για κάθε χρονικό διάστημα της προσομοίωσης, χρησιμοποιώντας το γεωγραφικό μήκος 

της κάθε λεκάνης, την Ιουλιανή ημέρα του χρόνου και την ώρα στη μέση του διαστήματος 

υπολογισμών. Στους υπολογισμούς υπεισέρχεται και ένας συντελεστής βραχέων κυμάτων ο 

οποίος πήρε την προεπιλεγμένη τιμή 0.17 σύμφωνα με τους Hargreaves και Samani (1985) 

γιατί η μέθοδος συνδυάζεται με την αντίστοιχή τους για την δυνητική εξατμισοδιαπνοή. 

Επίσης, εξαιτίας του συνδυασμού των δύο μεθόδων για τον υπολογισμό της δυνητικής 

εξατμισοδιαπνοής και της ηλιακής ακτινοβολίας βραχέων κυμάτων, η τιμή του συντελεστή 

στην εξίσωση 6.1 επιλέχθηκε να είναι 0.0023 σύμφωνα και με τους Hargreaves και Allen 

(2003). 

Στα επόμενα σχήματα (Σχήμα 6.16, 6.17, 6.18, 6.19) παρουσιάζονται οι επιλογές που έγιναν 

στα μετεωρολογικά μοντέλα των δύο λεκανών για τις παραπάνω μετεωρολογικές διεργασίες. 
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Σχήμα 6.16: Επιλογές μεθόδου Hargreaves για την ηλιακή ακτινοβολία βραχέων κυμάτων στη λεκάνη 

του Αγραφιώτη 

 

 
Σχήμα 6.17: Επιλογές μεθόδου Hargreaves για την ηλιακή ακτινοβολία βραχέων κυμάτων στη λεκάνη 

του Κρικελιώτη 

 

 
Σχήμα 6.18: Επιλογές μεθόδου Hargreaves για την δυνητική εξατμισοδιαπνοή στη λεκάνη του 

Αγραφιώτη 

 

 
Σχήμα 6.19: Επιλογές μεθόδου Hargreaves για την δυνητική εξατμισοδιαπνοή στη λεκάνη του 

Κρικελιώτη 

6.1.4 Λεπτομέρειες ελέγχου (Control Specifications) 

Η ενότητα των λεπτομερειών ελέγχου είναι μια από της κύριες ενότητες σε ένα έργο, παρόλο 

που δεν περιλαμβάνει πολλές παραμέτρους. Ο κύριος σκοπός της είναι να ελέγχει πότε αρχίζει 

και τελειώνει μια προσομοίωση και τι χρονικό βήμα χρησιμοποιείται σε αυτή. 
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Έτσι, σύμφωνα με το χρονικό εύρος των διαθέσιμων δεδομένων, έγιναν οι σωστές επιλογές για 

κάθε λεκάνη απορροής και παρουσιάζονται στα Σχήματα 6.20 & 6.21 που ακολουθούν. 

 

 
Σχήμα 6.20: Επιλογές ελέγχου για τη λεκάνη του Αγραφιώτη 

 

 
Σχήμα 6.21: Επιλογές ελέγχου για τη λεκάνη του Κρικελιώτη 

6.1.5 Δεδομένα χρονοσειρών (Time-series data) 

Η ενότητα των δεδομένων χρονοσειρών περιλαμβάνει όλες τις χρονοσειρές που 

χρησιμοποιούνται ως είσοδοι από το μοντέλο και αποτελεί, και αυτή, βασική ενότητα για την 

προσομοίωση μιας λεκάνης απορροής με το HEC-HMS. Για κάθε σταθμό με διαθέσιμα 

δεδομένα επιλέγεται το χρονικό εύρος της χρονοσειράς, το χρονικό βήμα και η μονάδα 

μέτρησης. Έπειτα, μπορεί να γίνει η εισαγωγή τους σε κατάλληλο πίνακα και παρέχεται και η 

δυνατότητα γραφικής αναπαράστασης της χρονοσειράς. 

Για τις υπό μελέτη λεκάνες απορροής τα δεδομένα που εισήλθαν με τον παραπάνω τρόπο ήταν 

αυτά που προετοιμάστηκαν στο κεφάλαιο 5, δηλαδή για τη λεκάνη του Αγραφιώτη: 

• Δεδομένα ημερήσιας βροχόπτωσης για τρεις σταθμούς (Επινιανά, Μοναστηράκι και 

Τροβάτο) 

• Δεδομένα ημερήσιας θερμοκρασίας για το σταθμό Φουσιανά (αναγωγή στο μέσο 

υψόμετρο της λεκάνης) 

• Δεδομένα ημερήσιας παροχής στην έξοδο της λεκάνης (Γέφυρα Βαρβαριάδας) 

και για τη λεκάνη του Κρικελιώτη: 

• Δεδομένα ημερήσιας βροχόπτωσης για δύο σταθμούς (Δομνίστα και Κρίκελλο) 

• Δεδομένα ημερήσιας θερμοκρασίας για ένα σταθμό (Κρίκελλο) 

• Δεδομένα παροχής από υδρομετρήσεις  
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6.1.6 Εκτέλεση μοντέλου 

Μετά την κατάρτιση του μοντέλου με τις παραπάνω διεργασίες,, αυτό είναι πλέον έτοιμο για την 

εκτέλεσή του. Η εκτέλεση του μοντέλου στο περιβάλλον του συστήματος HEC-HMS γίνεται 

δημιουργώντας ένα «τρέξιμο» προσομοίωσης (Run Simulation). Σε αυτή τη διαδικασία εισέρχονται το 

μοντέλο της λεκάνης απορροής (Basin Model), το μετεωρολογικό μοντέλο (Meteorological Model) και 

οι λεπτομέρειες ελέγχου (Control Specifications) όπως έχουν καθοριστεί για κάθε υπό μελέτη λεκάνη. 

Στη συνέχεια, το μοντέλο εκτελείται και εξάγονται τα αποτελέσματα της προσομοίωσης, τόσο σε 

πίνακες χρονοσειρών, όσο και σε διαγράμματα για κάθε συνιστώσα του υδρολογικού κύκλου που 

προσομοιώνεται, και τα οποία μπορούν να μεταφερθούν εύκολα σε λογιστικό φύλλο για οποιαδήποτε 

περαιτέρω ανάλυση και επεξεργασία τους. 

6.2 Βαθμονόμηση και επαλήθευση του μοντέλου 

6.2.1 Γενικά 

Για τη βαθμονόμηση (calibration) και την επαλήθευση (verification) των μοντέλων των 

λεκανών απορροής έγινε χρήση και του περιβάλλοντος του συστήματος HEC-HMS αλλά και 

λογιστικού φύλλου. 

Στο HEC-HMS παρέχεται η δυνατότητα βαθμονόμησης του μοντέλου με δύο αιτιοκρατικέ 

μεθόδους και με μία στοχαστική μέθοδο (US Army Corps of Engineers, 2018). Τα δύο αυτά 

είδη βελτιστοποίησης αποτελούν διαφορετικές προσεγγίσεις στο πρόβλημα της 

βελτιστοποίησης. Με μια αιτιοκρατική μέθοδο βελτιστοποίησης επιδιώκεται η ελαχιστοποίηση 

της διαφοράς των εξόδων του μοντέλου με τα παρατηρούμενα δεδομένα, μεταβάλλοντας τις 

παραμέτρους του μοντέλου ούτως ώστε να βρεθεί ένα μοναδικό σύνολο βέλτιστων 

παραμέτρων. Αυτές οι παράμετροι μπορούν να χρησιμοποιηθούν σε ένα κανονικό «τρέξιμο» 

του μοντέλου όπως παρουσιάστηκε στο προηγούμενο υποκεφάλαιο. Φυσικά,, με το ίδιο 

σύνολο παραμέτρων, μια αιτιοκρατική βελτιστοποίηση καταλήγει στις ίδιες βέλτιστες 

παραμέτρους σε κάθε δοκιμή τους. Η στοχαστική βελτιστοποίηση συμπεραίνει ποιες μπορεί 

να είναι οι πιθανές τιμές των παραμέτρων υπό το φως των παρατηρούμενων δεδομένων και 

αυτό μπορεί να πραγματοποιηθεί μόνο με τη δημιουργία ενός συνόλου από σετ παραμέτρων. 

Αυτή η προσέγγιση χρησιμοποιεί τις παραμέτρους με αβεβαιότητα και δεν επιστρέφει ένα 

μοναδικό σύνολο βέλτιστων παραμέτρων. Έτσι, κάθε στοχαστική βελτιστοποίηση θα εξάγει 

διαφορετικά σύνολα παραμέτρων σε κάθε δοκιμή. 

Οι δύο αιτιοκρατικές μέθοδοι που παρέχονται είναι: α) μια μέθοδος μίας μεταβλητής 

(univariate) η οποία επιτρέπει την αξιολόγηση και μεταβολή μίας μόνο παραμέτρου του 

μοντέλου κατά την βελτιστοποίηση και β) μια μέθοδο Simplex κατερχόμενου απλόκου (Nelder 

και Mead, 1965) η οποία αξιολογεί όλες τις παραμέτρους ταυτόχρονα και αποφασίζει ποιες 

παράμετροι θα μεταβληθούν. Προφανώς με τη μέθοδο Simplex μπορούν να μεταβληθούν 

πολλές παράμετροι αρκεί να είναι τουλάχιστον δύο. 

Η στοχαστική μέθοδος βελτιστοποίησης που παρέχεται είναι η Μαρκοβιανή αλυσίδα Monte 

Carlo (Markov Chain Monte Carlo ή MCMC). Η βασική αρχή αυτής της μεθόδου είναι η εξής: 

ο αλγόριθμος επιδιώκει να «επισκεφτεί» τα εύλογα σύνολα παραμέτρων τα οποία είναι πιο 

πιθανό να έχουν δημιουργήσει τα παρατηρούμενα δεδομένα πιο συχνά. Η αναζήτηση του 

αλγορίθμου προχωρά με τη δημιουργία μίας ακολουθίας τιμών παραμέτρων με την 

πραγματοποίηση τυχαίων μεταβάσεων από μία κατάσταση μίας αλυσίδας Markov σε μια άλλη. 

Κάθε κατάσταση αποτελεί ένα σύνολο τιμών των παραμέτρων του μοντέλου που 
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βελτιστοποιούνται. Αν η τρέχουσα κατάσταση συνεπάγεται καλή συμφωνία μεταξύ 

προσομοιωμένων και παρατηρούμενων δεδομένων, τότε η επανάληψη είναι λιγότερο πιθανό 

να επιχειρήσει μεγάλα «άλματα» μακριά από την τρέχουσα κατάσταση. Αυτό παράγει 

επαναλαμβανόμενα δείγματα από την περιοχή του χώρου παραμέτρων η οποία σχετίζεται με 

υψηλότερη πιθανότητα των συνόλων παραμέτρων να παράγουν τα παρατηρούμενα δεδομένα. 

Αν η συμφωνία των δεδομένων δεν είναι καλή, τότε μια μεγαλύτερη τυχαία αναπήδηση πέραν 

του χώρου παραμέτρων είναι πιθανό να συμβεί. 

Οι συναρτήσεις στόχου που προσφέρονται από το HEC-HMS για τη μέτρηση του πόσο καλά 

ταιριάζουν οι προσομοιωμένες τιμές με της παρατηρημένες είναι 14 για ελαχιστοποίηση 

στόχου και 8 για μεγιστοποίηση και περιγράφονται αναλυτικά στη τεκμηρίωση του HEC-HMS 

(US Army Corps of Engineers, 2018). 

Από τις παραμέτρους των διάφορων διεργασιών του μοντέλου που χρησιμοποιήθηκαν για την 

κατάρτισή του και παρουσιάστηκαν στο προηγούμενο υποκεφάλαιο, αυτές που έχουν την 

άμεση και ουσιαστική μεταβολή στα αποτελέσματά του είναι αυτές που σχετίζονται άμεσα με 

τις υδρολογικές διεργασίες, αποτελούν τις «ευαίσθητες» παραμέτρους του και παρουσιάζονται 

στον Πίνακα 6.1 που ακολουθεί. 

Πίνακας 6.1: Παράμετροι ευαισθησίας μοντέλου 

Α/Α Συνιστώσα Παράμετρος Περιγραφή παραμέτρου 
Μονάδα 

Μέτρησης 

1 
Simple 

Canopy 
Max Storage Μέγιστο απόθεμα στην κομοστέγη mm 

2 
Simple 

Surface 
Max Storage 

Μέγιστο απόθεμα στην επιφάνεια του 

εδάφους 
mm 

3 Snyder Unit 

Hydrograph 

Peaking Coefficient Συντελεστής αιχμής (0,4-0,8) - 

4 Standard Lag Χρόνος υστέρησης h 

5 

Soil 

Moisture 

Accounting 

Max Infiltration Μέγιστος ρυθμός διήθησης (8-10) mm/h 

6 Soil Storage 
Συνολικό απόθεμα νερού στη στρώση 

εδάφους 
mm 

7 Tension Storage 

Ποσό αποθέματος νερού στο έδαφος που 

δεν απορρέει υπό την επίδραση της 

βαρύτητας 

mm 

8 Soil Percolation 

Ποσοστό εδαφικής διήθησης από τη 

στρώση εδάφους στην ανώτερη υπόγεια 

στρώση 

mm/h 

9 GW1 Percolation 

Ποσοστό υπόγειας διήθησης από την 

ανώτερη υπόγεια στρώση εδάφους στην 

κατώτερη 

mm/h 

10 GW1 Storage 
Συνολικό απόθεμα νερού στην ανώτερη 

υπόγεια στρώση εδάφους 
mm 

11 
GW1 Storage 

Coefficient 

Χρονική υστέρηση σε μια γραμμική 

δεξαμενή για τη μετατροπή του νερού σε 

απόθεμα, μέχρι να γίνει πλευρική ροή  

h 

12 GW2 Percolation 

Ποσοστό υπόγειας διήθησης από την 

κατώτερη υπόγεια στρώση εδάφους στην 

βαθιά υπόγεια στρώση εδάφους 

mm/h 

13 GW2 Storage 
Συνολικό απόθεμα νερού στην κατώτερη 

υπόγεια στρώση εδάφους 
mm 

14 
GW2 Storage 

Coefficient 

Χρονική υστέρηση σε μια γραμμική 

δεξαμενή για τη μετατροπή του νερού σε 

απόθεμα, μέχρι να γίνει πλευρική ροή  

h 
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Για την παρούσα εφαρμογή στις λεκάνες του Αγραφιώτη και του Κρικελιώτη οι παράμετροι 

που έπρεπε να βαθμονομηθούν είναι οι 14 (Πίνακας 6.1). Επομένως, η πρώτη αιτιοκρατική 

μέθοδος μιας μεταβλητής απορρίφθηκε εξ αρχής. Στη συνέχεια, πραγματοποιήθηκαν δοκιμές 

και με τις άλλες δύο μεθόδους (Simplex και MCMC). Το πλεονέκτημα της μεθόδου Simplex 

που παρέχεται είναι η λήψη ενός συνόλου βέλτιστων παραμέτρων και, μάλιστα, λόγω της 

σχετικά απλής μεθοδολογίας εφαρμογής της, η εύρεση αυτού του συνόλου είναι αρκετά 

γρήγορη. Από την άλλη, η στοχαστική μέθοδος MCMC εισάγει την έννοια της αβεβαιότητας 

στις παραμέτρους και έχει ως αποτέλεσμα πολλά σύνολα. Όμως, λόγω της σύνθετης 

μεθοδολογίας και του όγκου των υπολογισμών, σε συνδυασμό με το μεγάλο πλήθος των 

παραμέτρων που απαιτούν βαθμονόμηση (14 παράμετροι), ο χρόνος εξαγωγής αποτελεσμάτων 

όχι μόνον ήταν πολύ μεγάλος, της τάξης των ημερών, αλλά και εν τέλει το πρόγραμμα εμφάνισε 

σφάλμα και κατέρρευσε η διαδικασία. Έτσι, επιλέχθηκε η βαθμονόμηση των παραμέτρων να 

γίνει με τη μέθοδο Simplex. 

6.2.2 Λεκάνη απορροής Αγραφιώτη 

Για τη λεκάνη του Αγραφιώτη υπήρχε διαθέσιμη χρονοσειρά ημερήσιων παροχών από 

01/09/1979 ως 30/09/1989 στην έξοδο της λεκάνης (Γεφ. Βαρβαριάδας) όπως παρουσιάστηκε 

στο κεφάλαιο 5. Η χρονοσειρά αυτή εισήλθε στο HEC-HMS κατά την κατάρτισή του μαζί με 

της υπόλοιπες χρονοσειρές (ημερήσιας βροχόπτωσης και ημερήσιας θερμοκρασίας, μέγιστης 

και ελάχιστης). 

Έπειτα, δημιουργήθηκε μια ενότητα στο HEC-HMS για τη βαθμονόμηση που επρόκειτο να 

πραγματοποιηθεί και σε αυτή καθορίστηκαν το μοντέλο λεκάνης (Basin Model) και το 

μετεωρολογικό μοντέλο (Meteorological Model) που θα χρησιμοποιούνταν, η έναρξη και η 

λήξη της βαθμονόμησης και το χρονικό της βήμα. Αυτά παρουσιάζονται στο Σχήμα 6.22 που 

ακολουθεί. 

 
Σχήμα 6.22: Βασικές επιλογές βαθμονόμησης για τη λεκάνη του Αγραφιώτη 

Στη συνέχεια, επιλέχθηκε η μέθοδος βελτιστοποίησης που θα χρησιμοποιούνταν, δηλαδή η 

Simplex, οι μέγιστες επαναλήψεις της και η ανοχή όπως φαίνεται στο Σχήμα 6.23. 
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Σχήμα 6.23: Επιλογές αναζήτησης για τη βαθμονόμηση στη λεκάνη του Αγραφιώτη 

Έπειτα, ακολουθούν οι επιλογές για τη συνάρτηση στόχου που θα χρησιμοποιηθεί σχετικά με 

το είδος της (μεγιστοποίησης ή ελαχιστοποίησης), το χρονικό της εύρος και το μέτρο επίδοσης 

που θα χρησιμοποιηθεί. Συγκεκριμένα, επιλέχθηκε ως συνάρτηση στόχου το άθροισμα των 

τετραγώνων των υπολοίπων (sum of squared residuals) με στόχο την ελαχιστοποίησή του όπως 

φαίνεται στο Σχήμα 6.24. 

 
Σχήμα 6.24: Επιλογές συνάρτησης στόχου για τη βαθμονόμηση στη λεκάνη του Αγραφιώτη 

Στη συνέχεια, κάθε μία παράμετρος που θα συμμετείχε στη βαθμονόμηση έπρεπε να 

καθοριστεί στην ενότητα της βελτιστοποίησης, μαζί με την αρχική τιμή της και το εύρος των 

τιμών της. Για τις 14 παραμέτρους που θα υπεισέρχονταν στη διαδικασία της βαθμονόμησης 

επιλέχθηκαν ως αρχικές τιμές ορισμένες τυπικές τιμές σύμφωνα με τη βιβλιογραφία και τα 

χαρακτηριστικά της λεκάνης απορροής, ενώ με παρόμοιο τρόπο καθορίστηκε και το εύρος που 

θα μπορούσε να μεταβληθεί η τιμή της. Αξίζει να σημειωθεί ότι για τον καλύτερο κατά το 

δυνατό προσδιορισμό όλων των προηγούμενων τιμών έγιναν πολλές χειροκίνητες δοκιμές. 

Ως περίοδος βαθμονόμησης (calibration) επιλέχθηκε η περίοδος από 01/10/1979 μέχρι 

30/09/1986, δηλαδή 7 υδρολογικά έτη. Ως περίοδος επαλήθευσης (validation) επιλέχθηκε το 

διάστημα από 01/10/1986 μέχρι 30/09/1989, δηλαδή 3 υδρολογικά έτη. Για το λόγο αυτό, 

τροποποιήθηκε η ενότητα των λεπτομερειών ελέγχου για να εκτελεστεί στο σωστό χρονικό 

εύρος η προσομοίωση για κάθε μια από τις παραπάνω χρονικές περιόδους. Αντίστοιχα, 

καταρτίστηκαν και οι χρονικές επιλογές της βελτιστοποίησης για την περίοδο της 

βαθμονόμησης. Στη συνέχεια, επιλέχθηκε η εντολή για τους υπολογισμούς της διαδικασίας της 

βαθμονόμησης (Compute) και αυτή εκτελέστηκε. Τα αποτελέσματα των υπολογισμών είναι 

διαθέσιμα στην καρτέλα Results. Εκεί, βρίσκεται μια πληθώρα επιλογών προβολής 
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αποτελεσμάτων τόσο σε αριθμητική μορφή και πίνακες, όσο και σε διαγράμματα των 

προσομοιωμένων μεταβλητών. Ένας από τους διαθέσιμου πίνακες προβάλει και τις τιμές των 

βέλτιστων παραμέτρων όπως αυτές προέκυψαν από τη βελτιστοποίηση. Οι τιμές αυτές 

παρουσιάζονται στον Πίνακα 6. που ακολουθεί. 

Πίνακας 6.2: Βέλτιστες παράμετροι λεκάνης απορροής Αγραφιώτη 

Α/Α Συνιστώσα Παράμετρος Τιμή 
Μονάδα 

Μέτρησης 

1 Simple Canopy Max Storage 10.5 mm 

2 Simple Surface Max Storage 17.6 mm 

3 Snyder Unit 

Hydrograph 

Peaking Coefficient 0.523 - 

4 Standard Lag 7.16 hr 

5 

Soil Moisture 

Accounting 

Max Infiltration 19.9 mm/hr 

6 Soil Storage 46.5 mm 

7 Tension Storage 14.6 mm 

8 Soil Percolation 40.8 mm/hr 

9 GW1 Percolation 1.1 mm/hr 

10 GW1 Storage 178 mm 

11 GW1 Storage Coefficient 1.24 hr 

12 GW2 Percolation 2.4 mm/hr 

13 GW2 Storage 315.7 mm 

14 GW2 Storage Coefficient 2.59 hr 

Εκτός από τις βέλτιστες παραμέτρους είναι διαθέσιμη σε πίνακα η χρονοσειρά της ημερήσιας 

προσομοιωμένης απορροής στην έξοδο της λεκάνης ήδη. Παρόλα αυτά έγινε ξεχωριστή 

εκτέλεση του μοντέλου για την περίοδο βαθμονόμησης (1979-1986) με τις βέλτιστες τιμές των 

παραμέτρων και ξεχωριστή εκτέλεση για την περίοδο επαλήθευσης (1986-1989) με τις 

βέλτιστες τιμές των παραμέτρων τόσο για έλεγχο όσο και για την εξαγωγή των παροχών της 

δεύτερης περιόδου μιας και στην βελτιστοποίηση δεν συμπεριλήφθηκαν τα δεδομένα 

απορροής για την περίοδο 1986-1989. Τα αποτελέσματα των προσομοιωμένων παροχών 

μεταφέρθηκαν σε λογιστικό φύλλο για περαιτέρω επεξεργασία. 

Έτσι, κατέστη εφικτός ο υπολογισμός του συντελεστή NSE ως μέτρο καλής προσαρμογής του 

μοντέλου στα δεδομένα. Για την περίοδο βαθμονόμησης ο συντελεστής NSE προέκυψε 0.689. 

Η τιμή αυτή υποδηλώνει πως υπάρχει ικανοποιητική προσαρμογή του μοντέλου στα δεδομένα 

και, επομένως, οι τιμές των παραμέτρων μπορούν να θεωρηθούν οι καλύτερες δυνατές. Για την 

περίοδο επαλήθευσης, ο συντελεστής NSE προέκυψε μικρότερος και συγκεκριμένα 0.612 

γεγονός που είναι δικαιολογημένο τόσο από το συνολικό χρονικό διάστημα των μετρημένων 

απορροών το οποίο είναι μόνο δέκα υδρολογικά έτη, όσο και από το μικρό χρονικό διάστημα 

των τριών ετών που επιλέχθηκε για επαλήθευση. Παρόλα αυτά και αυτή η τιμή είναι αποδεκτή 

και υποδηλώνει καλή προσαρμογή των προσομοιωμένων απορροών στις μετρημένες. 

Στο επόμενο διάγραμμα (Σχήμα 6.25) παρουσιάζονται οι μετρημένες και οι προσομοιωμένες 

ημερήσιες απορροές για όλο το χρονικό διάστημα των δέκα υδρολογικών ετών της 

προσομοίωσης. 
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Σχήμα 6.25: Μετρημένη και προσομοιωμένη ημερήσια απορροή στη λεκάνη απορροής του 

Αγραφιώτη 

Όπως φαίνεται και στο προηγούμενο διάγραμμα οι προσομοιωμένες απορροές 

προσαρμόζονται ικανοποιητικά στη μετρημένη χρονοσειρά ημερήσιων παροχών. Βέβαια, 

υπάρχουν κάποια εξωκείμενα σημεία στη μετρημένη χρονοσειρά τα οποία δεν μπόρεσαν να 

προσομοιωθούν ικανοποιητικά. Αυτό πιθανότατα οφείλεται σε κάποια γεγονότα ραγδαίας 

βροχής που έλαβαν χώρα τη συγκεκριμένη ημέρα ή για κάποιες διαδοχικές ημέρες, και τα οποία 

δεν μπορούν να προσομοιωθούν σωστά από το μοντέλο, καθώς αυτό είναι συνεχούς χρόνου 

και σωρευτικά μπορεί να υποεκτιμήσει τις απορροές τις συγκεκριμένες ημέρες. Όμως 

λαμβάνοντας υπόψη τη συνολική προσαρμογή του μοντέλου στο χρονικό ορίζοντα της 

δεκαετίας, η προηγούμενη διαπίστωση κρίνεται μικρής σημασίας. 

Βέβαια για την εξαγωγή περαιτέρω συμπερασμάτων για την προσαρμογή του μοντέλου έγινε 

αναπαράσταση της απορροής σε μηνιαίο χρονικό βήμα. Δηλαδή για τις μετρημένες και 

προσομοιωμένες χρονοσειρές απορροής υπολογίστηκε η μέση μηνιαία απορροή. Στο Σχήμα 

6.26 που ακολουθεί παρουσιάζονται οι παραπάνω χρονοσειρές που προέκυψαν. 
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Σχήμα 6.26: Μετρημένη και προσομοιωμένη μηνιαία απορροή στη λεκάνη απορροής του Αγραφιώτη 

Στο παραπάνω διάγραμμα φαίνεται πως οι προσομοιωμένες απορροές συμφωνούν με τις 

μετρημένες. Μάλιστα, οι κλάδοι ανόδου και καθόδου είναι σχεδόν όμοιοι σε αρκετά 

υδρολογικά έτη. Όμως, και σε αυτό το διάγραμμα φαίνονται κάποιες εξωκείμενες τιμές που 

οφείλονται σε κάποια ραγδαία γεγονότα βροχής. Επίσης, σε κάποια υδρολογικά έτη 

παρατηρείται μια υπερεκτίμηση της παροχής, ειδικά στο τέλος της συνολικής περιόδου. Αυτό 

οφείλεται στο γεγονός πως οι βέλτιστες παράμετροι εκτιμήθηκαν για την περίοδο 

βαθμονόμησης (1979-1986) και εφαρμόστηκαν στην περίοδο επαλήθευσης (1986-1989). Σε 

αυτήν, όμως, την περίοδο η μετρημένη απορροή ήταν, σε γενικές γραμμές, μειωμένη σε σχέση 

με τα προηγούμενα υδρολογικά έτη, οπότε η προσομοιωμένη με τις βέλτιστες τιμές απορροή 

προκύπτει υπερεκτιμημένη για την περίοδο 1986-1989. 

Άλλο ένα στοιχεία που υποδεικνύει την προσαρμογή του μοντέλου στα δεδομένα είναι ο 

υπολογισμός του υπολειμματικού σφάλματος για την μηνιαία απορροή, το οποίο είναι 

ουσιαστικά η διαφορά μεταξύ προσομοιωμένης και μετρημένης τιμής της απορροής για την 

εκάστοτε χρονική στιγμή. Στο Σχήμα 6.27 που ακολουθεί παρουσιάζεται το υπολειμματικό 

σφάλμα για τη μηνιαία απορροή. 
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Σχήμα 6.27: Υπολειμματικό σφάλμα μηνιαίας απορροής στη λεκάνη απορροής του Αγραφιώτη 

Στο παραπάνω σχήμα φαίνεται πως το υπολειμματικό σφάλμα είναι σχετικά μικρό εκτός από 

λίγους μήνες που ξεπερνάει τα 10 ή τα 15 m3/s. Άρα και από αυτό το διάγραμμα φαίνεται η 

καλή προσαρμογή του μοντέλου. 

6.3 Μεταφορά βέλτιστων παραμέτρων του μοντέλου  

Όπως έχει ήδη αναφερθεί σε προηγούμενο κεφάλαιο, δεν υπάρχει διαθέσιμη χρονοσειρά 

απορροής στην έξοδο της λεκάνης του Κρικελιώτη (Γέφυρα Δομνίστας). Επίσης, δεν κατέστη 

εφικτή η κατάρτιση καμπύλης στάθμης - παροχής από της διαθέσιμες μεμονωμένες 

υδρομετρήσεις για λόγους που ήδη έχουν αναλυθεί. Έτσι, η συγκεκριμένη λεκάνη μπορεί να 

θεωρηθεί μη μετρούμενη λεκάνη απορροής υπό την έννοια έλλειψης δεδομένων απορροής 

(ungauged drainage basin) και η βαθμονόμηση των παραμέτρων του μοντέλου της δεν μπορεί 

να υλοποιηθεί με τους συμβατικούς τρόπους. 

Όμως η λεκάνη του Κρικελιώτη έχει ταξινομηθεί σε προηγούμενη μελέτη (Papageorgaki and 

Nalbantis, 2016) σε κλάση ομοιότητας στην οποία ανήκει και η λεκάνη του Αγραφιώτη, το 

μοντέλο της οποίας βαθμονομήθηκε και εκτιμήθηκαν οι βέλτιστες τιμές των παραμέτρων του 

όπως παρουσιάστηκε στο προηγούμενο υποκεφάλαιο. Άρα, οι δύο αυτές λεκάνες θεωρούνται 

όμοιες ως προς κάποια φυσικά χαρακτηριστικά τους. 

Στις όμοιες λεκάνες μπορούν να εφαρμοστούν διάφορες μεθοδολογίες εκτίμησης των 

παραμέτρων της μιας από τις παραμέτρους της άλλης χρησιμοποιώντας στατιστικές και 

γεωστατιστικές μεθόδους. Στην παρούσα εργασία επιλέγεται σε ερευνητικό επίπεδο μια πιο 

απλή προσέγγιση, η οποία είναι η απευθείας μεταφορά των παραμέτρων του μοντέλου της 
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λεκάνης του Αγραφιώτη που έχει βαθμονομηθεί ήδη, στο μοντέλο του Κρικελιώτη που έχει 

καταρτιστεί και η σύγκριση του εξαγόμενου αποτελέσματος. Έτσι, οι 14 βέλτιστες παράμετροι 

του μοντέλου της λεκάνης απορροής του Αγραφιώτη, όπως παρουσιάστηκαν προηγουμένως 

στον Πίνακα 6.2, μεταφέρθηκαν αυτούσιες στο μοντέλο της λεκάνης του Κρικελιώτη και 

πραγματοποιήθηκε η εκτέλεση της προσομοίωσης του μοντέλου για την χρονική περίοδο από 

Οκτώβριο του 1980 μέχρι Σεπτέμβριο του 1987. Ο λόγος παρουσιάστηκε στο κεφάλαιο 5 για 

την προετοιμασία των δεδομένων και έγκειται στο ότι το κοινό χρονικό διάστημα για το οποίο 

υπήρχαν διαθέσιμα ημερήσια βροχομετρικά δεδομένα για τους σταθμούς Κρίκελλο και 

Δομνίστα, ημερήσια δεδομένα μέγιστης και ελάχιστης θερμοκρασίας για το σταθμό Κρίκελλο 

και σποραδικές υδρομετρήσεις στην έξοδο της λεκάνης είναι από 01/10/1980 ως 30/09/1987. 

Μετά την εκτέλεση του μοντέλου, τα αποτελέσματα είναι διαθέσιμα στην καρτέλα Results και, 

όπως και στην περίπτωση του Αγραφιώτη, αυτά μπορούν να μεταφερθούν σε λογιστικό φύλλο 

για περαιτέρω επεξεργασία. Συγκεκριμένα, η προσομοιωμένη ημερήσια παροχή που προέκυψε 

για την παραπάνω χρονική περίοδο παρουσιάζεται στο Σχήμα 6.28 που ακολουθεί. 

 
Σχήμα 6.28: Προσομοιωμένη ημερήσια απορροή στη λεκάνη απορροής του Κρικελιώτη 

Εκτός από της ημερήσιες τιμές της προσομοιωμένης απορροής, μπορούν να υπολογιστούν και 

οι μέσες μηνιαίες τιμές με κατάλληλη επεξεργασία. Αυτές παρουσιάζονται στο σχήμα 6.29 που 

ακολουθεί. 
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Σχήμα 6.29: Προσομοιωμένη μηνιαία απορροή στη λεκάνη απορροής του Κρικελιώτη 

6.4 Σύγκριση αποτελεσμάτων για τη λεκάνη του Κρικελιώτη 

Η διαδικασία που πραγματοποιήθηκε και περιγράφεται στο προηγούμενο υποκεφάλαιο για τη 

μεταφορά των παραμέτρων μεταξύ των μοντέλων των όμοιων λεκανών του Αγραφιώτη και 

του Κρικελιώτη πρέπει να αναλυθεί περαιτέρω ούτως ώστε να ερευνηθεί αν στα αποτελέσματα 

που προέκυψαν, δηλαδή την προσομοιωμένη απορροή στην έξοδο της λεκάνης του 

Κρικελιώτη, υπάρχει αξιοπιστία και αν μπορούν να αντιπροσωπεύουν την πραγματικότητα, 

έστω μέχρι έναν βαθμό. Έτσι, γίνεται μια προσπάθεια σύγκρισης της προσομοιωμένης 

απορροής με το μόνο μετρημένο στοιχείο που είναι διαθέσιμο, δηλαδή της σποραδικές 

υδρομετρήσεις στην έξοδο της λεκάνης (Γεφ. Δομνίστας) για μια περίοδο από τον Οκτώβριο 

του 1980 μέχρι το Σεπτέμβριο του 1987, με πλήθος παρατηρήσεων ίσο με 81. 

Αρχικά, επιλέγονται οι ημερήσιες τιμές της προσομοιωμένης απορροής που προέκυψε, οι 

οποίες αντιστοιχούν στις ημερομηνίες που έλαβαν χώρα οι υδρομετρήσεις. Έτσι, για τις 

συγκεκριμένες ημερομηνίες υπάρχουν 81 μετρημένες τιμές απορροής και 81 προσομοιωμένες 

τιμές απορροής. Σε αυτό το σύνολο δεδομένων υπολογίστηκε ο συντελεστής NSE που 

παρουσιάστηκε προηγουμένως και η τιμή του προέκυψε 0.622. Η τιμή αυτή υποδηλώνει πως 

υπάρχει ικανοποιητική προσαρμογή των προσομοιωμένων απορροών στις μετρημένες. 

Επόμενο μέτρο το οποίο μπορεί να χρησιμοποιηθεί για να συγκριθεί και να ελεγχθεί η 

προσομοιωμένη απορροή με τις μετρημένες τιμές είναι ο συντελεστής γραμμικής συσχέτισης, 

ο οποίος προκύπτει από τη σχέση 5.4 που παρουσιάστηκε σε προηγούμενο κεφάλαιο και 

προφανώς αντί για δεδομένα βροχόπτωσης χρησιμοποιούνται οι 81 μετρημένες τιμές απορροής 

και 81 προσομοιωμένες τιμές απορροής όπως και προηγουμένως. Η τιμή του συντελεστή 

γραμμικής συσχέτισης προέκυψε 0.81 πράγμα που σημαίνει ότι είναι αρκετά υψηλός και κοντά 

στο 1 που αποτελεί ένα από τα άκρα του πεδίου τιμών του και συνεπώς η συσχέτιση 

μετρημένης και προσομοιωμένης απορροής είναι αρκετά υψηλή. 
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Επίσης, μπορεί να υπολογιστεί το Μέσο Τετραγωνικό Σφάλμα (Root Mean Square Error, 

RMSE) από την επόμενη σχέση. 

 𝑅𝑀𝑆𝐸 = √∑ (𝑄𝑜𝑏𝑠𝑖−𝑄𝑠𝑖𝑚𝑖)
𝟐𝑵

𝒊=𝟏

𝑁
 (6.1) 

όπου  

 Qobsi   είναι η εκάστοτε μετρημένη τιμή απορροής 

 Qsimi   είναι η εκάστοτε προσομοιωμένη τιμή απορροής 

 Ν   είναι το πλήθος των τιμών του κάθε συνόλου δεδομένων, δηλαδή 81 

Το Μέσο Τετραγωνικό Σφάλμα προέκυψε 1.33 m3/s  το οποίο μπορεί να θεωρηθεί σχετικά 

μικρό σε σχέση με τις τιμές των μετρημένων απορροών. 

Τέλος μπορεί να υπολογιστεί η μεροληψία μεταξύ της προσομοιωμένης και της μετρημένης 

απορροής ως η διαφορά της μέσης τιμής των υδρομετρήσεων από τη μέση τιμή των 

προσομοιωμένων απορροών. Η διαφορά αυτή προκύπτει 0.35 m3/s. Για να προκύψει η 

μεροληψία και ως ποσοστό αρκεί η διαφορά να διαιρεθεί με τη μέση τιμή των υδρομετρήσεων 

και προκύπτει 18.6%. Αυτό σημαίνει ότι υπάρχει μία μικρή τάση υπερεκτίμησης των 

προσομοιωμένων απορροών αλλά, φυσικά, δεν μπορεί να εξαχθεί ένα καθολικό συμπέρασμα 

για όλο το ημερήσιο εύρος από Οκτώβριο του 1980 μέχρι Σεπτέμβριο του 1987. Στον Πίνακα 

6.3 που ακολουθεί παρουσιάζονται ομαδοποιημένα τα παραπάνω μεγέθη. 

Πίνακας 6.3: Μεγέθη σύγκρισης των προσομοιωμένων απορροών με τις υδρομετρήσεις για τη 

λεκάνη του Κρικελιώτη 

Μεγέθη Σύγκρισης Τιμές 

Συντελεστής Nash and Sutcliffe Efficiency (NSE) 0.622 

Συντελεστής Γραμμικής Συσχέτισης r 0.81 

Μέσο Τετραγωνικό Σφάλμα (RMSE) 1.33 

Μεροληψία (Μέση υπολογισμένη – μέση μετρημένη παροχή) 0.35 

Μεροληψία (Μέση υπολογισμένη – μέση μετρημένη παροχή)/ μέση μετρημένη παροχή 18.6% 
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7 Σύνοψη – Συμπεράσματα 

7.1 Σύνοψη - Προβλήματα 

Η παρούσα μεταπτυχιακή εργασία είχε ως στόχο τη διερεύνηση και την ανάδειξη των 

επιπτώσεων της έλλειψης δεδομένων απορροής σε λεκάνες απορροής που είναι γνωστές ως 

«μη μετρούμενες λεκάνες απορροής». Παράλληλα, αξιοποιήθηκε η ιδέα της υδρολογικής 

ομοιότητας μεταξύ λεκανών απορροής για την ανάπτυξη μεθοδολογιών και τεχνικών που έχουν 

στόχο την καλύτερη δυνατή προσομοίωση των μη μετρούμενων λεκανών. Υπενθυμίζεται ότι 

η προσομοίωση σε αυτές τις λεκάνες είναι αδύνατη με τις συμβατικές μεθόδους. Για τις μη 

μετρούμενες λεκάνες έγινε μια ανασκόπηση των δράσεων που έχουν αναληφθεί στο πλαίσιο 

της διεθνούς επιστημονικής πρωτοβουλίας Predictions in Ungauged Basins (PUB) και 

αναλύθηκαν οι αιτίες που καθιστούν τη βέλτιστη προσομοίωσή τους μια περίπλοκη διαδικασία. 

Για την πρακτική μελέτη όλων των παραπάνω πραγματοποιήθηκε μία εφαρμογή σε λεκάνες 

απορροής του ελλαδικού χώρου. Συγκεκριμένα, επιλέχθηκαν δύο υπολεκάνες του Αχελώου, η 

λεκάνη του Αγραφιώτη και η λεκάνη του Κρικελιώτη, για τις οποίες έχει αποδειχθεί η 

υδρολογική ομοιότητά τους σε παλαιότερη έρευνα. Έπειτα, με την κατάλληλη συλλογή 

γεωγραφικών και υδρομετεωρολογικών δεδομένων από διάφορες υπηρεσίες και παλαιότερα 

ερευνητικά έργα ακολούθησε η προσομοίωσή των υδρολογικών διεργασιών στις δύο λεκάνες. 

Το υδρολογικό μοντέλο που χρησιμοποιήθηκε είναι το HEC-HMS και η προσομοίωση που 

πραγματοποιήθηκε ήταν συνεχούς χρόνου, ενώ οι λεκάνες απορροής αντιμετωπίστηκαν ως 

αδιαμέριστες. Έτσι, κατά την κατάρτιση του μοντέλου για κάθε λεκάνη επιλέχθηκαν από τις 

παρεχόμενες συνιστώσες του HEC-HMS, αυτές που υποστηρίζουν κατάλληλα τις παραπάνω 

αρχές. Ακολούθησε η βαθμονόμηση μόνον του μοντέλου της λεκάνης του Αγραφιώτη γιατί γι’ 

αυτόν υπήρχαν πλήρη δεδομένα απορροής στην έξοδό του. Η λεκάνη του Κρικελιώτη 

αντιμετωπίστηκε ως μη μετρούμενη γιατί δεν υπάρχουν διαθέσιμα δεδομένα απορροής στην 

έξοδο, παρά μόνο ορισμένες σποραδικές υδρομετρήσεις, η ποιότητα των οποίων δεν επιτρέπει 

την εξαγωγή δεδομένων απορροών. Έτσι, και λόγω της προαναφερθείσας ομοιότητας μεταξύ 

των δύο λεκανών, έγινε μεταφορά των βέλτιστων παραμέτρων που προέκυψαν από τη 

βαθμονόμηση της λεκάνης του Αγραφιώτη στη λεκάνη του Κρικελιώτη και, ακολούθως, έγινε 

εφαρμογή του μοντέλου. Για τον έλεγχο και τη σύγκριση των αποτελεσμάτων του μοντέλου με 

την πραγματικότητα υπολογίστηκαν ορισμένα στατιστικά χαρακτηριστικά και δείκτες σε 

σχέση πάντα με τα μόνα διαθέσιμα δεδομένα, δηλαδή τις υδρομετρήσεις στην έξοδο του 

Κρικελιώτη. Τελικά, τα αποτελέσματα κρίθηκαν επαρκώς ικανοποιητικά με μία ελαφριά τάση 

υπερεκτίμησης της απορροής. 

Όπως σχεδόν σε κάθε υδρολογική μελέτη, στην πορεία των εργασιών εμφανίστηκαν 

προβλήματα που έπρεπε να λυθούν. Αυτά αναφέρονται στη συνέχεια. 

• Οποιαδήποτε προσομοίωση μιας λεκάνης απορροής με ένα υδρολογικό μοντέλο αποτελεί 

μία πολύπλοκη διαδικασία. Απαιτείται πολύ καλή γνώση της υδρολογίας, των λειτουργιών 

του μοντέλου που εφαρμόζεται, της υπό μελέτη λεκάνης απορροής, καθώς και γνώση 

εργαλείων για την επεξεργασία όλων των γεωγραφικών δεδομένων, τα οποία, στην 

συγκεκριμένη περίπτωση, ήταν αυτά του λογισμικού ArcGIS. Επίσης, απαιτείται η 

αναζήτηση και συλλογή των κατάλληλων δεδομένων που θα επιτρέψουν την καλύτερη 

δυνατή προσομοίωση. Ο μελετητής καλείται να πραγματοποιήσει μία πολύ απαιτητική 

σύνθεση όλων των πληροφοριών που έχει αντλήσει. 
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• Σημαντικότατο πρόβλημα το οποίο αναδεικνύει και το ευρύτερο θέμα της εργασίας ήταν η 

έλλειψη αξιόπιστων δεδομένων απορροής για τη λεκάνη του Κρικελιώτη και για ένα 

συνεχές χρονικό διάστημα, το οποίο απέτρεψε την τυπική διαδικασία βαθμονόμησης του 

μοντέλου στη συγκεκριμένη λεκάνη. Βέβαια, στην περίπτωση πλήρους βαθμονόμησης του 

μοντέλου και αυτής της λεκάνης, θα μπορούσε να γίνει περαιτέρω έρευνα με την 

αντίστροφη μεταφορά παραμέτρων και να εξαχθούν χρήσιμα συμπεράσματα για τη σχέση 

των όμοιων λεκανών (της λεκάνης δότη παραμέτρων και της λεκάνης δέκτη παραμέτρων). 

Επίσης θα μπορούσε να ποσοτικοποιηθεί η αβεβαιότητα των εξαγόμενων απορροών 

συγκρίνοντας αυτές που προέκυψαν από τη βαθμονόμηση και αυτές που προέκυψαν από 

τη μεταφορά παραμέτρων από την όμοια λεκάνη. 

7.2 Συμπεράσματα 

Όπως αποδείχτηκε και από την εφαρμογή της παρούσας εργασίας στις δύο λεκάνες απορροής 

του Αγραφιώτη και του Κρικελιώτη, η έλλειψη μετρήσεων απορροής επηρεάζει σε πολύ 

μεγάλο βαθμό την προσομοιωμένη απορροή γιατί, στην περίπτωση αυτή, δεν μπορεί να γίνει 

βαθμονόμηση και επαλήθευση ούτως ώστε να προκύψουν οι βέλτιστες παράμετροι και, κατ’ 

επέκταση, η προσομοιωμένη απορροή που θα προσεγγίζει την πραγματικότητα. 

Παρόλα αυτά, είναι δυνατή η εκμετάλλευση της πληροφορίας που μπορούν να δώσουν όμοιες 

υδρολογικά λεκάνες η οποία περιέχεται μέσα στις εκάστοτε παραμέτρους ενός 

βαθμονομημένου μοντέλο και μπορεί να μεταφερθεί άμεσα ή έμμεσα. Συγκεκριμένα, τα 

αποτελέσματα που προέκυψαν για την λεκάνη του Κρικελιώτη είναι επαρκώς αποδεκτά και 

προσεγγίζουν την πραγματικότητα, όμως δεν είναι πλήρως ικανοποιητικά όπως θα ήταν στην 

περίπτωση ύπαρξης μετρήσεων απορροής. 

Το μοντέλο HEC-HMS αποτελεί ένα ισχυρό εργαλείο για την προσομοίωση λεκανών 

απορροής γιατί περιλαμβάνει πολλές, διαφορετικές και εναλλακτικές λύσεις για την 

προσομοίωση όλων των διεργασιών του υδρολογικού κύκλου. Μάλιστα, είναι και ιδιαίτερα 

διαδεδομένο καθώς έχει εφαρμοστεί σε αναρίθμητες μελέτες και ερευνητικές εργασίες. Όμως, 

η συντριπτική πλειονότητα των μελετών ειδικά για τον ελληνικό χώρο, χρησιμοποιεί το HEC-

HMS για προσομοίωση γεγονότος βροχής. Στην παρούσα εργασία, το συγκεκριμένο μοντέλο 

εφαρμόζεται για συνεχή προσομοίωση χρησιμοποιώντας τις κατάλληλες ενότητες και, όπως 

φαίνεται από τα αποτελέσματα, η επίδοσή του είναι καθόλα ικανοποιητική. 

Ο ρόλος της υδρολογικής ομοιότητας μεταξύ λεκανών απορροής έχει ιδιαίτερη σημασία καθώς 

παρέχει το πλαίσιο ανάπτυξης τεχνικών και μεθοδολογιών για την κατά το δυνατόν καλύτερη 

προσομοίωση μη μετρούμενων λεκανών απορροής και τη μείωση της αβεβαιότητας των 

αποτελεσμάτων μιας τέτοιας προσομοίωσης. Βέβαια, απαιτείται περισσότερο συντονισμένη 

έρευνα πάνω σε αυτό το αντικείμενο ούτως ώστε να μπορέσουν να εξαχθούν πιο καθολικά 

συμπεράσματα για τις σχέσεις που δυνητικά μπορούν να καταστήσουν δύο ή περισσότερες 

λεκάνες απορροής όμοιες. Για την επίτευξη προόδου σε αυτό κρίνεται σκόπιμη η μελέτη πέρα 

από τις συμβατικές θεωρίες και η κατάρτιση πιο πρακτικών μεθοδολογιών που προκύπτουν 

από την εμπειρία και την τριβή με περιπτώσεις προσομοίωσης σε διάφορες περιοχές μελέτης. 

Ο δρόμος για τη σωστή προσομοίωση και τις σωστές προβλέψεις σε μη μετρούμενες λεκάνες 

απορροής είναι ακόμα μακρύς και απαιτεί την ανάπτυξη νέων μοντέλων και εργαλείων που θα 

αφορούν τέτοιες λεκάνες. Επίσης, απαιτείται διαφορετική προσέγγιση στην προσομοίωση 

ούτως ώστε να λαμβάνονται ακόμα πιο αναλυτικά δεδομένα για τη λεκάνη απορροής 

(γεωγραφικά, κάλυψη γης, χαρακτηριστικά εδάφους και υπογείων υδάτων) μιας και οι 
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τεχνολογικές εξελίξεις το επιτρέπουν, ούτως ώστε να μπορεί να καλυφθεί κατά μία έννοια η 

απουσία μετρήσεων απορροής, παρόλο που αυτές δεν είναι δυνατό να υποκατασταθούν 

πλήρως. Τέλος, όλα τα παραπάνω πρέπει και να υποστηρίζονται από το επιστημονικό 

υπόβαθρο και, έτσι, η παραγωγή νέων επιστημονικών θεωριών που αφορούν τις μη 

μετρούμενες λεκάνες απορροής είναι αναγκαία. 

7.3 Προεκτάσεις 

Πιθανές προεκτάσεις που μπορούν να προκύψουν από την παρούσα εργασία και οι οποίες είναι 

μικρής αλλά και ευρείας κλίμακας θα μπορούσαν να είναι οι εξής: 

• Η μελέτη της αμφίδρομης μεταφοράς παραμέτρων μεταξύ δύο όμοιων λεκανών απορροής 

θεωρώντας κάθε φορά τη λεκάνη δέκτη ως μη μετρούμενη, ούτως ώστε να εξεταστεί η 

επίδραση που θα έχουν στην προσομοιωμένη απορροή με τη σύγκριση εκ των υστέρων με 

τη χρονοσειρά μετρημένων απορροών. Αυτό όμως προϋποθέτει την ύπαρξη κατάλληλων 

χρονοσειρών, κάτι που στην παρούσα μελέτη δεν ήταν εφικτό. 

• Η εξέταση περισσότερων προσεγγίσεων για την μεταφορά παραμέτρων μεταξύ δύο ή 

περισσότερων λεκανών απορροής με χρήση μεθόδων χωρικής εγγύτητας, όπως η ανάλυση 

συμπλέγματος (cluster analyses), η ανάλυση κυρίων συνιστωσών και η πολλαπλή 

παλινδρόμηση και η αξιοποίηση ιδιοτήτων των λεκανών απορροής όπως το μέγεθος της 

λεκάνης απορροής, πληροφορίες σχετικά με την τοπογραφία, τις χρήσεις γης, τη γεωλογία, 

το υψόμετρο, τα χαρακτηριστικά του εδάφους, καθώς και κλιματικές μεταβλητές όπως η 

μέση ετήσια βροχόπτωση. Επίσης, εκτός από την απευθείας μεταφορά παραμέτρων θα 

μπορούσε να ερευνηθεί το ενδεχόμενο κατάρτισης βαρών μέσω της στατιστικής ανάλογα 

με το βαθμό ομοιότητας των λεκανών απορροής ούτως ώστε να γίνει εφικτή η μεταφορά 

παραμέτρων μεταξύ λεκανών που δεν ανήκουν στις ίδιες κλάσεις ομοιότητας. 

• Η έρευνα της ομοιότητας ενός μεγάλου πλήθους λεκανών και υπολεκανών απορροής ώστε 

να μπορέσει να γίνει γνωστό ποιες από αυτές είναι όμοιες και να δοκιμαστούν σε συνθήκες 

προσομοίωσης με παρόμοιες μεθοδολογίες με αυτή που χρησιμοποιήθηκε στην παρούσα 

εργασία. Ιδανικά, η συγκεκριμένη γνώση για το σύνολο των λεκανών απορροής του 

ελληνικού χώρου θα ήταν ιδιαίτερα πολύτιμη, καθώς θα παρείχε μια προεκτίμηση της 

απόκρισης κάθε λεκάνης, στοιχείο που θα ήταν σημαντικότατο κατά τον οποιοδήποτε 

σχεδιασμό έργων διαχείρισης υδατικών πόρων. 
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Παράρτημα Α: Πίνακες 

Πίνακας Α.1: Μέση μηνιαία παροχή στην έξοδο της λεκάνης του Αγραφιώτη, στη Γέφυρα 

Βαρβαριάδας (m3/s) 
ΥΔΡ. 

ΕΤΟΣ 
ΟΚΤ ΝΟΕ ΔΕΚ ΙΑΝ ΦΕΒ ΜΑΡ ΑΠΡ ΜΑΪ ΙΟΥΝ ΙΟΥΛ ΑΥΓ ΣΕΠ 

1979-80 2.14 14.82 16.88 32,.70 10.95 25.52 19.97 22.35 8.37 3.19 2.41 1.73 

1980-81 6.51 20.69 23.19 14.08 28.15 25.24 15.35 15.30 4.18 2.21 1.48 1.55 

1981-82 3.35 1.26 26.87 7.84 5.95 15.53 20.65 13.41 8.03 2.71 1.67 1.48 

1982-83 1.50 15.03 37.04 10.75 25.23 14.56 13.69 4.75 4.62 3.91 2.14 1.44 

1983-84 1.57 17.87 16.43 25.32 21.80 16.04 19.78 12.09 3.81 2.28 1.63 1.87 

1984-85 0.98 6.02 3.20 34.92 24.99 24.94 21.97 10.72 4.49 2.21 1.61 1.12 

1985-86 1.19 24.86 9.35 32.07 24.20 16.27 15.89 7.44 4.30 2.32 1.53 1.27 

1986-87 1.21 1.55 6.37 22.35 12.37 18.85 14.37 9.34 4.48 2.65 1.98 1.63 

1987-88 6.77 18.74 26.11 7.55 14.62 15.71 11.26 5.86 2.75 1.68 1.20 0.86 

1988-89 0.86 9.06 18.73 5.26 9.42 19.20 15.83 10.63 3.03 1.95 1.48 1.07 
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Πίνακας Α.2: Σποραδικές υδρομετρήσεις στην έξοδο της λεκάνης του Κρικελιώτη, στη Γέφυρα 

Δομνίστα (m3/s) 

Α/Α Ημ/νια Παροχή (m3/s) Α/Α Ημ/νια Παροχή (m3/s) Α/Α Ημ/νια Παροχή (m3/s) 

1 23/10/1980 3.07 31 27/6/1984 0.51 61 20/3/1986 2.78 

2 19/11/1980 1.41 32 11/7/1984 0.35 62 15/4/1986 1.87 

3 17/12/1980 2.51 33 17/7/1984 0.33 63 22/4/1986 4.04 

4 28/5/1981 1.08 34 28/8/1984 0.26 64 21/5/1986 1.49 

5 25/6/1981 0.73 35 11/9/1984 0.19 65 28/5/1986 0.90 

6 23/7/1981 0.28 36 25/9/1984 0.29 66 10/6/1986 0.57 

7 16/12/1982 7.05 37 10/10/1984 0.14 67 25/6/1986 0.37 

8 10/3/1983 5.14 38 31/10/1984 0.25 68 8/7/1986 0.53 

9 21/4/1983 1.65 39 15/11/1984 0.39 69 22/7/1986 0.31 

10 28/4/1983 1.45 40 28/11/1984 0.70 70 16/9/1986 0.08 

11 19/5/1983 0.71 41 19/12/1984 0.40 71 21/10/1986 0.08 

12 26/5/1983 0.45 42 19/2/1985 7.28 72 11/11/1986 0.43 

13 8/6/1983 0.91 43 27/2/1985 2.68 73 25/11/1986 0.26 

14 22/6/1983 0.52 44 28/3/1985 8.82 74 10/2/1987 1.95 

15 14/7/1983 0.47 45 10/4/1985 7.28 75 24/2/1987 3.67 

16 11/8/1983 0.29 46 24/4/1985 3.92 76 14/4/1987 3.76 

17 21/9/1983 0.13 47 16/5/1985 1.47 77 12/5/1987 2.87 

18 27/9/1983 0.15 48 28/5/1985 0.96 78 27/5/1987 1.45 

19 13/10/1983 0.10 49 19/6/1985 0.43 79 10/6/1987 0.77 

20 17/11/1983 3.18 50 26/6/1985 0.41 80 23/6/1987 1.77 

21 24/11/1983 3.77 51 30/7/1985 0.12 81 15/9/1987 0.14 

22 15/12/1983 3.87 52 12/8/1985 0.14    

23 21/12/1983 3.33 53 12/9/1985 0.13    

24 21/2/1984 2.69 54 16/10/1985 0.24    

25 21/3/1984 3.69 55 22/10/1985 0.15    

26 27/3/1984 6.52 56 13/11/1985 0.45    

27 10/4/1984 6.85 57 12/12/1985 1.85    

28 15/5/1984 3.07 58 23/1/1986 2.88    

29 24/5/1984 1.91 59 18/2/1986 6.41    

30 19/6/1984 0.66 60 13/3/1986 7.57    

 


